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About gPCRsoft auto Software

1  About gPCRsoft auto Software

Described software
version

Supported devices

The qPCRsoft auto software can be used to create and perform PCR and real-time PCR
experiments. This section describes the basic setup and the layout of the operating
elements of the software.

The short instructions also offer a quick entrance on the operation of gPCRsoft auto (—
section "Appendix A - Short instruction" p. 151).

This description is based on the version gPCRsoft auto V. 1.2.

The program supports the device control and data analysis of following devices:
= gqTOWER3 auto
= qTOWER3 84 auto

If the real-time PCR cycler is used in an automated system, the system software controls
the execution of the real-time PCR experiments. In this case gPCRsoft auto is used for
the evaluation and analysis of the experiments. You define the interfaces for the szstem
software and hardware connections in the Options / Automation window. Up to 4
devices can be controlled simultaneously with one PC. For each device a separate
program instance of Produkt is used.

If the real-time PCR cycler is used as a stand-alone device and controlled by a PC, the
PCR protocol and the PCR run will are defined and startet directly with qPCRsoft auto.

Note: This manual contains illustrations with layouts of 96 well microplates of the
qTOWER? auto. For the gTOWER? 84 auto, the layouts are extended to 384 wells
accordingly, all other software functions are the same.

1.1 Installation of gPCRsoft auto

System requirements for
installing gPCRsoft auto

Administrator rights on the operating system are required for installing the program.

You can control up to 4 real-time PCR cyclers from one PC. A program instance of
gPCRsoft auto must be installed for each device. During the installation, you configure
each program instance for a specific device. You can subsequently edit the configuration
of an instance in the gPCRsoft.ini file.

For using qPCRsoft auto to control the real-time PCR device, your PC must fulfill the
following minimum requirements:

Operating system Windows 10

Processor Dual Core with at least 4 Threads and 1.2 GHz
RAM 4GB

Available hard disk space Min. 300 MB

Interfaces Min. USB 2.0
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Installation procedure

Set up administrator

Editing qPCRsoft.ini file

gPCRsoft auto is delivered on CD-Rom.

1. Insertthe CD in the CD-Rom drive. Normally, the installation's start window opens
automatically.
If this is not the case, start the "setup.exe" file on the CD.
A selection dialog window for installing the device driver or the user management or
for viewing the PDF files of the manuals appears.

2. Activate your language version.

3. Click on [Install].
The installation routine begins.

4. Follow the further instructions of the installation program. During installation, enter
the serial number of the device according to the type label.

5. Switch on the device at the power switch. Start gPCRsoft auto.

v" The program instance for the device is installed. The start icon of gPCRsoft auto
is displayed on the desktop with the serial number of the device.

Note:

The software will only be installed correctly if it has been started once with
administrator rights. A password for the program administrator must be entered during
this first start.

After the software installation, an administrator password must be assigned, and an
administrator must be specified.

1. Start qPCRsoft auto.
2. Enter and confirm the password for the adminstrator in the window Login.

3. Set up the user profiles (— section "User management" p. 139).
If the user management is not necessary, disable the user management via Extras »
Options / User management.

To adapt the configuration of a program instance of gPCRsoft auto to a device later, you
must edit the gPCRsoft.ini file in the installation of the program instance.

Locate the gPCRsoft.ini file in the installation folder and open the file with a text editor.
You can edit the following parameters:

Parameter  Value / Meaning
Mode Single Only one program instance is installed on the PC, i.e.
only one real-time PCR cycler is connected to the PC.

Multi Up to 4 devices are controlled by one PC, each with its
own program instance.

Connection  USB The device is connected to the PC via the USB interface.
TCP The device is connected via Ethernet.

ID Serial number oft he device

IP IP address power module (only relevant for TCP/Ethernet)
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1.2  Starting and exiting gPCRsoft auto

Starting qPCRsoft auto 1. Switch on the device.

2. To start gqPCRsoft auto for a selected device, click on the desktop icon with the serial
number of the device.

If the user management has been installed, you will be prompted to enter username and
password. The gPCRsoft auto workspace will only become accessible if the entry of this
data was successful.

Note:
An administrator and password must be defined during the first program start. Only the
administrator can edit and set up further user accounts or disable the user management.

Note:

At the first start of the software the color modules installed in the device must be
defined in the software (— section "Editing color modules" p. 134). A table of all
currently available color modules can be found on the Analytik Jena website
https://www.analytik-jena.com and in the appendix of this manual (— section
"Appendix E - Available Color Modules and Dyes to be detected" p. 170).

Activate automation By activating automation, you connect the thermal cycler to the automated system and
let it be controlled by the system software.

m (lickon @ in the toolbar.

v' The device is connected to the automated system and controlled automatically.

= Alternatively, you can start the automation when starting gqPCRsoft auto Product. To
do this, activate the Activate automation at software start option in the Options /
Automation window (— "General settings in the qPCRsoft auto software" p.135).

®  To control the device with gPCRsoft auto again, click on @

—

Exiting qPCRsoft auto To exit the gPCRsoft auto application, activate the File » Exit menu command.

2. The program will display a message if any projects that have not yet been saved are
still open at this point.

3. If you want to save these projects, click on [Yes]. Save the projects in the Save as
standard window

4. Then call up the File » Exit menu command again to exit gPCRsoft auto.
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1.3

1.3.1

10

The main window in gPCRsoft auto

@ qpcReoft3zd auto - 31075-0003 1
File Edit View Extras Windi p EH

N2-d- @2 BEX| PO OE@E 2

Window 0 - Unnamed ~

G2 Settings | @ Monitoring | ¥ Analysis | [ D
hermal Cycler 2
[ General |- [i{ Themal Cyder | € Scan Samples |

= Title:

& samples 5 [

ES Absolute quantification - |Uperaux:

%z Relative quantification —

+ ddCt quantification o [

[l Melting curve Comment:

- Genotyping

®% Endpoint

No connection with "qTOWER'24 /G"

Main window of the qPCRsoft auto software

After starting the gPCRsoft auto software the main window opens. It has the following
sections:

Menu bar The menu bar contains the menu commands for, e.g., opening, editing and
(1) saving projects, managing user profiles, setting basic software options and a
help function.

Toolbar (2) Commands for editing projects are arranged in the toolbar. The commands
offered in the toolbar may change according to context.

Project In the project explorer a drop-down menu provides a quick overview of the
explorer (3) most important information on the current open project.

Project The project interface is used to process projects. As soon as a new project is
interface (4)  created or an existing project is loaded, a window opens in which all relevant
settings for the respective project can be made.

Menu commands overview

The menu bar is context-sensitive and is automatically adapted to the program tasks.
Menu items that are not necessary for the current work interface are automatically
hidden. The following menu commands are available in the gPCRsoft auto software:
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Menu Function Description
File New Opens a new project.

Open template Opens a template.

Open project Opens a project.

Open autom. saved  Opens an automatically saved project.

project

Save template Saves a template file in the gPCRsoft auto standard
folder.

Save template as Saves a template file in any user-selected folder.

Save project Saves a project file in the gPCRsoft auto standard
folder.

Save project as Saves a project file in any user-selected folder.

Import analyses Opens an analysis file.

Export analyses Saves an analysis file.

Import LIMS Imports a transfer file, with which the software of
another program can be configured, e. g. LIMS.

MultiGene Starts the Multi Gene analysis for analyzing
experiments that comprise multiple PCR plates and
multiple genes.

Close Closes a template or a project.

Close all Closes all open projects or templates.

Print Prints a project.

Exit Closes the software.

Edit Undo Reverses the last text modification (up to 10 steps).

Redo Restores the last deleted text item (up to 10 steps).

Cut Cuts a marked text area.

Copy Copies an active and/or marked text area.

Paste Pastes atext area copied to the clipboard.

Delete Deletes an active and/or marked text area.

Mark all Marks a complete text area.

User management Opens the window for creating user profiles and
changing the password. (Only available if the user
management function is activated)

View Project explorer Switches the project explorer view in the main
window on or off.

Toolbar Switches the toolbar view in the main window on or
off.

Scan Set color Opens the window for creating files for spectral color
compensation compensation.
Extras Device initialization ~ Resets the connected device to the initial state.

Device identifcation

Activates the connected device

11
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Edit color modules

Opens the window for configuring the system with
color filter modules.

Transport lock

Prepares the device for transport (not for gTOWER).

Options Opens the window for general basic software
settings.
Window Tile horz Arranges project windows horizontally.
Tile vert Arranges project windows vertically.
Cascade Arranges project windows in a cascaded fashion.
Help Content Opens the table of contents of the help function.
Info Displays software information.
Cycler Add empty step Adds a new step.
Delete step Deletes a step.
Cut step Cuts a step and copies it to the clipboard.
Copy step Copies the parameters in one step into the clipboard.
Paste step Inserts a copied step.
Scan Edit color Opens the window for creating files for spectral color
compensation compensation.
Samples Edit layout Edit sample table.
Copy layout Copy the area of the sample table.
Paste layout Insert the copied area of the sample table.
Preview layout Detailed view of the plate assignment
Monitoring Start qPCR run Start the PCR run.
Stop qPCR run Stop the PCR run.
Pause qPCR run Pause the PCR run.
Display options Display options for the product accumulation curves
QBase Export Exports measured values as a CSV or an XLS file in
gBase format (available after Ct calculations)
AbsQuant Add abs. Create new evaluation.

quantification

Delte abs.
quantification

Delete evaluation.

Optionsabs.
quantificationg

Opens a window for basic evaluation settings.

Automa. Threshold

Automatic determination of the fluorescence
threshold for detecting Ct values.

Import Standard
curve

Import a saved standard curve.

12



RelQuant

DeltaDeltaCt

Melting
Curve

Genotyping

Endpoint

MIQE

Qbase export

Add rel.
quantification

Delte rel.
quantification

Optionsrel.
quantificationg

Automa.
Threshold/Cut off

Import Standard
curve

Add AACt
quantification

Delte AACt.
quantification

OptionsAACt.
quantificationg

Automa. Threshold

Add melting curve

Delte melting curve

Optionsmelting
curve

Automa. Threshold
Add Genotyping
Delete Genotyping
Options Genotyping

Autom.
Threshold\Cut off

Add Endpoint
Delete Endpoint
Options Endpoint

Auto Threshold\Cut
off

Import MIQE
Documentation

1.3.2 Overview of the tools in the toolbar
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Exports measured values as a CSV or an XLS file in
gBase format.

Create new evaluation.

Delete evaluation.

Opens a window for basic evaluation settings.

Automatic determination of the fluorescence
threshold for detecting Ct values.

Import a saved standard curve.

Create new evaluation.

Delete evaluation.

Opens a window for basic evaluation settings.

Automatic determination of the fluorescence
threshold for detecting Ct values.

Create new evaluation.

Delete evaluation.

Opens a window for basic evaluation settings.

Determine threshold automatically.

Create new evaluation.

Delete evaluation.

Opens a window for basic evaluation settings.

Automatic determination of the fluorescence
threshold for detecting Ct values.

Create new evaluation.
Delete evaluation.
Opens a window for basic evaluation settings.

Automatic determination of the cut-off fluorescence
value for decision POS/NEG

Imports MIQE information from other project.

The buttons in the toolbar are mostly context-sensitive. The program automatically
adjusts the toolbar to the window content and adds buttons provided that this is

13
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required and useful for the current project window view. Buttons not accessible for the
current contents of the workspace are hidden.

You can display or hide the toolbar via the View » Toolbar menu command.

Button Command Function

General

D New Opens a new project.

@ - Opentemplate Opens a template.

H Save template Saves a template.

@: - Open project Opens a project.

H Save project Saves a project.

&3 Print project Prints a project.

n Undo Reverses the last modification.

@ Redo Restores the last deleted modification.

Q&, Cut Cuts a marked area.

Copy Copies an active and/or marked area.

E Paste Pastes an area copied into the clipboard.

X Delete Deletes an active and/or marked area.

- MultiGene Startet die MultiGene- und Multi-Platten-Analyse.

b Start PCR protocol Starts the PCR run.

Englisch Schaltet zur englischen Sprachversion der Software um.

PCR protocol

IEE, Add empty step Adds a new step.

| | B

ﬁ Delete step Deletes a step.

@ Activate melting Adds a step for melting curve determination.
curve

% Cut step Cuts a step and copies it to the clipboard.

% Copy step Copies the parameters in one step into the clipboard.

é@ Paste step Pastes a copied step.

Color

@ Edit color Opens the window for creating files for spectral color
compensation compensation.

14
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Samples

Edit layout

Assigns changes that were made to the sample table.

Copy layout

Copies an area in the sample table.

Paste layout

Pastes a copied area from the sample table.

Preview layout

Displays a complete view of the plate assignment.

Import MIQE
Documentation

Imports MIQE information from other project.

Monitoring

Start PCR protocol

Starts the PCR run.

Stop PCR protocol

Ends the PCR run.

Pause PCR protocol

Breaks the PCR run.

Drive the tray out out of the device

Drive the tray into the device

Options

Display options of the product accumulation curves.

qBase Export

v dbd =NV

Exports measured values as a CSV or an XLS file in gBase
format.

Evaluation/absolute quantification

New Creates a new evaluation
Delete Deletes an evaluation
Options Opens a window for basic evaluation settings.

Automatic threshold

Automatic determination of the fluorescence threshold
value for Ct value determination.

Import standard curve

Imports a saved standard curve.

qBase Export

Rl RE R R

Exports measured values as a CSV or an XLS file in gBase
format.

Evaluation/relative quantification

New Creates a new evaluation.
Delete Deletes an evaluation.
Options Opens a window for basic evaluation settings.

Automatic threshold

Automatic determination of the fluorescence threshold
value for Ct value determination.

Import standard curve

offl| F || | =R

Imports a saved standard curve.

15
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1.3.3

16

Evaluation/AACt analysis

ddCt

New Creates a new evaluation.
'ﬁ Delete Deletes an evaluation.
'&@ Options Opens a window for basic evaluation settings.
ddCt Automatic threshold Automatic determination of the fluorescence threshold

value for Ct value determination

Evaluation/melting curve

Automatic threshold

Automatically determines the threshold.

@ New Creates a new evaluation.
E Delete Deletes the current evaluation.
'f:@ Options Opens a window for basic settings for the evaluation.

Evaluation/Genotyping

Auto threshold/cut off

jﬁ New Creates a new evaluation.
.:Pi Delete Deletes the current evaluation.
'ﬁ@ Options Opens a window for basic settings for the evaluation.

Automatically determines the threshold.

Evaluation/Endpoint

7 New Creates a new evaluation.

oA Delete Deletes the current evaluation.

'ﬁ% Options Opens a window for basic settings for the evaluation.

Auto threshold/Cut off  Automatic determination of the cut-off fluorescence
value for decision POS/NEG

Automation

©

Connects the thermal cycler with the automated system (control via the system

software)

Q@

Diconnects the thermal cycler from the automated system (control via gPCRsoft auto)

Project explorer components

Different menus (2) in the project explorer offer a quick overview of the currently
processed project. Individual projects can be selected via a selection list (1). The

information on the individual menus can be displayed or hidden via the [+] and [-] (3)

buttons.
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| Window 0 - SyGreen-Assay.rts

B General

0

T
1000

T T T
2000 3000 4000

Time (s)

& Scan

Samples

B Genotyping

¥ Endpoint

« ddCt quantification

Bl Melting curve

]

B Absolute quantification

% Relative quantification

Organization of the project explorer

Menu

Information

General

Project title, user, date, timeand device

Thermocycler

Graphic display of the history of the PCR program in the active project

Scan

Overview of the colors and areas of the PCR plate that are being scanned

Samples

Displays a short info text on the plate layout.

Used for activation or deactivation of samples during measurement and
evaluation (— sections "Display options for monitoring" p. 56 and
"Activating/deactivating samples for evaluation" p. 67).

The edit mode for the plate layout displays detailed information on the
selected well.

Absolute
quantification

Graphic display Ct against log concentration

Relative
quantification

Graphic display Ct against log concentration

AACt Graphical display dCt(V) compared to log concentration

Melting Curve Graphical display of melting curve compared to temperature

GenoTyping Graphical display of dRn Genotype 1 compared to dRn Genotype 2 as a
scatter plot or bar graph

Endpoint Graphical display of endpoint fluorescences as a bar chart for the GOl and

the IPC

You can display or hide the project explorer via the View P Project explorer menu

command.

17
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1.3.4 Project interface with project window

1.3.5
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Help function

The project interface is initially empty when starting the program. Only when a new
project is created or a saved project and/or a template is loaded the project window
opens.

Real time pcr template - Salmonella.rtsx EI@
i Settings |\ Monitoring 4 Analysis [E Documentation 4 b
["] General [ Thermal Cyder & Scan [ samples 1 b

Title:

|Salm0nella |

Operator:

|User |

Start: End:

Comment:

optional notes about the experiment]

View of a project window

In the project window all parameters, measuring data and evaluations for one PCR plate
are combined. The basic functions are arranged on the four main tabs on the top:

Tab Function

Settings Contains all functions required for defining real-time PCR runs.
Monitoring Contains different tools for monitoring real-time PCR runs.
Evaluation Includes the evaluation algorithms implemented in the software for

analyzing acquired data.

Documentation  Opens the input mask for MIQE compliant documentation of real-time PCR
experiments.

These four tabs are always visible. The view of the project window changes depending
on the selection of a function tab. To indicate the tab the descriptions refer to, the tabs
and list sheets are listed in the order in which they were activated and divided by a slash,
e.g. Settings / Thermocycler / Table.

You can get help on the operation of gPCRsoft auto via the menu command Help »
Content.

While working with project windows, you can activate context-sensitive help by pressing
function key [F1].

The program pops up brief information (tool tips) on buttons of toolbar while you move
the mouse pointer across the button.
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1.3.6 Version number of the software

By means of the Help » Info menu command, you open the window with information on
the version number of the software program.
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2  Managing projects and templates

Extensions for gTOWER?
auto

Extensions for
qTOWER? 84 auto

20

The gPCRsoft auto software saves all experiments in the project files. A project contains
different information required to perform a real-time PCR experiment:

Description of the experiment

PCR protocol

Scan settings of the optical system

Plate assignment with detailed information on each sample

Measuring results and the corresponding evaluation after the experiment has been

performed

All basic information required for performing an experiment that is stored in the project
window on the Settings tab, such as the description of the experiment, the PCR

protocol, scan settings of the optical system and the plate assignment, can be saved as a
template.

Following file extensions are used in the software:

Extension

* rtpx

* rtsx

*.mgax

.rta

Extension

*.rtpx384

* rtsx384

*.mgax384

.rta

File type

real time project file
real time settings file
real time multigen

analysis file

real time analysis file

File type

real time project file

real time settings file

real time multigen

analysis file

real time analysis file

Description

Project file with settings of the PCR run, analysis and
measurement results

Templates with settings of the PCR run and the
analysis

Multigene/Multiplate analysis

Export/import file format for analysis parameters of a
project

Description

Project file with settings of the PCR run, analysis and
measurement results

Templates with settings of the PCR run and the
analysis

Multigene/Multiplate analysis

Export/deviceimport file format for analysis
parameters of a project
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2.1 Creating a new project or opening a project

Creating a new project

Creating a new project
based on a template

Opening a saved project

Opening an automatically
saved project

Viewing the projects

A project is always indicated in a project window in a section of the project interface of
the main window.

To create a new project, click on _lorcall up the File » New menu command.

A new project with standard presets is created in the project window.

A new project can be opened with saved presets (template):

1. Clickon ¥ or call up the File » Open template menu command.

2. Inthe standard window, select the desired template to open files and confirm the
selection with [OK].

A new project with the parameter settings of the template is created in the project
window.

1. Clickon P - or call up the File » Open project menu command.

2. Inthe standard window, select the desired project to open files and confirm the
selection with [OK].

The project with the parameter settings, measurement results and evaluations is created
in the project window.

The gPCRsoft auto programs enables you to automatically save the last completed real-
time PCR run to a folder of your choice and thus prevents data loss due to unexpected
terminations of a PCR run.

1. Recovere the terminated measurement with the File » Open autom. saved project
menu command.

2. Save the file under a different name as a project file.

To change the storage location of the file, proceed as follows:

1. Select Extras » Options to open the window of the same name.
2. Open the General tab.

3. (Click [...] and select a storage location.

The autom. save option enables you to switch the automatic save function on and off.

You can open several projects at a time. Each project is displayed in its own project
window. With the commands from the Window menu, the project windows can be
arranged:

Command Description

Tile horz In the horizontal layout the project windows are shown below each other.
Dependent on their number they are additionally arranged in two columns next
to each other for more than 4 project windows.

21
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2.2

2.3

22

Tile vert In the vertical layout the project windows are shown next to each other. For
more than 4 project windows they are additionally divided into two columns.

Cascade In the cascading layout the project windows are placed on top of each other with
an offset.

Changes can only be made in the respective active window.

Saving a template

All basic information required for performing an experiment that is stored in the project
window on the Settings tab, such as the description of the experiment, the PCR
protocol, scan settings of the optical system and the plate assignment, can be saved as a
template.

1. Call up the File » Save template as command.

2. To save files enter the name of the template in the standard window and save the
template with [OK].

The changes in a template can be saved with the File » Save template menu command.

Optionally, you can click on the H symbol in the toolbar.

Saving a project

You can save the project with all parameters of the PCR run, the fluorescence curves and
evaluations.

1. Call up the File » Save project as command.

2. To save files enter the name of the template in the standard window and save the
template with [OK].

The changes in a project can be saved with the File » Save project menu command.

Optionally, you can click on the H symbol in the toolbar.

In the window Options / general (menu command Extras » Options) you can define
how the file will be saved and how the file name is to be assigned:

®m  Automatically by date or name and an index number:
The results of the PCR run are saved without user interaction. The file name consists
of the date or the selected name and a three-digit index.

= Manually when stating the PCR run:
The user is promted to enter the file name of the project when starting the project.

= Manually at the end of the PCR run (default):
After the PCR run, the user is prompted to enter a file name of the project.
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2.5

2.6

2.7

2.8

Managing projects and templates

Importing/exporting analyses

Settings for the data evaluations of a project can be saved (exported) and later
transferred (imported) to an open project. The evaluations are applied to the open
project when they are imported.

1. Select the File » Export analyses menu command.

2. To save files enter the name of the analysis and save the files with [OK].
Analyses are saved with the extension "*.rta".

1. Select the File » Import analyses menu command.

2. Select the name of the analysis in the default window for opening files and import
the analysis into the current project by clicking [OK].

Creating a project template from a transfer file

With the File » Import LIMS menu command, a project template is created from a
transfer file and a PCR run can be started (— section "Appendix C - Creating a project
template from the transfer file (LIMS)"S. 158).

Performing a Multigene-/Multiplate-Analysis

The File » MultiGene menu command allows the analysis of experiments that required
multiple PCR runs and that comprise multiple genes (— section "Multigene-/Multiplate-
Analysis"p. 117).

Closing project windows

The File » close menu command closes the active project window. To close all project
windows, select the File P close all menu command. If any unsaved changes have been
made in project windows, a confirmation prompt appears.

Printing

You can specify the desired contents for printing a project in a selection list:
1. Select the File » Print menu command.

2. Manage the print output using the displayed lists. Select the desired information in
B3
the list on the left and click to transfer it to the print list on the right. To

remove undesired information from the print list, click

3. Click [Print] to start the printout.

23



Managing projects and templates

24

Select [Options] to configure the printout, or [Preview] to display a page view of the

print image.

Print

il

4 & Print

4 {0, Settings

..... @ Scan

I Samples

4 g Monitoring
(- | Raw data

-+ k= Amplification |
S k| Melting curve
a [ Analysis

----- 4 Abs. Quant.
----- E5 Rel. Quant.
----- 998 DeltaDeltaCt
----- 7 Melt. curve

..... % Genotyping

]

[ Thermal Cyder
@ Scan

Samples

|| Amplification

Options ” Preview “

Print

) o

Print window

The individual print modules are sorted into the Settings, Monitoring and Analysis

subgroups in the Print window.
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Settings for a Real-time PCR experiment

Settings for a Real-time PCR experiment

If you want to start a new project, create a new project or open a template:

= (reate an empty project with a click on __linthe toolbar.

= QOptionally,

open a template with T to use the previously stored parameters for

the new project or to modify them.

All functions necessary to create a new project are combined under the Settings tab.
Additional tabs on the second level are assigned to the Settings tab:

Tab page
General
Thermocycler

Scan

Samples

3.1

Function
Allows you to enter general information and remarks
Used for programming PCR protocols

Definition of the colors to be measured and settings for the measuring
parameters

Opens the sample table in which detailed information on each sample can be
saved and groups of experiments defined

Entering general information on the project

You can save general information on each project. The entries can be made on the

General tab:

Real time pcr template - Salmonella.rtsx EI@
i/ Settings & Monitoring % Analysis |j Documentation 4 b
[7] General " [[| Thermal Cycler & Scan [ samples 4 b

Title:

|Salm0nella |

Operator:

|User |

Start: End:

Comment:

optional notes about the experiment]

Real-time PCR run - General information

Command
Title

Operator

Description
Analysis title

User

If you are using a user management option, the user name you signed in with
will be entered automatically.
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Start / Start and end of the gPCR run. Remains empty in a template.
End

Comment Comment input

Note:

For text inputs on the tab General being able to use the usual commands for copying,
cut out and insert of texts. These commands are arranged in the menu Edit.

3.2 Creating a PCR protocol

A PCR protocol must be programmed for each real-time PCR experiment. All necessary
functions are combined in the Settings / Thermocycler project window. The screen is
divided in three sections: graphical program preview (1), program header (2) and
program table (3).

n Real time pcr template - SyGi Assay.rts384 =N iR =
Ly Settings & Monitoring 4 Analysis :; Documentation 4 b
[ General 4] Thermal Cycler -~ & Scan Samples 4 b
©,
100 1
g
a
F s
0 T T T T T T
0 1000 2000 3000 4000 5000 6000
Time (s)
éable( A Step:10f5)
d temp. °C: E? [Mpreheatlid Device: v
4 steps | scan °C m:s | goto [ loops || AT(°C) | At(s) | ~(°C/s)
1 95,0 02:00 = == =F === 4,0
95,0 00:05 = — = — 4,0
40x[ 58,0 00:05 = — == = 2,0
& 72,0 00:15 2 39 4,0

@ [Melting curve 60 to 95 °C, 15 s with AT 1 °C

(o)
w
N
W (o |N (o w4 [w]n

-
o

Table | Graph | Melting curve

Program table for creating PCR protocols

The program preview illustrates the history of the PCR protocol. The program header
defines the general conditions for the PCR protocol, such as the programmed lid
temperature, the lid-heating mode and the thermocycler's block type. The programming
table offers a clear representation of the individual steps of the program.

The Thermocycler tab contains three list sheets. The tabs for switching between the list
sheets are located at the bottom of the window.
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List sheet Function

Table Contains a table for programming PCR programs.

Graph Offers the option for graphical programming of PCR programs.

Melting curve Is used to enter parameters for measuring a melting curve.
Editing a PCR protocol Programs can be edited in the tabular or graphical representation.

You can switch between the two alternative representations via the Table and Graph
screens. To edit one step (the current active step is highlighted light red) you can use
the corresponding function from the Cycler menu in the menu bar or the corresponding
symbol from the toolbar:

Symbol

iF

x4
oo

a2

(Cycler/...) menu command Description

Add empty step Inserts a new step behind the active step
Delete step Deletes the active step

Cut step Cuts the active step

Copy step Copies the active step

Paste step Inserts a copied step behind the active step

3.2.1 Entering information in the program header

The program header contains several general, device specific program settings:

®  QOptions for lid heating

®m  Temperature control method

®  Stand-by mode activation after the PCR is complete

Table ( _¥_Step: 1 of 5)

Lid temp. °C: |100

+ | “IPreheatlid Device: v

Program header of the PCR program (example for qTower settings)

Option/List

Lid temp.

Description

Sets the lid temperature.

The temperature of the heating lid should generally be slightly above the
maximum block temperature to prevent liquids from evaporating from the
reaction mixture and condensing at the walls or lid of the reaction cups.
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Preheatlid  If activated, this option preheats the lid to the set Lid temperature before the
actual PCR program starts.
This is the recommended standard setting to ensure the formation of a
homogeneously tempered air cushion between the sample containers. This
leads to an improved temperature uniformity between the samples. While the
lid is being heated, the block is kept at a constant 25°C.
If the option is deactivated, the PCR program starts while the lid is still being
heated.

Adjustable lid temperature: 30 = 110 °C
Note:

After the heating lid has reached the target temperature, this is followed by a
40-second equilibration before the program is started.

3.2.2 Overview about the PCR protocol

The PCR program is entered into the program table of the Table list sheet. One row of
the table contains the parameters of a temperature step.

You can navigate in the program table by using the mouse or the four arrow keys ([ €]
[=] [] [¥]) on the keyboard. Each entry is confirmed with the [Enter] key or the [>]
arrow key. The cursor jumps into the corresponding field in the adjoining column. If the
cursor is in the last row, an additional temperature step is inserted with [\/]. Click in the
next empty row for inserting an additional temperature step.

4 steps | scan e m:s | goto |loops | AT(°C) | &t(s) | ~(°C/s)

1 95,0 02:00 -- 3,0

2 95,0 00:05 H 3,0
4Dx[ 3 58,0 00:05 -- 2,0

4 * 72,0 00:15 2 39 == 3,0

5 # | Melting curve 60 to 95 °C, 15 s with AT 1 °C

]

7

8

9

10

Program table for a PCR run

The following values are entered into the table or calculated from the default values:

Value Description
Scan Measures the sample fluorescence during this step, if marked
Steps Number of the step in the temperature program

Is automatically numbered consecutively

°C Enter the target temperature of the step in °C

m:s Enter the hold time of the target temperature

goto / Define the loop with the number of repetitions for a cycle

loop

AT(°C) Enter the increment or decrement of the target temperature within the PCR run
At(s) Enter the increment or decrement of the hold time within the PCR run

A(°C/s) Enter the heating or cooling rate to reach the target temperature in the

temperature step
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3.2.3 Inserting a new temperature step / deleting a temperature step

®  You can insert an additional temperature step to the program table with one of

following functions:

®  Set the cursor in the last row of the temperature program and press the [\V/]
arrow key.

®  Select the menu command Cycler » Add empty step.

-
m (lickon |I—'4}-'.
®  (lick with the mous on the next row under the program.
The total number of steps and the current processed step are displayed in the
protocol header.
.
To delete a program step move the cursor to the program row and click on )

Optionally, select the Cycler » Delete step menu command.

3.2.4 Entering the target temperature, hold time and heating/cooling rates

Enter the target temperature of the temperature step into the °C column.

Into the m:s column, enter the hold time in the format "minutes:seconds" (e.g. hold
time of a duration of 1 min 20 s: 1:20).

For special applications or the transfer of protocols from other devices it may be
required to adjust the heating and cooling rates.

Enter the average heating and cooling rate for each individual step in the 2(°C/s)
column.

Note:

The value in the ZA(°C/s) column defines the speed at which the target temperature is
reached. If the temperature is be heated (or cooled) at a speed of 3°C per second
between step 2 and step 3 the value 3.0 must be entered for step 3.

Note:
If the speed is to be reduced for the whole program the heating or cooling rates of all
steps must be adjusted. The settings are only valid for that one program.

4 steps | scan °C m:s | goto | loops | AT(°C) | At(s) | ~(°C/s)

1 G5 K| - [~ - [ - [AD

2 95,0 00:05 - — =< — 4,0
4UX[ 3 58,0 00:05 - — =< — 2,0

4 * 72,0 00:15 | 2 39 4.0

5 € | Melting curve 60 to 95 °C, 15 s with AT 1 °C

6

7

8

9

10

Entering the target temperature, hold time and heating/cooling rates in the PCR table
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3.2.5

Defining loops

Program sequences that are repeated reqularly can be summarized in loops. Generally, a
loop is then defined by a target step for the return ("goto" and the number or repetitions
("loops").

4 steps | scan °C m:s | goto | loops || AT(°C) | At(s) | A(°C/s)

1 95,0 02:00 — -— o - 4,0

2 95,0 00:05 - — =< 4,0
4Dx[ 3 58,0 00:05 | — 2,0

4 * 72,0 00:15 2 39 b —- 4,0

5 # | Melting curve 60 to 95 °C, 15 s with AT 1 °C

6

7

8

9

10

Programming a loop in the PCR table

1. Place the cursor on the last step of the future loop (step 4 in the example above).

2. Enter the number of the target step into the goto column ("2"in the example above).
3. Inthe loops column enter the number of repetitions ("39"in the example above).

After entering the target step and the repetitions the programmed loop is displayed as a
bracket on the left side of the table.

Note:

The total number of loops displayed in the bracket is determined from the number of
programmed repetitions plus 1, as the corresponding sequence of steps prior to reaching
the loop has already cycled once.

3.2.6 Entering increments/decrements for temperature and hold time

30

By programming increments/decrements the temperature or hold time can be
modified by a specific amount from one cycle to the other within a loop.This technology
is for instance used for the "Touch Down" PCR.

3 steps | scan °C m:s | goto |loops || AT(2C) | &t(s) | ~(°C/s)
1 85,0 02:00 - -—- == - 3,0
a0 2 95,0 00:05 | — [ — | e Jd o | 3.0
3 68,0 00:15 2 39 4§ -1.0 5 0 30
4 | ® |Melting curve 60 to 95 °C, 15 swith AT 1 °C___
3
A

Entering increments for temperature and hold time

®  FEnter the desired changes for the temperature step the values of which you wish to
modify within the loop. Use the (-) sign to specify a decrement, i.e. temperature or
hold time are reduced from cycle to cycle by the specified amount. No sign or (+)
mark a decrement with the result that the parameter increases by the specified
amount from cycle to cycle.

= To modify the target temperature in steps, enter the changes in the AT(°C) column.

= To modify the hold temperature in steps, enter the changes in the At(s) column.



Settings for a Real-time PCR experiment

Note:
The modified step must be within a loop. Otherwise, the entries in the columns AT(°C)
and At(s) have no effect.

Note:

The extension of the hold time of one step affects the total run time of a protocol. A
program with many cycles and significant hold time increases takes substantially longer
than a comparable program without a programmed extension.

3.2.7 Arranging a fluorescence measurement

®  To define the measurement of the sample fluorescence in a temperature step of the
PCR protocol, click on the Scan column of the temperature step. A green diamond
(@) indicates that the measurements is active.

4 steps | scan °C m:s | goto | loops || AT(°C) | At(s) | A(°C/s)

1 95,0 02:00 — — == -— 4,0

2 95,0 00:05 - -— == - 4,0
4UX[ 3 58,0 00:05 - -— == - 2,0

4 |[CeD] 720 00:15 | 2 39 4,0

3 € | Melting curve 60 to 95 °C, 15 s with AT 1 °C

6

7

8

9

10

Defining a fluorescence measurement in the PCR run

Define the parameters for the fluorescence measurement on the Scan tab (— section
"Defining the parameters for the fluorescence measurement'p. 34).

Note:

If a step for melting curve determination is added, the scanning process is automatically
activated for this step. For all other steps of the PCR protocol the allocation must be
made manually.

3.2.8 Adding a melting curve

For experiments with intercalating dyes we recommend to check the specificity of the
products by measuring a melting curve. The device can be programmed to add the
corresponding step in the PCR protocol. Activate the option active on the Melting curve

tab.
4 steps | scan °C m:s | goto | loops || AT(°C) | At{s) | A(°C/s)
1 95,0 02:00 — — == -— 4,0
2 95,0 00:05 | — ; 4,0
4Dx[ 3 58,0 00:05 | —- 2,0
4 & 72,0 00:15 2 39 —,- - 4,0
&1 ® [Melting curve 60 to 95 =C, 15 s with AT 1 °C —
b
7
8
9
10

PCR protocol with a step for determining the melting curve
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= A melting curve can be added to the program table by activating the option active on
Melting curve tab.

The melting curve is added to the last temperature step in the table.

= To remove a melting curve from the program table deactivate the option active on
melting curve tab.

®  Set the individual parameters of the melting curve step on the Meltingcurve tab:

Start temp. (C): Increment A T:
End temp. {*C): Heating rate (*Cs):

Equilibration (s):

active

Table | Graph |Melting curve

DNA melting curve screen

The following parameters can be modified:

Parameter Description
Start temp. (°C) Start temperature of the melting curve
End temp. (°C) End temperature of the melting curve

Equilibration (s) Time for equilibration of the sample in a temperature before a
measurement is performed

Increment AT Difference between two adjoining temperature steps in °C
Heating rate Heating rate of the block

(°C/s)

active Add a melting curve on the end of the PCR protocol.

The fluorescence measurement is automatically defined when the melting curve is
recorded.

Note:

If you want to record a melting curve without previous amplification you must add a
separate step prior the melting step in the cycler program. This step must bring the
block temperature to the start temperature of the melting curve and a fluorescence
measurement must be performed. Recording a melting curve without at least one
previous temperature step is not possible.

3.2.9 Graphical display and programming the PCR protocols

32

In the Settings / Thermocycler project window, the history of a programmed PCR
protocol is displayed graphically in the Table and Graph screens. It represents the
temperature curve of the block (blue line) and the heating lid (red line) over time. The
green diamond symbolizes steps during which the fluorescence is measured.
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100

504

Temp. (°C)

o S00 1000 1500 2000 2500

Time {s)
Graphical representation of a PCR protocol

Programs are generally created in the table view, which allows new steps to be
programmed quickly and provides a summarized overall survey of the protocol structure.
Some programming options are only available in the table view. The graphical
programming mode additionally offers a schematic representation of the temperature
profile and the option to adjust protocols quickly. In the Settings / Thermocycler project
window you can switch between the table view and the graphical mode via the Table or
Graph sheets.

Graph { ¥ Step: 1 of 5)

55,0 95,0 Melt
. . 0.0
01:00 00:02 —_ I
£5.0
570 | ooizo | T
00:10
00:02
o1 0z BOx|03 04 & |05 ® 27x

' Table }\Graph ln{DN.ﬁ. rmelting /

Graphical programming mode

The graphical programming is generally performed in the same way as in the
programming table.

® By selecting a step (clicking on it) it becomes active and is highlighted light red.

= The bottom part of the display shows the number of the corresponding protocol step.
Next to it, the number of repetitions in loops (right) and scanning processes (middle)
can be programmed in this field.
The number of repetitions is indicated as a figure (e.g. 40x ) and can be edited by
clicking on it with the left mouse button.
Planned measurements are displayed by means of a green diamond in the middle of
the field and can also be selected or deselected with the left mouse button.

= Temperatures and hold times are indicated as numerical values above or below the
blue line that displays the corresponding temperature level at the individual steps.
The values can be modified by clicking with the left mouse button. Melting curve
steps are marked with the addition Melt. Additionally, a symbol of an arrow pointing
upwards is displayed with the melting curve steps (/1).

Note:
The number of repetitions in melting curve steps cannot be modified.

®  The temperature value at each step can be modified using the mouse. For this
purpose, press and hold the left mouse button to move the blue line of the
temperature curve up or down.
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3.3  Defining the parameters for the fluorescence measurement

The product accumulation is measured by means of the increase in fluorescence in the
real-time PCR. The following measurement parameters must be defined for that
purpose:

= Dyes to be measured
®  Temperature step of the PCR protocol during which a measurement is to take place
®m  The area on the PCR plate that is to be scanned

The colors to be measured are defined in the Settings / Scan project window:

Real time pcr project - ddCt_With5tandards.rtpx EI@
i/ Settings ix  Monitoring % Analysis |j Documentation 4 b
[ General [ Thermal Cyder & Scan | [ Samples 4 b
Pos. Channel Dye Gain Measurement  Pass. Ref,
1 Blue FAM 5 *
2 Green JOE 5
3 Yellow TAMRA 5
4 Orange ROX 5
5 Red Cy5 5
] MNIR1 Cy5.5 5
Meas. repeats: 3 Color compensation: Off ~
Scan region according layout
Define scan region manually

Project window with settings for the fluorescence measurement

The Scan tab contains a table with different parameters for defining the scan properties:

Table parameters Description

Pos. Color module position in the device

Channel Color channel description

Dye Define the dye to be measured for the corresponding channel in the

table by means of a selection list

Gain Regulation of signal intensity

The signal intensity can be adjusted in steps between 0 and 10. The
higher the value, the higher the fluorescence signal in the
corresponding channel.

Standard value: 5

Measurement Activates dye measurement

An active measurement is indicated with a green diamond (®)

Pass. Ref. The LED technology of the device does not require a passive
reference. If you wish to measure a reference dye anyway, place a
checkmark in this column.

The information on position, channel and the selection list of the available dyes cannot
be modified in this table. Modifications of these general settings can only be made in
the Edit color modules window (— section "Editing color modules" p.134).

Following lists and options are available on Scan tab:
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Option Descritption
Meas. repeats Enter the number of repetitions of the fluorescence measurement

Possible values: 1to 16

Color compensation Activate spectral compensation (— section "Color compensation" p.
36).

Scan region according ~ Sample measurement according to the layout of the samples on the

layout Samplestab (— section "Editing the sample table" p. 38).

Define scan region Sample measurement according to manual settings (— section

manually "Manually defining the scan region" p. 35).

Set the following parameters for each channel you wish to make a measurement for:

1. Select the dye to be measured in the Dye column. Click in the cell and mark the dye
in the list that opens up.

Note:
The number of measured dyes does not have an influence on the scan time.

2. Setthe signal quality in the Gain column.
The standard setting is "3".

3. Activate the fluorescence measurement in the channel in the "Measurement" column
by placing a green diamond (®).
Channels that are not marked with a diamond will not be measured.

4. If necessary, activate the reference dye measurement by placing a (v') in the Pass.
Ref. column.

5. Enter the number of repetitions for the fluorescence measurements in the Meas.
repeats field.

Note:
An increased number of repeat measurements reduces the measurement value
distribution but also creates longer scanning times and thus longer protocolling
times.

6. Select one of the options for the scan region (manuallyor according to layout).

3.3.1 Manually defining the scan region

The scan region can be defined according to the plate layout in the sample table (—
section "Editing the sample table" p. 38) or manually. The scan region for the
thermocycler is always defined per column. It must always consist of connected columns.

1. For a manual sample selection, select the Define scan region manually option on
the Settings / Scantab.

2. A graphical representation of the sample block is opened.

3. Enter the first and last column of the region to be scanned into the From column
andTo column fields.

Optionally, you can use the mouse to select the columns. To select an individual
column click directly into that column. If you wish to select several columns, press
and hold the left mouse button and move the cursor over the corresponding area.

Active columns are highlighted blue in the diagram.
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() Scan region according layout
(@ Define scan region manually

Scan region; from column: to column:

Manual adjustment of the scan region

3.3.2 Color compensation

Color compensation: Off

Color compensation:
Standard

Color compensation:
Selection

36

If you are using several dyes per reaction mixture the result may be a fluorescence
crosstalk. This means that a second dye is excited and measured next to the desired dye
at the same time. To subtract the fluorescence quotient of the second dye, you can use
the color compensation function on the Settings / Scan project tab.

gPCRsoft auto offers two different variants for color compensation on measurement
data:

®  Using the standard color compensation Standard1 or Standard 2
Test which of the two compensations gives the best result. If the standard
compensations do not give a satisfactory result, you will need to record a custom
color compensation.

®  Recording und selection of a customer-specific color compensation Selection

The standard setting for the color compensation is Off. This is due to the fact that color
compensation is not required for the most common applications (only one active
measuring channel or dyes that are spectrally widely spaced, such as FAM and ROX).

Bei der Standard-Farbkompensation wird eine Kompensationsmatrix auf die Messdaten
angewendet, die bei der Gain-Einstellung "5"in allen Farben eine ausreichende
Kompensation des Ubersprechens erméglicht.

Using the standard color compensation, a compensation matrix is applied to the
measurement data whichpermits a sufficient compensation of the crosstalk in all colors
in the case of the gain setting "5".

Select Standard from the Color compensation list for using the standard color
compensation.

A better compensation is attained when a compensating matrix is recorded with the
used dyes (— "Spectral calibration" below).

Select Select from the Color compensation list for using this color compensation. A
window appears, in which color compensations that have already been recorded can be
opened and used again. In the window only those compensation data are printed in
black color which meet the settings on the card Scan. Invalid compensation data appear
in red color and cannot be selected.
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Spectral calibration

1 Real time por project - Estarkp ..IJH.IEI
T Monkoring | B9 Analyss | 4
[ Ganersl }/-H;j Thesrmnal Cyclar l-"rﬂsunVE Samples | 4 b
Pos. Channel Drye (Gain Measurement  Pass, Aef,
1 Blig FAM 5 *
2  Green JOE 5
3 veliow TAMAA, 3
4 Orange RO 3
3 Red Cy3 3
] NR1 Cy5.5 5

Maac, rapests: |3 ""I Cidor coenpenesation: ISM vI
e oicctColo Compensation S

" Deefine scan rey
JrriaT |

COBITamraTr
COB3_1kis4

| o I Cancel

Window for selection of color compensation data

Select a color compensation for the current project with the left mouse button and press
[OK] to activate that compensation.

With the @ symbol or the menu command Scan » Edit color compensation, you can
create a new color compensation by measurement. This process is called spectral
calibration. A new window opens, in which all the required settings can be made. The
window is divided in a selection list for dyesand a plate diagram.

Color Compensation *
Color module Iz 1 2 3 4 5 3 7 5 3 w oo o1
1 FAM ™Y
2 vIC » 2
3 TAMRA 3
4 ROX Y
3 cys ® c FAM vIC ROX ys
6 Cy5.5 o FAM VIC ROX Cy5
Blanks »
Delete > E FAM vIC ROX ys
E
]
Mame: Temp.:
[4colorcc_so°C | [60 H
[ Start Measurement Ok

Color compensation for spectral calibration window
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3.4
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To record the calibration data the dyes required for a color compensation must be
available individually in solution. You could for example use the sensors for the
calibration measurement that are to be used in the later PCR experiment. The dye
concentration for the calibration measurement should be approx. 0.1 pmol/I.

In the displayed plate diagram the wells that contain the calibration samples are now
marked individually for each dye and the dye in each of the samples is assigned to the
marked well by clicking on the blue arrow. The dyes offered for selection are those that
were selected in the Settings / Scan project tab.

For an exact calibration measurement we recommend that each dye be created at least
as a triple replicate. It is also recommended to use blanks, i.e. samples which do not
contain dyes. Blanks can be either your NTC samples or wells filled with buffer solution.
In addition, the temperature at which the calibration measurement should be performed
can be set. This should be the same temperature at which the fluorescence
measurements are performed during the PCR run.

The calibration measurement is started by clicking on [Start measurement].

Note:
The selection of available dyes cannot be modified in this table. Modifications can only
be made on Scan tab.

The new color compensation needs to be assigned a description in the name field. It is
included in the selection list after pressing [OK] and will be displayed in the
corresponding window. Templates that are no longer in use can be deleted with
[Delete].

Editing the sample table

The sample table defines which sample is in which position of the block. These details
are required for using the evaluation functions of gPCRsoft auto. Here, a sample can be
described by means of its properties, such as name, gene, type, concentration and dye.
Furthermore, samples from different experimental approaches can be combined in
groups.

The necessary entries can be made on the Samples tab after pressing the [Edit layout]
button. The corresponding window is divided into different sections:
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Real time per project - qTOWER2_Demo_AbsQuantl 1.rtp = =]
ﬁ""; Settings ]/'5_‘,: Monitoring VE Analysis VD Documentation l q bk
[ General ]/ﬁ Thermal Cyder ]/@ Smn Samplﬁ] q b

I Edit layout Create groups |

1|2|3|4|5|6|?|8|9|10|11|12|53mpht“’e’
n Sample name:
@’B_ e e e Target:
pu— Dye IGene IConc. I
< OLOOOOOOOO0 OO0 [~
000000000000
000
F | 000
s 000
H Unit: ng
well El Sample namel Sample type IComment IGroup name I + |Gene ISmndard mnceri -
c2 Patient1 Unknown Group 1
c3 .Patientl .Unknown Group 1
C4 .Pah’ent?_ .Unknown Group 1
C5 .Paﬁentz .Unknown Group 1

Cz? . Patient2 . Unknown Group 1 3 N
7 . Patient3 . Unknown Group 1 @

ca . Patient3 . Unknown Group 1
C9 . Patient3 . Unknown Group 1
cin Patient4 . Unknowri Group 1
c11 Patient4 . Unknown Group 1
c12 Patient4 . Unknowri Group 1
D1 . Patient5 . Unknown Group 1
D2 . Patients . Unknown Group 1
D3 . Patient5 . Unknown Group 1
D4 . Patientd . Unknown Group 1
S P - -~ S i
|Fam]
Window for editing the sample table
Range Function
Layout view (1) Graphical display of the well assignment on the microplate
Edit area (3) Edit area for the sample properties:

= Sample name
= Sample type
= Concentration of standard samples

= Allocation of the dye and the analyzed gene

Sample table (2) Summary of the information on each sample
Dyes (4) Dyes and assigned genes for each sample
Note:

The sample table can also be edited after the real-time PCR run has been completed.
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3.4.1
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Entering sample properties in the layout

You can define the properties for the samples in the wells on the Settings / Samples
project tab in the layout view and the edit area next to it.

Edit layout Create groups
1 |2|3 |4|5 |6|7|8 |g |10|11|12‘5ampletype: Standard -

Sample name: stft

e e Target:
|

Diye |Gene |Conc.
FAM c-myc j

Layout view for the sample type

Note

The color coding of the wells for each sample type and the color used to identify
replicates can be edited in menu Extras » Options » colors.

The following sample types can be defined:

Sample type Symbol  Definition
Empty Describes an empty position on the PCR plate
Unknown u Sample of unknown concentration or dilution

(measuring sample)

Standard S Sample of known concentration or dilution

Calibrator K Sample the target gene expression level of which is set
tol

No template control N Complete reaction mixture but without template strand

(NTC)

Positive control + Positive control assay for which a reaction product can

be expected

Negative control - Negative control assay for which no reaction product is
to be expected

Samples with identical sample properties (sample name, sample type, same gene-dye-
assignments) are viewed as replicates. For a better overview replicates are indicated by
the same color code of the outer ring.The individual values of these samples are
averaged and their mean value is used for the remaining calculations.

With a singleplex assay, samples can have the same sample name and sample type but
differ as far as the gene-dye-assignment is concerned. These samples are identified as
associated samples due to the same name. The evaluation, however, is performed
individually.

= Mark the sample position to be edited by clicking into the layout. To select adjacent
positions press the left mouse button and define an area. To select non-adjacent
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positions press the Ctrl key on the keyboard plus the left mouse button at each
position.

To mark rows or columns, click on the corresponding row or column name [A-H] or
[1-12].

You can mark all sample positions in the layout by clicking on the gray button in the
top left of the layout (between 1 and Al).

Button for marking the complete layout

®  Enter the following sample parameters in the adjacent edit area:

Parameter Description
Sample name Sample description
Sample type Selection of the sample type (see top of table)

Target table
Gene column In the dye row, enter the gene to be analyzed

Conc. column For standards

Enter the concentration of the gene to be analyzed.

®  You can assign sample properties to the marked positions by clicking on @ or by
pressing ENTER.
For emptying on ore more wells, press the DEL key.

Note:
The entries for the selected area will only be applied by the program after they have
been assigned. Entries or modifications that are not assigned will be lost.

®  To display defined sample properties in the edit area, double-click on a well.

You can edit the information and assign them to the well again by clicking @ or by
pressing ENTER.

To assign these sample properties to other wells, mark the desired wells and then

click @ or press ENTER.

= By using the context menu it is possible to assign gene names to the selected wells
afterwards without changing the other properties which had already been assigned.
The context menu can also be used to assign and to remove sample wells which do
not contain an internal positive control (IPC-). The context menu is displayed by right
clicking the PCR plate scheme.
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Assign IPC-
Delete IPC-

Assign genes

Context menu for assigning gennames and ICP- samples

The entry of a sample layout is described by means of an example for a singleplex assay
and a multiplex assay (— sections "Entering a sample layout for a singleplex assay" p. 45
and "Entering a sample layout for a multiplex assay" p. 44).

3.4.2 Entering sample properties into the sample table

Selecting the table view

42

You can also make entries in the sample table itself.

®  Select the desired position in the layout view or a field directly in the sample table.
The corresponding row is then highlighted yellow.

®  Enter descriptions and/or values directly in the designated cells.

The sample table is edited cell by cell. Multiple selections and the associated
assignment of parameters to several cells or rows at a time are not possible.

well B I Sarple namI Sarnple tvpdComment IGroup narnel;l Gene IStandard concd:l
aln iStdS Standard Group 1 GAPDH 100
ST E%E | ERre aroup 1 GAPDH 100
clz [tz B 5tandard Group 1 GAPDH 100
H1 Ernplky Group 1
Hz2 Ernpiky Group 1
H3 Emptky Group 1
H4 Ernpiky Group 1
HS Emptky Group 1
H& Ernplky Group 1
H7 Ernpiky Group 1
Hi& Empty aroup 1
H2 Ernpiky Group 1
Hid Emptky Group 1
Hitl Ernplky Group 1
Hiz Emptky Group 1
- d

Sample table for entering sample properties

The genes and, in the case of standard samples, their concentration are summarized
separately by dye in the second part of the sample table. A list sheet is assigned to each
dye. It is thus possible to use different standard concentrations for each gene. The
number of displayed sheets depends on which dyes have been activated on the Settings
/ Scan project tab for this measurement.

= Enter for each gene the desired standard concentration.

Depending on the selected window size and the number of dyes to be measured, two
buttons with left and right arrows appear. They can be used to move between the
different tabs.

The number of columns that are displayed in the sample table can be user-defined:

®  Right-click on a column header to display and mark the desired columns in the
context menu.
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®  The order of the columns can be changed by clicking on the table header and
dragging with the mouse.

Well

Well color
Marme
Type color
Type

Comment

LY RS RSN N N S

Group name

Selection field for defining the columns displayed in the sample table

Note: The general color settings can be made in the Options / Color window (Extras »
Options menu command). This is where the colors for wells, replicates and sample types
are determined.

In the graphic representation, the amplification curve is highlighted in the color shown
in the 2nd column of the sample table. You can change the color individually:

®  Double-click on the color cell to be changed in the sample table and select the
desired color in the Color window.

= |n order to reset the color of a well, press the Shift key (€') and double-click on the
color cell at the same time. The color is reset to the default setting in the Options /
Color window.

®  To allocate the same color to multiple wells, press the Ctrl key and double-click on
the color cell of a well.
Mark the applicable wells in the plate layout in the Edit colors window and select the
shared color. Click [Accept] to assign the color to the wells. Click [Reset] to reset the
color changes in the marked wells to the default settings in the Options / Color
window.

3.4.3 Displaying sample properties in the project explorer

Moving the mouse pointer over a well on the Sample project tab in the layout view will
display the properties of the well in the Samples menu item in the project explorer.

:

Position: B3

Group: 1

Mame: Std2

Type: Standard

Genel: Conc.: 100ng
Dyel: EAM

Project explorer Samples window showing the well properties

43



Settings for a Real-time PCR experiment

3.4.4 Entering a sample layout for a multiplex assay

The following example shows the definition of four samples and standards with three
repeat measurements each in the layout. The GAPDH gene is analyzed with the FAM
dye and the c-myc gene with the VIC dye. The two dyes are selected on the Settings /
Scan project tab and activated for measurement. The indicated sample names and
standard concentrations serve as examples only.

1. Activate the [Edit layout] button.
Emptying sample layout 2. Empty the plate layout to make sure that no unintentional entries remain:

= Mark the complete plate by clicking on the gray button in the top left of the
layout.

= |n the Sample type list select the option Empty.

= (lickon or press ENTER.

Defining samples 3. Mark the three wells A1 - A3.

4. Make the following settings:

Parameter Entered value
Sample name Sample 1
Sample type Unknown
FAM GAPDH
VIC c-myc

Note:

The genes are allocated to the corresponding dye by entering the name of the gene or
by selecting it from the displayed list in the Target table.

5. Clickon or press ENTER, to assign the sample properties to the three wells.

6. Repeat steps (3) - (5) for the other samples.
Use the following parameters:

Wells Sample name Sample type FAM VIC

A4 - A6 Sample 2 Unknown GAPDH c-myc

B1-B3 Sample 3 Unknown GAPDH c-myc

B4-B6 Sample 4 Unknown GAPDH c-myc
Defining the standard 7. Mark the three wells C1 - C3.

samples 8. Make the following settings:

Parameter Entered value
Sample name Std 1
Sample type Standard

9. Make the following entries in the Target table:
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Dye Gene Conc.

FAM GAPDH 100

VIC c-myc 50
Note:

The Conc. column in the Target table is only available for the Standard sample type.

10. From the Unitlist, choose a concentration or mass unit. You can select from the
following units:ng, ng/pl, ng/ml, pg/ul, copies, copies/pl, copies/ml, mg/ml, 1U/pl,
IU/ml or %.

11.Click on or press ENTER, to assign the sample properties to the three wells.

12.Repeat steps (7) - (10) for the other three standards.
Use the following parameters:

Wells Sample name Conc.

FAM VIC
C4-C6 Std 2 50 5
D1-D3 Std 3 10 1
D4 - D6 Std 4 0.1 0.05

= Assample type, select the Standard option.
®  Assign the genes to the dyes as described in step (6).

v" The plate layout for a multiplex assay is complete.

3.4.5 Entering a sample layout for a singleplex assay

The following example shows the definition of four samples and four standards with
three repeat measurements each in the layout. The GAPDH and c-myc genes are
analyzed with the FAM dye with the help of two sensors. The FAM dye was selected on
the Settings / Scan project tab and activated for the measurement. The indicated
sample names and standard concentrations serve as examples only.

1. Activate the [Edit layout] button.
Emptying sample layout 2. Empty the plate layout to make sure that no unintentional entries remain:

= Mark the complete plate by clicking on the gray button in the top left of the
layout.

= |n the Sample type list select the option Empty.

m (lickon or press ENTER.

Defining samples 3. Mark the three wells A1 - A3.

4. Make the following settings:

Parameter Entered value
Sample name Sample 1
Sample type Unknown
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FAM GAPDH

5. Clickon @ or press ENTER, to assign the sample properties to the three wells.
6. Mark the three wells A4 - A6.

7. Make the following settings:

Parameter Entered value
Sample name Sample 1
Sample type Unknown
FAM c-myc

8. Clickon @ or press ENTER., to assign the sample properties to the three wells.

9. Repeat steps (3) - (8) for the other three samples.
Use the following parameters:

Wells Sample name Sample type Gene /FAM
B1-B3 Sample 2 Unknown GAPDH
B4-B6 Sample 2 Unknown c-myc
c1-c3 Sample 3 Unknown GAPDH
C4-C6 Sample 3 Unknown c-myc
D1-D3 Sample 4 Unknown GAPDH
D4-D6 Sample 4 Unknown c-myc
Defining the standard 10. Mark the three wells E1 - E3.

samples 11. Make the following settings:

Parameter Entered value
Sample name Std1
Sample type Standard

12. Make the following entries in the Target table:

Dye Gene Conc.
FAM GAPDH 100
Note:

The Conc. column in the Target table is only available for the Standard sample type.

13.From the Unit list, choose a concentration or mass unit. You can select from the
following units:ng, ng/pl, ng/ml, pg/pl, copies, copies/pl, copies/ml, mg/ml, 1U/pl,
IU/ml or %.

14.Click on @ or press ENTER, to assign the sample properties to the three wells.
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15. Repeat steps (10) - (13) for the other standards.
Use the following parameters:

Wells Sample name Gene Conc.
E4 - E6 Std. 1 c-myc 100
F1-F3 Std. 2 GAPDH 75
F& - F6 Std. 2 c-myc 75
G1-G3 Std. 3 GAPDH 50
G4 - G6 Std. 3 c-myc 50
H1-H3 Std. 4 GAPDH 10
H4 - H6 Std. 4 c-myc 10

16.Click on or press ENTER, to assign the sample properties to the three values.

Note:
Connected samples must have the same sample name.

v The plate layout for a singleplex assay is complete.

3.4.6 Automatic generation of dilution series/replicates

If in an experiment dilution series or replicates are measured, the layout creation can be
automated.

1. Mark the well at which the dilution series or the sample replicate sequence should
start (start at well) or mark an area on the PCR plate for the dilution series or
replicates.

If no area is preselected, the plate is always automatically filled to the rims.

2. Click on the button li'il on the Settings / Samples project tab in the layout view.

Sample type: |Empty -

Sample name: @,
Target:

Dye |Gene |C0nc. |
FAM

Button for automatic creation of dilution series or replicates

In the window Dilution series/replicates parameters for automatic dilution series and
replicates can be defined.
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Creating a dilution series

Creating replicates
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Dilution senes/replicates

Dilution series

Starting concentration Dilution factor Steps Replicates
10 10 3 3
Start at well
B8 @ by column ) by row
NemeoF skeiad FAM 10E TaMrA [WIROX  [Clcys Cy5.5

Std Genel = Gene2 - |Gened Gened - IPC -
Set
Replicates
Start at well Mumber of samples Replicates
B& 10 3
Sample name
Unb @) by column ) by row
Sample type [“IFam  [¥]10E TAMRA [W]rROX  [Clcys Cy5.5
Unknown ~ Genel » Gened - |Genel Gened » IPC -

k

Window for creation of automatic dilution series/replicates

1.

The starting concentration, the dilution factor and the number of dilution steps and
replicates.

Specify the start point (Start at well) and select whether the entry in the layout table
should be done line by line or column by column.

For determination of the start point, the software automatically takes over the
currently active position in the layout or the first position at the upper left from a
group of selected wells. Alternatively, the start point can also be defined by manual
entry in the corresponding field.

Enter a name for the standard sample (Name of standard) and assign dyes to be
measured (multiple selections are allowed). The standard name for each replicate is
added by one digit (GAPDH1, GAPDH2, etc.).

Activate the dyes for which dilution series should be created. Select the names genes
for the standards. A separate treatment of dyes (targets) is possible in such a way.

Click on [Set].

v The dilution series is created automatically by the software and the
corresponding data is displayed in the layout and the sample table.

Enter the start point (Start at well) and the Number of samples and the Number of
replicates.

For determination of the start point, the software automatically takes over the
currently active position in the layout or the first position at the upper left from a
group of selected wells. Alternatively, the start point can also be defined by manual
entry in the corresponding field.

Enter a Sample name and select whether the entry in the layout table should be
done line by line or column by column. The sample name for each replicate is added
by one digit (Test1, Test2, etc.)
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Specify the Sample type.

Activate the dyes for which replicates should be created. Select the names genes for
the samples. A separate treatment of dyes (targests) is possible in such a way.

Click on [Set].

v" Replicates are created automatically by the software and the corresponding
data is displayed in the layout and the sample table.

Several experiments can be performed on one microtiter plate at the same time. The

samples that are part of one experiment are combined in a group. A group contains a
number of reaction mixtures that will be evaluated together later on. You can define a
maximum of 12 such groups.

The groups are defined in the Settings / Samples project window.

1.

In the Settings / Samples project window click on the [Create groups] button.

The Group list and the Group name field are activated.
In the layout, all samples are marked with the number 1. This means they have been
assigned to group 1.

In the layout, select the samples that are part of one experiment. To select adjacent
positions press the left mouse button and define an area. To select non-adjacent
positions press the Ctrl key on the keyboard plus the left mouse button at each
position

Select the next group from the Group list.

Enter the description for the experiment in the Group name field. You may select
any group name.

Click on or press ENTER, to assign the group properties to the samples.

The samples that belong together are marked with the group number in the layout.

The descriptions are displayed in the sample table in the Group name column.
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Real tirme pcr project - Unnamed EIE
i Settings l/& Monitoring I/E Analysis ] q b
[ General I/ﬁ Thermal Cyder ]/@ Scan J/ Samplﬁ] 4 b

Edit layout ” Create groups
oo+ [s]e[r [0 n[ua]omr s

A oooooﬂa oooo Group name:  Group 4
00000 - D000
‘000000000000
000000800000
H:1-1:1-1-1- /000000
H:1:1:1:1:1- 000000
B:1-1:1-1-1:/000000
B:1-1:1-1-1-/000000
Well I ISampJe naml Sample typeIComment |Group namel + |Gene Standard concl -
Al Unknown Analysis1
A2 . . Unknown Analysis1
A3 . . Unknown Analysis1
A4 . . Unknown Analysis1
AS . Unknown Analysis1
AB . Unknown Analysis1
A7 . Unknown Analysis 2
AB . . Unknown Analysis 2
AS . . Unknown Analysis 2
AlD . . Unknown Analysis 2
All . . Unknown Analysis 2
Al12 . Unknown Analysis 2
B1 . . Unknown Analysis1
B2 . . Unknown Analysis1
B3 . Unknown Analysis1
- [— PP o

Sample layout with four groups

3.4.8 Layout preview
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The layout preview provides a complete overview of the layout of the PCR plate with
samples and the corresponding information that has been saved for the samples.

= Open the layout preview by clicking on the 9 symbol in the toolbar.
Optionally, call up the Samples » Preview layout menu command.

The layout preview is displayed in the View sample plate window.
The layout preview provides an overview of the following properties:
®  Position on the PCR plate
" Genes to be determined
®  Sample type by means of color marking at the edge
= Underlined in color to indicate group affiliation

If you move the cursor to a specific position, all known settings for this position, such as
sample names, sample type and group and all genes and dyes to be measured for the
sample as well as the concentration in the case of standards are displayed in detail.
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3 | 4 | 5
Zellkultur 24h HZellkuItur zah [Jzelikuitur 2ah [zellkultur 240 [lZellkultur 24h
FAM: GAPDH Far: GAPDH Posiktion: A2 FAM: SAPDH
Zellkultur 24h HZellkuItur 24h  Gruppe: L 2ellkultur 24h
FAM: GAPDH FAM: GAPDH Marne: Zellkulbur 24k FAar: GAPDH
Zellkultur 24h uZellkultur 24h  Tvp: Skandard Zellkultur 24h
FAM: MCF-1 FAM: MCF-1 FAM: MCF-1
Zellkultur Z24h uZellkultur 24h  Genl: GAPDH  Konz.: 100ng Zellkultur 24h
FAM: MZF-1 Far: MCF-1 Farbstoff1: EaM FAr: MZF-1

Section from the layout preview table

The table can be printed and used, for example, as a template for pipetting the samples
or for documenting the experiment.

Press the [Print] button in the View sample plate window to print the table.

3.4.9 Copying the layout

The layout view or parts of the layout can be copied and inserted into another project.

1.

Use your mouse to mark the area in the layout view to be copied.

Transfer the information to the clipboard by clicking on the = symbol in the
toolbar.
Optionally, call up the Samples » Copy layout menu command.

Select the target project.

Paste the information using the = symbol.
Optionally, you can use the Samples / Paste layout menu command.

v The copied areas become inserted at the same position in the target project like
their position in the source file.

The way described to edit the layout is related to the graphical presentation of the PCR
plate in the upper part of the project window. If the layout table shall be edited by copy,
cut and paste this can be done by using the right-hand mouse button and keeping the
Ctr-button pressed. | this way, also areas within the same project can be copied.

1.
2.

Press the Ctr-button and hold it pressed during the whole operation.
Mark the lines to be copied or cut by left-klicking the mouse and drawing it up or
down.
Press the right mouse button and select the desired function

a1z Ernpky

61 stz B standard

Bz Stdz [ standard

E3 Stdz [ standard

B4 Ernpky

BS Ernpky

B Empky

The standard samples in the wells B1, B2 and B3 are copied to the clipboard

4. Select the line by left clicking the mouse from which the copied samples shall be

inserted. By right clicking the mouse the paste menu appears.
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v In the example the standard Std2 is now a six fold replicate by their identical
sample name.

a1z Ernpky
pr stz B standard
B2 Stdz B standard
B3 Stdz P standard
E4 Ernpky
BS Stdz B standard
gs stz B standard
B7 Stdz I standard
B& Ermply
E2 Ernpky

The selected standard samples including their properties are now copied to the wells B5, B6 and B7

3.4.10 Exporting or importing the layout in Excel
The layout can be exported or imported as an Excel file (*.xls). The exported data can be
edited in Excel and then reimported.
= Right-click on the sample table.

A context menu with the Import table from Excel file (*.xIs) and Export table to
Excel file (*.xIs) menu commands opens.

Select the desired menu command.

Sample name: |Std2
[-]00 00000000
arget:
B
J— o O O D IGene ICUnc.
| | Fa 100
]
E
F
G
H Linik: ng hd
Well B I Sample namI Sample typEICDmment Group namalﬂ GEne IStandard conc:iﬂ
Al Stdz Standard Graup 1 100
nz st B standard Group 1 10
' EX B standard Group 1 1000
a4 == = =
Import, table from Excel-File { j
AS . St l Export table bo Excel-File (*.xs) | 1
BE sas TR SO T
Excel export and import function for the sample layout
3.4.11 Functions for creating and editing a plate layout
Action Where Function
Left click a well PCR plate Selects this well
scheme
Double left click a PCR plate Shows the information assigned to this well in the
well scheme edit fields
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Left click and drag
Ctrl + left click

Ctrl + left click and
drag

Right click selected
wells

ENTER

Del
Function button F5

Left click on the
table header,
column Well

Right click on the
table header

Right click and drag
on the table header

Left click on a line

Right click on a line

Ctrl + right click (+
drag) on a line of the
table

(holding Ctrl
pressed)

Symbol il below

the target table

Double-click on the
color cell in the table
row

PCR plate
scheme

PCR plate
scheme

PCR plate
scheme

PCR plate
scheme

Keyboard

Keyboard

Keyboard / edit

field ,Gene”

Table

Table

Table

Table

Table

Ttable

Edit field

Table

Settings for a Real-time PCR experiment

Selects consecutive wells
Selects this well additionally
Selects consecutive wells additionally

Opens context menu for:

= Assigning and deleting wells which do not
contain an internal positive control (IPC-, only
relevant to end point analysis)

= Assigning genes afterwards
(The gene names shown in the edit field will be
assigned to the selected wells.)

Complies with function assig

(symbol placed near the edit field Sample
name or in the toolbar)

Deletes the information assigned to the well and
changes sample type to ,Empty”

Removes the selected gene from the displayed list
of genes

Changes sort sequence from ,by line” to ,by
column” or vice versa

Opens context menu for selection of the colums to
be displayed in the table

Changes the sequence of the colums

Highlights this line an allows for data input or
selection of sample types, directly in the table

Opens context menu for:
exporting the layout table to Excel

importing the layout table from Excel

Opens context menu to copy, cut, paste or delete
the contents of the selected table lines

Opens dialog for automatically creating dilution
series and replicates

Opens the Color window for selecting the color of
the amplification curve.
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Shift key and Table Resets the color setting of the amplification curve
double-click on color to the default setting in the Options / Color

cell window.

Ctrl + double-click Table Opens the Edit color window. A selected color can

on color cell

be allocated to the amplification curves of multiple
wells at the same time.

TEditIayout Create groups |

Y 1 PCRplate

h
_I_|_|_|_5|6|7|8|9|10|11|12 Sam':"e“"’e’ ) SEcdite:::lds

0 5 [ e [ =
00000000~
elelelelelelelell
0000000~
elelelelclelelelR

7

(1]

Sample name: std1

Target:

Dye IGEnE ICnnt:. I
FAM GOI1 100

JOE GOI2 100

ROX GOI3 30

Cy5 GOI4 80

a

N (elelelelelelele
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4 Monitoring

All functions required for starting and monitoring a real-time PCR run are combined on
the Monitoring project tab.

Note

After the PCR run is finished you have the choice to save the project or to continue
without saving. If you save the project you cannot change the settings anymore and, for
data integrity, it is not possible to start a new PCR run from that project. If you want to
start a new PCR run with the same settings you must first generate a template from the
project and then open it.

4.1  Starting the PCR protocol

The toolbar displays the icons for starting the PCR protocol defined in the Settings
project window.

Symbol Monitoring / ... Description
menu command
b Start qPCR run Start the PCR run
Stop qPCR run The PCR run is interrupted and will not be continued.
The data recorded up to this point is saved and can be
evaluated.
ii Pause qPCR run The PCR run is interrupted. The symbol flashes during the

break. The PCR run can be continued by clicking ii
again.

Drives the samples tray out of and into the thermoblock.

View options Defines default settings for the Monitoring view.

< ap

55



Monitoring

4.2

56

Display options for monitoring

The Monitoring project window is divided into the following areas:

Real time pcr project - gTOWERZ_Demo_AbsQuantl_1.rtp EIIEI

g";i Settings % Monitoring 24 Analysis

Measurement =

[£] Documentation 4 b

view: | Amplification ~| ) [ caleulatect |

é 20000

15000 —

10000

Intensity [1]

3000

Cycles [n]

( :i.\'-\ll colors | FAM

Lid: 25,0 °C 4 steps | scan °C m:s
1 95,0 02:00
2 95,0 00:05
41){[ 3 58,0 00:05
4 * 72,0 00:15
€ 25,0 °C 2
7
g
9
10

( :BTabIe Graph | T-Profile

Monitoring project window for monitoring PCR runs

Area Function

Measuring results  Displays the measured fluorescence data. The fluorescence intensity is
(1) plotted against the cycle.

Colors tabs (2) Switches between the fluorescence accumulation curves that were
measured for the individual dyes.

PCR protocol (3) Displays the PCR protocol. The active step is indicated by a green arrow.

Protocol view tabs  Switches between different views of the PCR protocol (tabular, graphic,

(4) temperature profile).

The fluorescence measurements are displayed in the top area. On the different list
sheets you can choose between the overlapping display of the measurement results of
all dyes or the display of the individual dyes.
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In the View list you can switch between the Amplification, Melting curve and Raw data
views. The Ct value can be calculated for the amplification and the melting temperature
Tm for the melting curve.

The current PCR protocol is displayed at the bottom of the table in the project window.
The active step is marked by means of a green arrow during the PCR run. On the
different sheets you can choose between a tabular or graphical view of the PCR protocol
or the temperature profile. The view of the PCR protocol is described in the section
"Monitoring the PCR run"p. 61.

Note: For each amplification curve a short information is displayed when the mouse
pointer is placed it (mouse-over function).

4.2.1 Default settings for the Monitoring view

For all views in the Monitoring project window it is generally possible to choose
between linear and logarithmic scaling for the graphical display of the data. The setting
for the baseline correction can also be changed.

Loy
= Select the Monitoring » Display options menu command or click ¥ in the toolbar.

B |
Display options i @
i A . . )
Smoothing Scaling
none @ linear
@ |5 | Points logarithmic
I Baseline correction I
For all samples
From cydle: To cyde:
3 T 0
@) Sample spedfic
Crop first cycles:
5 =
Ok ] | Cancel
k.

Display options window for changing the default settings of the Monitoring view

Parameter / Description

Option
Smoothing Setting the smoothing conditions for the measured data
Scaling Scaling options for the data (linear or logarithmic)
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Baseline There are two options for the baseline correction:
correction = For all samples
If this option is selected, the baseline for every sample in the same range
is determined. The upper and lower range limit must be set in the From
cycle and To cycle fields.
= Sample specific
Select this option if the curves have significantly different Ct values. The
lower range limit for determining the baseline is set in the Crop first
cycles field for all samples. The upper range limit is determined separately
for each sample by an algorithm.
Note:

The type of baseline correction can only be set in this dialog. The range limits
for the correction can also be adjusted in the project window.

4.2.2 Adjusting the view in the Monitoring project window

In the Monitoring project window, you can adjust the preset parameters (Monitoring »
Display options menu command) for the display of the scaling as well as the range
limits for the baseline correction.

1. Click on the ﬂ button above the chart.

A selection field for setting the display options and entering the baseline parameters
opens.

Baseline correction:
Min: A 3 3
Max: 4 15 [k

Baseline correction:
Pits: A 5 k

Scaling: Scaling:
® finear m |inear
logarithmic logarithmic
For all samples baseline correction Sample specific baseline correction
parameter parameter

Parameter settings in the Monitoring project window

2. Change the baseline correction limits and activate the linear or logarithmic option
for the desired view of the fluorescence curves.

4.2.3 Displaying and hiding measurement results for individual wells

The sample view in the Monitoring project window is controlled via the Samples menu
item in the project explorer. Measurement results in the individual wells can be hidden
or shown.

Note:
The selection in the project explorer only influences the display of the fluorescence data
but not the measurement.
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Project explorer Samples window

The color code for each sample type can be modified in menu Extras / Options » colors.

The marking of the sample assignment corresponds to the marking on the Samples

project tab:

Sample type Symbol  Definition

Empty E Describes an empty position on the PCR plate

Unknown u Sample of unknown concentration or dilution
(measuring sample)

Standard S Sample of known concentration or dilution

Calibrator K Sample whose gene of interest expression level is set as
1

No template control N Complete reaction preparation but without matrix strand

(NTC)

Positive control + Positive control preparation for which a reaction product

is expected

Negative control

Negative control preparation for which no reaction
product is expected

Active wells (i.e. displayed wells) are marked with their sample type symbol. For
deactivated wells the position is grey and the fluorescence data is hidden. Empty wells
are marked "E". By default measurement data for empty wells is not shown. For control
by activating empty wells the measurement data can be displayed.

Click with the mouse to switch. The activation changes with each click on a well.

You can change adjacent wells by holding the mouse button and moving the cursor
over the wells. To select non-adjacent positions press the Ctrl key on the keyboard
plus the left mouse button at each position.

Complete rows and columns can be inverted by clicking on the letter or number of

the row [A-H] or column [1-12].

The activation status of the complete plate can be inverted by clicking on @ on the
top left between A and 1.

To activate all wells click on the @ symbol below the chart.
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®  To activate only samples of a specific type click on the corresponding symbol below
the chart. To activate multiple sample types at the same time keep the Ctrl key
pressed when clicking on the sample types.

4.2.4 Exporting fluorescence data

The data from the fluorescence measurement can be exported as ".csv" files. In addition,
the graphical display of the measurement results can be copied to the clipboard as a
hardcopy and is hereby made available for other programs.

= Right-click on the graph.
® A selection window for export and hardcopy appears.
®  (lick on Copy chart to copy the chart to the clipboard.

m  Select the Save chart option to export the fluorescence data.
The Save as standard window opens.
Enter a file name and confirm with [OK].

Real time per project - qTOWER3_Demo_AbsQuant1_1.rtp EI@
i Settings & Monitoring | 2% Analysis [E] Documentation 4 b
View: Amplification ~ | | Calculate Ct

20000 | W—-
= 15000+ et *
=z Copy chart /
£ 10000
= Save chart as CSV-File (*.csv)

5000

[, T

5 10 15 25 30 35 40
Cycles [n]
All colors | FAM
Lid: 25,0 °C 4 steps | scan oC m:s
1 95,0 02:00
2 95,0 00:05
41)([ 58,0 00:05
& 72,0 00:15
25,0 °C

wo (oo |~ o o | w

=
=

Table | Graph | T-Profile

Context menu for exporting the fluorescence data in the Monitoring project window
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4.3  Monitoring the PCR run

Table list sheet

Graph list sheet

T profile list sheet

The running PCR protocol is shown in the bottom part of the Monitoring project tab. It
is generally possible to to choose between the three different views (list sheets) Graph,
Table and T-Profile via tabs.

In addition to the display on the list sheets a status bar shows further information on the
protocol, such as the plateau time, the calculated remaining time and, in programmed
loops, the step number and the number of loops.

% _schritt: 3 von 3, & Loop: 11 von 40, & Plateauzeit: 8 s, € Restzeit: 27 min

Status bar of the Monitoring project tab

Lid: 100.2 °C 3 Steps | scan oC mis
1 05.0 00:03
10/40 @ 50.0 00:03
3 * 72.0 00:10
4
o 5
62.1 °C
=]
7
=]
q
10

Monitoring project window with PCR protocol table

Element Description

Lid Current lid temperature

Temperature display ~ Current block temperature

Steps Temperature steps in the PCR protocol

The active step is marked by a green arrow.

°C Target temperature of the step
m:s Hold time, format: min:s
w
Melt
g5.0 5.0 0.0
01:00 00:30 |, 720 5.0
0.0 — '
= 0030 o
00:30 -
ol 2 400|013 04 05 # 27

Monitoring project window with PCR protocol table

The Graph list sheet contains the same elements of the graphical representation of the
PCR protocol as the Settings / Thermocycler / Graph project window. Once again, the
active step is marked by a green arrow.
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100 <

Temp. {*C)
wn
(=]
|

L

1} 500 1000 1500 2000 2500

1]

Zeit (s)
Monitoring project window with T profile

In the representation of the temperature profile a yellow progress bar indicates the step
that is currently being performed.

The size of the area displayed for fluorescent curves and results table or standard curves
can be adjusted by the slider control that is located between the two areas.

I

GOI-FAM | Mean Ct | Mean canc,
I & ‘
+ +

(el | |Sam|:|le narne |Sarnp|e bype ct & |Mean Ct Conc. Std. ] 41

Slide control to adjust the size of the displayed areas

4.4  Displaying product accumulation curves and calculating Ct values

Displaying the product
accumulation curve

Calculating the Ct values

62

The product accumulation is documented by means of fluorescence measurements
during the PCR run in the project window Monitoring.

®  Select the Amplification or Raw data option from the View list to display
measurement curves for the product accumulation.

In the chart the fluorescence intensity [l] is plotted against the number of cycles in
relative units. The color of the curve that is being displayed corresponds to the color
assigned to each well in the sample table (Settings / Sample project window).

®  Selected the measurement results for the individual dyes via the corresponding list
sheets.

You have the option to display the measurement results of all dyes together (all
colors list sheet) or only the results of an individual dye.

The display options for the product accumulation curves are described in the section
'Display options for monitoring" p. 56.

After the PCR run, the Ct values can be calculated directly from the amplification curves,
without having to create an analysis such as Absolute quantification.

m  Select the Amplification or Raw data option from the View list and click [Calculate
Ct].

The amplification curves are normalized and displayed individually or together on
the list sheets for the dyes. The table below shows the Ct values of the individual
samples and the mean values of the replicates.
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The threshold value for the individual dyes can be set on the applicable list sheet.
The parameters set in the Options / Analysis window are factored in.

After clicking on [Data], you return to the display of the fluorescence intensities.

4.5 Displaying melting curves and calculating the melting temperatures T,

Displaying melting curves

Calculating the melting
temperature T,

The course of the melting curve after the PCR can be monitored in the Monitoring
project window.

To display the melting curves, select the Melting curve option from the View list.

The display options for the product accumulation curves are described in the "Display
options for monitoring" p. 56.

For a PCR run with included melting curve, the melting temperatures can be calculated
in the Monitoring window without having to create a Melting curve analysis.

In the Monitoring project window, select the Melting curve option in the View list.
Click on [Calculate Tm].
Select the gene to be examined in the Gene of Interest (GOI) list.

The melting temperature is calculated taking the parameters set in the Options /
Analysis window into account, and the diagram and the results table are displayed.

As an option, a threshold value can be set on the Derivative tab, with which
significant peaks can be distinguished from insignificant ones.

After clicking on [Data], you return to the display of the fluorescence intensities.
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Real time pcr project - DermoProjektFuer ScreenshotsV3-2_Sybr+Melt.rip EI@
i Settings J/\L Menitoring I/E Analysis ]/D Documentation ] 4 Pk

Messung (Tm) =
Gene of Interest (GOI): Threshold: 1,31 E]

ddrn/dT

Temp (°C)
Ableitung | GOI |
2 ;
wel 8 I Sample name |Sam|:||e type ITm Mean Tm Std.Dev. ... | -
Al i 1 Unknawn 79,6 79,46 0,2 (o
A6 B Unknown 79,4 79,46 0,2
sz [l Unknawn 73,3 73,46 0,2
B1 B Unknown 79,6 79,46 0,2
Bs B Unknawn 79,4 73,46 0,2
sz Unknawn 79,1 79,46 0,2
a I Unknawn 79,6 79,4 0,2
cé B Unknown 79,4 79,46 0,2
cz  l: Unknawn 7,2 79,4 0,2
D1 B Unknawn 73,7 79,46 0,2
s [l Unknawn 79,4 79,4 0,2 -

Monitoring project window with calculation of the melting temperature
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Evaluation

Evaluation

On the Analysis tab of the project window the following methods are available for
evaluating real-time PCR experiments on four cards:

= Absolute quantification

m  Relative quantification

= AACt method

= Melting curve determination

= Genotyping

®m  POS/NEG analysis at the end point

E5i Real time pcr project - T-Optical_Demo_AbsoluteQuantitatio — |EI|1|
i Settings ]/\,, Manitaring 1 Analysis|/ [£]  Documentation 1 I

j!'j‘nhsnlutequantiﬁcatiun ]/'4:5. Relative quantification }/“}Et ddiCt quantification ]4 b

Absolute Quantification: ELRECIEY -

Gene of interest (GOI): Group: Threshald:
FAM *|| [T Include pass, reference IGrUup 1 j |1;34 ﬂ
100
721
s i
= S0
25
a
T T T T T T T
5 10 15 20 25 30 35 40
Cycle

GOL-FAM | Mean Ct | Mean conc,

€

4
t +
Well I Sample name ISampIe tvpe k AIMean Ct IConc. Std, Iﬂ

EZ Stdl Standard 17,23 17,31 10000

El . Stdi Standard 17,27 17,31 10000

E3 . Skdl Standard 17,41 17,31 10000

c2 Sarmplel Unknawn 19,78 19,93

3 Samplel Unknown 19,99 19,93

C1 Sarmplel Unknawn 20,03 19,93 _ILI

K| 4
Table | Standard curve |

Analysis project window

The individual evaluation methods can be accessed via the subordinated tabs. For each

selection method different evaluations can be created.

Toolbar and menu commands are adjusted to the requirements of the selected method

tab.
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5.1 General functions in the evaluation project window

5.1.1 Making basic settings

Presets can be made for some evaluation parameters.

£33
1. Clickon 'ﬁﬂ in the toolbar.

2. Set up the following parameters.

Absolute quantification Dpkioy |

—amoothing caling

= none ¥ linear

i+ |3 'I Points " lagarithmic

Baseline correction

* Far all samples
From cycle: To cycle:

f2 =E =

" sample specific
Crop first cycles:

=

rAuta threshold

{* Standard deviation of base lines

" Defined standards

rFilker

Intensity: [~ Cancel noise

Imedium j
Ok, - ko Thr, I Ok - Fix Thr, | Cancel |

Window for basic evaluation settings

Option Function

Smoothing Smoothing the fluorescence curves on the basis of the calculated moving
average over a range of 2 to 12 measuring points or representation without
smoothing

Scaling Linear or logarithmic representation of fluorescence curves

Baseline At the correction of the base line you can choose between two options:

correction = For all samples: At this correction the base line is determined for every

sample in the same area. The lower and upper area limit has to be edited
in the fields From cyncle and To cycle.

®  Sample specific: This correction should be chosen if the curves have very
different Ct values. The lower area limit for the determination of the base
line will adjusted in the field Crop first cycles for all samples. The upper
area limit is separately found out by an algorithm for each sample.

Note:

The manner of the base line correction can be selected only in this dialog. The
area limits can, however, be adapted for the correction in the project window.

66



Evaluation

Autom. Calculation of the threshold as a deviation of x times of the standard deviation

threshold of the baselines (factor can be adjusted under Extras / Options / Analysis in
the main menu) or based on defined standards with the goal to get the
maximum value for the coefficient of determination R?

Filter Digital filter for smoothing the fluorescence curves. Adjustable in steps: slight,
medium and strong

Cancel noise  Curves with high background noise that are not interpreted as amplification
curves by the software are set to 0 and no Ct values are calculated.

Auto The threshold line is calculated new when changes to the basic settings are

Threshold made.

Fix The set threshold line is maintained when changes to the basic settings are

Threshold made.

More setting options may be available depending on the analysis method used. They are
explained separately in the respective sections. All items displayed on the Analysis
project tab can also be accessed quickly via the settings area of the baseline and
displayed as linear or logarithmic representations. For this purpose, a selection for
display options can be opened in the corresponding window via the right-arrow button

>

Baseline correction:
Min: A 3 L4
Max: 4 15 [k

Baseline correction:
Pts: A 5 g

Scaling: Scaling:
m linear m ingar
logarithmic logarithmic

For all samples baseline correction
parameter

Sample specific baseline correction
parameter

Individual setting of the baseline correction and fluorescence curve scaling during the evaluation

5.1.2 Activating/deactivating samples for evaluation

Samples from individual wells can be activated or deactivated for evaluation in the
project explorer Samples menu item. This enables you, for example, not to include
excessive values when calculating mean values.

Note:
The selection in the project explorer only influences the analysis of the fluorescence
data. Measured data will not be deleted.
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Project explorer Samples window for (de-)activating the samples in the evaluation

The marking of the sample assignment corresponds to the marking on the Samples
project tab. The color code for each sample type can be modified in menu Extras /
Options P colors.

Sample type Symbol  Definition
Empty E Describes an empty position on the PCR plate
Unknown u Sample of unknown concentration or dilution

(measuring sample)

Standard S Sample of known concentration or dilution

Calibrator K Sample whose gene of interest expression level is set as
1

No template control N Complete reaction preparation but without matrix strand

(NTC)

Positive control + Positive control preparation for which a reaction product
is expected

Negative control - Negative control preparation for which no reaction

product is expected

Active wells (i.e. wells included in the analysis) are marked with their sample type
symbol. For deactivated wells the position is grey and the fluorescence data is hidden.
Empty wells are marked "E".

= (lick with the mouse to switch. The activation changes with each click on a well.

= You can change adjacent wells by holding the mouse button and moving the cursor
over the wells.

®  Complete rows and columns can be inverted by clicking on the letter or number of
the row [A-H] or column [1-12].

= The complete plate can be inverted by clicking on @ on the top left between A and
1.

®  To activate all wells click on the @ symbol below the chart.

®  To activate only samples of a specific type click on the corresponding symbol below
the chart. To activate multiple sample types at the same time keep the Ctrl key
pressed when clicking on the sample types.



5.1.3 Exporting fluorescence data

Evaluation

The data from the fluorescence measurement can be exported as ".csv" files. In addition,
the graphical display of the measurement results can be copied to the clipboard as a
hardcopy and is hereby made available for other programs.

= Right-click on the graph.

® A selection window for export and hardcopy appears.

= (lick on Copy chart to copy the chart to the clipboard.

m  Select the Save chart option to export the fluorescence data.

The Save as standard window opens.
Enter a file name and confirm with [OK].

Real time pcr project - qTOWER3_Demo_AbsQuant1_l.ritp

iy Settings & Monitoring

& Analysis

ﬂ Documentation

‘_‘ Absolute quantification & Relative quantification

Absolute Quantification: [SIER 1

Gene of interest (GOI):
FAM w

Indude pass. reference

v—

Group: Threshold:
Gowp1  ~| |13

100 4

75

dRn
3
1

Copy chart

Save chart as C5V-File

(*.csv)

25

GOI-FAM | Mean Ct | Mean conc.

Exporting data from the evaluation

5.1.4 Configure results table

For each analysis the results are summarized in a table that is accessible by the tab

TABLE.
well B | Sample name ISampIe bype ICt |Mean k IConc. Skd,
El Skdz Standard 20,55 20,7 1000
B2 . Skd2 Standard 20,75 20,7 1000
B3 | Er Standard 20,76 20,7 1000
1l Samplel Unknown 20,03 19,93
[ Samplel Unknown 19,75 19,93
C_SI—I Samplel Unknown 19,99 19,93
4

r

5

| rable [ Standard curve |

Results table

Depending on the analysis method the results table contains different data sets but for
each table the view and selection of columns to be displayed can be configured user-

defined:

® By click with the right mouse button on a column header a box is displayed in which
single columns can be selected or deselected to be shown in the table.
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® By dragging a columns header with pressed left mouse button columns can be
exchanged against each other and the arrangement modified.

= By click with the left mouse button on the left or right border of a columns header
the width can be modified.

® By click with the left mouse button on a columns header the data becomes arranged
ascending or descending (by number or alphabetically).

®  The colors of the amplification curves can be changed after double-clicking on the
color cell in the table row.
Press the Ctrl key and double-click the Edit color window to set the color for multiple
wells (— section "Entering sample properties into the sample table" p. 42).

® By click with the left mouse button on the column ,Well” the display of data switches
between column- or row-wise representation of the results. The column- or row-
wise representation is based on the arrangement of samples in the layout.

Symbol Meaning
Witell m | Display of data by columns

Well B Display of data by rows

5.1.5 Export results
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The results table can be exported as Excel-file (*.xls) or ,*.csv'-file.
®  (lick with the right mouse button on the results table.

A context menu opens with the commands Save Table as Excel-File (*.XLS), Save Table
as Excel-File (*.XLS) and run Excel and Save Table as CSV-File (*.CSV).

®  Select the corresponding command.

®  The standard Windows dialog SAVE AS opens. Enter a name for the file and confirm
the settings with [OK].

Note:
User defined configurations of the results table are included in the exported data set (—
section "Configure results table" p. 69).

well B I Sample name |Sample type |Ct IMean ct |Conc. Std. Ij
El Stdz Standard 20,58 20,7 1000
B2 . Skdz Standard 2N.7A 2N.7 1000
B3 . Stz Save kable as Excel-File (*,xls) 1000
Save table as Excel-File (*,xls) and run Excel
C1 Samplel
farcd Samplel Save table as CSW-File (*,csw)
3 Samplel Inknown 19,99 19,93 -
K1 | 4
Table | Standard curve |

Export results



5.2

5.2.1

Evaluation

Absolute quantification

The absolute quantification is used to determine absolute copy numbers in samples with
the help of the comparison with standards with known concentrations.

Creating an evaluation for an absolute quantification

1. Go to the Analysis / Abs quant project tab.
If the tab is not visible, click on the arrows 4 ¥ in the tab bar. This will scroll the
tabs.

2. Click on the ﬁg’“ symbol in the toolbar.

Optionally, call up the AbsQuant » Add abs. quantification menu command.
3. Aninput window appears. Enter the description for the current evaluation.
On the AbsQuant tab the following information is activated:
= Parameter settings (1)
= Display of fluorescence spectra (2)

= Display of result table with measurement results (3)

= Display of the standard curves and the calculated coefficients (4)
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i Real time pcr project - T-Optical_Demo_AbsoluteQuantitation.rtp - |EI|§|
£ Settings 4 analysis

& Monitoring D Documentation

=% Absolute quantification l/% Relative quantification ]/“?.Et ddCt quantification ]4 i

o"-sulute Quantification: EiEeIEy 3 _
ene of interest (G0N Group: Threshold:
FAM || [ Include pass, reference IGI’DLID 1 j |1;34 ﬂ
1004
75
s |
& S0
2)
25
o
T T T T T T T
5 10 15 20 25 30 5 40
Cycle

GOI-FAM | Mean Ct | Mean conc,

5 0
T T
el | Sample name |Sarnple type [ald & |Mean Ct Conc, Std, |ﬂ

Ez iStdl Standard 17,23 17,51 10000

E1l . Skdl Standard 17,27 17,31 1o0og

E3 . Skdl Standard 17,41 17,31 10000

2 . Samplel Unknown 19,78 19,93

C3 . Sarmplel Unknawn 19,99 19,93

E|_| B camplet Unkniown 20,03 19,93 _|;|
L] »

3 iTabIe Skandard curv@

Window for absolute quantification

5.2.2 Setting parameter for absolute quantification

Abs. Quantification: AbsQuant _

zene of interest {GOLL Group: Threshold:
FaM-c-mye - [™ | Include pass. reference IGroup 1 j [3.923 ﬂ

Parameter settings for absolute quantification

Set the following parameters for the absolute quantification:

Option Description

Selection list Selection of an evaluation created for the experiment

Gene of Selection list of target gene/dye combinations

interest (GOI) According to the selection, the fluorescence and regression curves for the

concentration are displayed.

Incloud pass. Only active if a dye has been defined as a passive reference on the Settings
reference /Scan project tab

If this option is activated, the fluorescence of the dye that has been set as a
passive reference is used for standardization.
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Setting the threshold
value

Fix Threshold

Evaluation

Group If several experiments were carried out on the PCR plate, select the group
of the experiment to be analyzed. (— section "Defining groups” p. 49).

Threshold Manually adjust threshold value
The threshold value must be between 1 and 100, depending on the
standardized representation of the fluorescence curves (dRn).
Note:
The threshold value can be calculated automatically or set manually in the
chart (see also "Setting the threshold value" below).

¥ Opens the selection window with display options (— section “Displaying
the fluorescence curves for absolute quantification” p. 73).

To determine Ct values for the evaluation, a threshold value needs to be determined for
each experiment first.

You have several options for setting the threshold value:
= |n the general options (— section "Making basic settings" p. 66).
= Manually in the parameters for the respective evaluation (see table above)

®  Graphically in the fluorescence curves representation:
In the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so. At the same time, the Ct values in the
result table are updated.

Note:

Due to the further spread of the early exponential area of the product accumulation
curves, a logarithmic representation is better suited for setting the threshold
manually in the display range than a linear representation.

® By automatic calculation:
The automatic calculation of the threshold value is activated by clicking on the ==
symbol.
Alternatively, you can call up the AbsQuant » Autom. Threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the corresponding Threshold input field.

The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that
the threshold value is retained if the basic settings for the analysis are changed (—
section "Making basic settings" p. 66).

5.2.3 Displaying the fluorescence curves for absolute quantification

In the display range, the measured data, standardized to the value 100 for highest
fluorescence intensity, is plotted against the cycle for the selected target gene.

The respective fluorescence curves are displayed by switching to another target
gene/dye combination.

The fluorescence data is displayed as a linear or logarithmic representation depending
on the selected display option. For both display options the program shows brief
information on the sample if the cursor is placed on one of the curves.
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Switching the display 1. Click on the 2 button in the parameter bar.
options for the chart
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.

100 +

75

dRn

50

25

5 10 15 20 25 30 33 40

GOI-FAM | Mean Ct | Mean conc, |

Linear representation of the fluorescence curve for the absolute quantification

100

well E1 (Std1}

| A

dRn

01 T

Cycle

GOI-FAM | Mean Ct | Mean conc. |

Logarithmic representation of the fluorescence curve with horizontal threshold line

5.2.4 Display of the mean Ct values or mean concentrations

After selecting the tab MEAN. CT or MEAN. CONC. the display changes to a presentation of
the results as bar chart. The respective sample name is given below each bar. The height
of the bar is determined by the mean Ct-value or the calculated mean concentration of
replicates. For each bar some short information about the position of the samples, the
mean value and the calculated standard deviation is shown if the mouse pointer is
placed on it. The size of the standard deviation is shown as error bar on top of each bar.
Since for large numbers of samples not all bars can be displayed in the screen the
diagram can be moved horizontally with pressed left mouse button and dragged to the

desired position.
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5.2.5 Displaying the standard curve and results of an absolute quantification
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In the bottom Standard curvesection of the Analysis project window, you can switch
between the calculated standard curve and the result table via the Curve and Table list
sheets.

For the display of the standard curve the Ct values of the standard samples are plotted
graphically against the logarithm of their concentration. In the value range on the right

the following calculated data is displayed:

the coefficient of determination R? of the linear equation
the standard curve gradient
the intersection of the curve with the y-axis at x=0 (offset)

The PCR efficiency
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The standard curve and the values are automatically calculated by the gPCRsoft auto
software and updated in case of settings modifications.

FaM u]
FAM, 2, 24,48 B 0,99927
o 2T J Slope 3,62
f
20 4 Offset 31,72
; ; ; ; | PCR Efficiency |0,59
1 1,5 2 25 3 35 4
Log Std. Conc.
Table | Standard curve |

Standard curve for absolute quantification

The result table for the absolute quantification contains all data and the associated
measurement values for the samples.

well B | Sample name ISampIe type ICt IMean Ck IConc. Skd, Iﬂ
E1 iStdZ Standard 20,558 20,7 1000

B2 . Std2 Standard 20,75 20,7 1000

B3 . Shdz Standard 20,76 20,7 1000

Cl Samplel Unknown 20,03 19,93

cz Sarmplel Unknawn 19,78 19,93

C_3|_| Samplel Unknown 19,99 19,93 _|;|
Ll 3

"| rable [ Standard curve |

Result table for absolute quantification

Display in the project
explorer

76

For the absolute quantification the results table contains the following information:

Column
Well

color of curve

Sample name
Sample type
Group

Gene

Ct

Mean. Ct
Conc. Std

Mean conc.

StdDev. Ct
%CV Ct

StdDev. Mean
conc.

Description
Position of sample

Each sample is automatically assigned an unchangeable color which is used
to display the corresponding fluorescence curve

Name of sample

Type of sample

Assignment of the sample to an experimental group
Name of gene measured in the sample

Ct value of sample

Mean Ct value of replicates

Concentration of the standard sample

Concentration determined from the standard curve on the basis of the mean
Ctvalue

Standard deviation of the Ct values between replicates
Variation coefficient of the Ct values between replicates

Standard deviation of the mean concentration

A shortened representation of the standard curve calculated by the software is displayed
in the project explorer under Abs. quant. The image displays the graphical plot of the Ct
values of the standard samples against the logarithm of their concentration:
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Log Std, Kz,

Representation of the standard curve in the project explorer

5.2.6 Exporting results of calculations

Excel and CSV

Export to qBASE+

Exporting measurement data and results of calculations enables you to perform more
extended data analysis by using dedicated software.

You can design the results table according to your requirements by setting type,
sequence and width of the columns to be displayed. You can also adjust the sort
sequence of data in the column (alphabetical, numerical, by column, by row). The table
configured this way can be exported as Excel or CSV file by right clicking the table.

Save table as Excel-File (*,xls)
Save table as Excel-File (*,xls) and run Excel

Save table as CSW-File (%, ooyl

Context menu for data export

gqBASE+ is a software which allows for a more detailed statistical analysis of your gPCR
data. For information see www.biogazelle.com. Using the analysis module ‘Absolute
Quantification’ of gPCRsoft auto you can export gPCR data to a file which can be read
and analyzed by qBASE+.

|_|
1. In order to export qPCR data for use in gBASE+ click the symbol E¥ in the toolbar.
Alternatively you can select the menu ABSOLUTE QUANTIFICATION / QBASE EXPORT.

2. Choose the targets shall be exported and the data format shall be used (qBASE+ is
able to read both formats) in next dialogue.

The following information is sent to qBASE+:
= Well

= sample type

® sample name

®  gene name

® (Ctvalue

®  concentrations of standards

® sample active/inactive
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5.2.7

78

sl x

Q1 (FAM)
Q2 (ROX)

& * cov Expork
= # wls Export

Ok I Abbruch

Window QBase Export fort he data export to qBase+

Note:

Only those genes are displayed in the export dialogue which were set as GOI before.
Therefore in multiplex assays for each GOI, i.e. each dye, an absolute quantification
must be defined. To do so repeat the steps explained in section "Creating an evaluation
for an absolute quantification" p. 71, topic 2 and 3, for each GOI.

Importing the standard curve

Next to the option to measure a standard curve in the experiment, the gPCRsoft auto
software can also be used to determine the concentration of the samples based on the
saved standard curve. You can use the import function for this purpose.

1. Usethe E,‘% symbol in the toolbar to open the Import standard curve window.

Optionally, you can call up the AbsQuant / Import standard curve menu command.

The mathematical equation that the standard curve is based on and the associated
dye are each displayed in the list fields of the window.

2. Select one of the import options from the Import standard curve window and make
the corresponding entries:

Option

Import from this
run

Import from saved
run

Manual input

Delete External
Standards

Meaning

Imports a standard curve from the current open project.

If several standard curves are saved in one project, all curves are
displayed and you can make a selection.

Imports a standard curve from a saved project.

If several standard curves have been saved, select the corresponding
curve from the list.

Standard curve coefficients are entered manually.

Enter the gradient and the intercept for the equation:

Ct = gradient * log(conc) + intercept

Deletes imported or entered standard curves so that they are no
longer used for analysis



Evaluation

5.2.8 Deleting the evaluation of an absolute quantification

An evaluation that is no longer required can be removed.

1. Activate the evaluation by selecting its description in the evaluation list of the
method tab.

2. Clickon ?i in the toolbar.Optionally, you can call up the Absolute quantification »
Delete evaluation menu command.

The evaluation is removed.

5.3  Relative quantification

Relative quantitation allows for determination of the relative expression level of a gene
of interest in relation to one or more reference genes (often housekeeping genes). If
one of the samples is denoted as the calibrator, the expression level of that sample is
set to unity and the relative expression levels of all the other samples are given in
relation to the calibrator sample. For relative quantification standard dilution series are
required for the gene of interest as well as for the reference genes.

5.3.1 Creating a new evaluation for a relative quantification

1. Go to the Analysis / RelQuant project tab.
If the tab is not visible, click on the arrows 4 ¥ in the tab bar. This will scroll the
tabs.

ik
= L .
2. Click on the " 7 symbol in the toolbar.
Alternatively, call up the RelQuant » Add rel. quantification menu command.

3. Aninput window appears. Enter the description for the current evaluation.

On the Rel. Quant. tab the following information is activated:

= Parameter settings (1)

= Display of the fluorescence curves for the target gene and the reference gene (2)
m  Display of the result table with the added values (3)

®  Display of the standard curves for the target gene and the reference gene and the
calculated coefficients (4)
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Efi Real-Time PCR Projekt - T-Optical_Demo_RelativeQuantitation.rkp - |EI|5|
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Relative Quantifizierung: [ETEGS] -
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B7 | B Standard c-myt 26,21
BS | B Standard £yt 26,15
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Window for relative quantification

5.3.2 Parameter settings for relative quantification

Rel. Quantification: ReQuant _

Gene of Inkerest (GOI); Group: Threshold:
FAM-c-myc - I™ | Include passive reference Group 1 j |23.163 ﬂ

Reference genes!

| vic-GaPDH = !l

Parameter settings for relative quantification

The following parameters must be set for the relative quantification:

Option Description
Selection list Selection of an evaluation created for the experiment
Gene of Selection list of target gene/dyecombinations

interest (GOI) According to the selection, the fluorescence and regression curves for the
concentration are displayed.

Only one target gene at a time can be selected.
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value

Fix Threshold

Reference
genes

Include pass.

reference

Group

Threshold

»

Evaluation

Reference gene selection list

In contrast to the target gene, several reference genes can be selected at the
same time. The number of list sheets in the display range therefore grows
with each reference gene.

The [#]symbol is used to remove all reference gene settings from the
evaluation.

Only active if a dye has been defined as a passive reference on the Settings
/ Scan project tab.

If this option is activated, the fluorescence of the dye that has been set as a
passive reference is used for standardization.

If several experiments were carried out on the PCR plate, select the group of
the experiment to be analyzed. (— section "Defining groups" p. 49).
Manually adjust threshold values

The threshold value must be between 1 and 100, depending on the
standardized representation of the fluorescence curves (dRn).

Note:
The threshold value can be calculated automatically or set in the graph.

Opens the selection window with display options

To determine Ct values for the evaluation, a threshold value needs to be determined for
each experiment first.

You have several options for setting the threshold value:

= |n the general options (— section "Making basic settings" p. 66)

= Manually in the parameters for the respective evaluation (see table above)

®  Graphically in the fluorescence curves representation:
In the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so. At the same time, the Ct values in the
result table are updated.

Note:

Due to the further spread of the early exponential area of the product accumulation
curves, a logarithmic representation is better suited for setting the threshold
manually in the display range than a linear representation.

® By having it calculated automatically:

B
The automatic calculation of the threshold value is activated by clicking on the = &=

symbol.

Alternatively, you can call up the RelQuant » Autom. Threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the corresponding Threshold iput field.

The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that
the threshold value is retained if the basic settings for the analysis are changed (—
section "Making basic settings' p. 66).
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5.3.3 Displaying the fluorescence curves in the relative quantification

In the display range, the measured data, standardized to the value 100 for highest
fluorescence intensity, is plotted against the cycle for the selected target gene. The
target gene/dye and the reference gene/dye combinations are each assigned a list sheet
that can be activated by clicking on the gene/dye tab on the bottom.

Since only one target gene/dye combination is permitted at a time, the fluorescence
curves of the selected combination are displayed whenever a new combination is
selected. The number of the available list sheets depends on the number of the selected
reference genes.

The fluorescence data is displayed as a linear or logarithmic representation depending
on the selected display option. For both display options the program shows brief
information on the sample if the cursor is placed on one of the curves.

Switching the display 1. Click on the ] button in the parameter bar.
options for the chart
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.

100 <

751

50

dRn

25 1

5 10 15 20 25 30 33 40

GOI-FAM | Ref.gene-FAM | Narm.rel, canc, |

Linear representation of the fluorescence curve for the relative quantification

100

5 /Well B1, 21, 3,31 {Std2)
= il
- / M /
0,1 T T T T T T T
5 10 15 20 25 30 E5 40

Cycle

GOI-FAM | Ref.qene-FAM | Morm.rel, conc, |

Logarithmic representation of the fluorescence curve for the relative quantification with horizontal
threshold line
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5.3.4 Display of the normalised relative concentrations

After selecting the tab Norm. rel. conc. the display changes to a presentation of the
results as bar chart. The respective sample name is given below each bar. The height of
the bar is determined by the mean Ct-value or the calculated mean concentration of
replicates. For each bar some short information about the position of the samples, the
mean value and the calculated standard deviation is shown if the mouse pointer is
placed on it. The size of the standard deviation is shown as error bar on top of each bar.
Since for large numbers of samples not all bars can be displayed in the screen the
diagram can be moved horizontally with pressed left mouse button and dragged to the
desired position.

RC

EAM _ Skd?
EAM _ Skd=
FAM - Skdd

Efabl _ SkA1

GOI-FAM | Ref.gene-FaM |Morm.rel, conc,

Bar chart for display of normalised relative concentrations

5.3.5 Displaying the standard curves and the results of a relative quantification

In the upper area of the project window you can switch between the display of the
calculated standard curves for the target gene and all selected reference genes and the
result table for the relative quantification using the Standard curve and Table list
sheets.

For the display of the standard curve the Ct values of the standard samples are plotted
graphically against the logarithm of their concentration. For the respective data points
errors bar are shown that indicate the standard deviation between replicates. For each
data point some short information about the sample name and the size of the standard
deviation of replicates is shown if the mouse pointer is placed on it. In the value range
on the right the following calculated data is displayed:

® the coefficients of determination R? of the linear equation

® the standard curve gradients

® the intersections of the curves with the y-axis at x=0 (offset)
® the PCR efficiency

When more than one standard curve is displayed each curve has its individual color.
Accordingly each table has a color code in the header that reflects the assignment to the
respective standard curve. The standard curve and the values are automatically
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calculated by the qPCRsoft auto software and updated in case of settings modifications.
According to the number of genes used a scroll bar appears under the table. It can be

84

used to navigate through the table's columns.

FaM-cmyc ® [FaM-GaPCH m
30
FAM-GAPDH, 2,18, 25,68 | R2 u,99322 0,99z22
& 254 Slope -3,06 -4,18
20 CFfset 29,1 34,28
| | PCR Efficiency |1,12 0,74

Table |Standard curve

Log Std. Conc.

Standard curves for relative quantification

The result table for the relative quantification contains all data and the associated
measurement values for the samples.

well B | Sample name |Sam|:-le bype IGOI IReference. " |Ct a0l ICt Refere, ﬂ
B1 Stdz Standard c-rye 20,23

B2 B Standard c-mye 20,35

B3 B sta: Standard iy 20,29

B7 B stas Standard commyc 26,21

B8 B Standard ey 26,15

B9 B Standard ey 26,14 _|ﬂ
4 I I 3

| rable [ Standard curve |

Result table for relative quantification

For the relative quantification the results table contains the following information:

Column
Well

Color of curve

Sample name
Sample type
Group

GOl

Reference gene
Ct GOI

Ct Reference
gene

Mean. Ct GOI

Mean. Ct
Ref.gen

Conc. Std. GOI

Conc. Std
Ref.gen

Mean Conc. GOI

Meaning
Position of sample

Each sample is automatically assigned an unchangeable color which is
used to display the corresponding fluorescence curve

Name of sample

Type of sample

Assignment of the sample to an experimental group
Gene of interest

Reference gene

Ct value of gene of interest

Ct value of reference gene

Mean Ct value of replicates of the gene of interest

Mean Ct value of replicates of the reference gene

Concentration of the standard for the gene of interest

Concentration of the standard for the reference gene

Concentration for the gene of interest determined from the standard
curve on the basis of the mean Ct value



Display in the project
explorer

5.3.6

Mean Conc.. Ref.

gen

Std.Dev. Ct GOI

Std.Dev. RefGen

%CV Ct GOI

%CV Ct RefGen

Relative Conc.

Norm. Rel. Conc.

Std.Dev.
Relative Conc.

Std.Dev. Norm.
Rel. Conc.

Evaluation

Concentration for the reference gene determined from the standard curve
on the basis of the mean Ct value

Standard deviation of the Ct values between replicates of the gene of
interest

Standard deviation of the Ct values between replicates of the reference
gene

Variation coefficient of the Ct values between replicates of the gene of
interest

Variation coefficient of the Ct values between replicates of the reference
gene

Relative (x-fold) expression level of the gene of interest in relation to the
reference gene

Relative (x-fold) expression level of the gene of interest in relation to the
reference gene, standardized to the expression of the calibrator (if
defined)

Standard deviation of the relative concentrations

Standard deviation of the normalised relative concentrations

A shortened representation of the standard curves calculated by the software is
displayed in the project explorer under Relative quantification. The image displays the
graphical plot of the Ct values of the standard samples against the logarithm of their

concentration.

B Relative quantification =

30
o 257
(]

20

Log Std. Conc.

Representation of the standard curves in the project explorer

Importing the standard curve for relative quantification

Next to the option to measure a standard curve in the experiment, the gPCRsoft auto
software can also be used to determine the concentration of the samples based on the
saved standard curve. You can use the import function for this purpose.

1. Usethe ﬂ?" symbol in the toolbar to open the Import standard curve window.
Optionally, you can call up the RelQuant » Import standard curve menu command.

2. All additional setting are analogous to the settings for the absolute quantification
(— section "Importing the standard curve" p. 78).
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5.3.7 Deleting the evaluation of a relative quantification

An evaluation that is no longer required can be removed.

1. Activate the evaluation by selecting its description in the evaluation list of the
method tab.
L
2. Click on the " &7 symbol in the toolbar.
Alternatively, call up the RelQuant » Delete rel. quantification menu command.

The evaluation is removed.

5.4 AACt method

The AACt-method allows for determination of the relative expression level of a gene of
interest in relation to one or more reference genes (often housekeeping genes). One of
the samples has to be denoted as the calibrator. The expression level ofthe calibrator is
set to unity and the relative expression levels of all the other samples are given in
relation to the calibrator sample. In AACt-method there is no need to measure standard
dilution series. However, if the AACt-method shall be validated within the same PCR run
standard dilution series must be defined.

5.4.1 Creating a new evaluation for a AACt method

1. Go to the Analysis / ddCt quantification project tab.
If the tab is not visible, click on the arrows ¥ * in the tab bar. This will scroll the
tabs.

ddlCt
2. Click on the ©% symbol in the toolbar.
Alternatively, call up the DeltaDeltaCt / Add ddCt quantification menu command.

3. Aninput window appears. Enter the description for the current evaluation.
On the DeltaDeltaCt tab the following information is activated:
®  Parameter settings (1)

= Display of the fluorescence curves for the target gene and the reference gene (2)

Display of the result table with the added values (3)

If standards have been defined, display of the standard curve (4) and the validation
curve (5) for the expression level of the gene of interest in relation to the reference
gene and the calculated factors
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Project window for the AACt method

Parameter settings for the AACt method

ddCt Quantification: [EEEE R _
Gene of Inkeresk (GO Group: Threshald:

FAM-c-myc - Goupl v| [3e.12s] 2
Reference genes:

[ ROX-Tubuiin =1 |

Parameter settings for the AACt method

The following parameters must be set for the AACt method:

Option Description
Selection list Selection of an evaluation created for the experiment
Gene of Selection list of combinations of measured dyes and target genes to be

interest (GOI)  quantified

Only one target gene at a time can be selected.
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Reference Selection list for the reference genes

genes In contrast to the target gene, several reference genes can be selected at the
same time. The number of list sheets in the display range therefore grows
with each reference gene.
With the [#]symbol you can remove all selected reference genes from the
selection.

Group If several experiments were carried out on the PCR plate, select the group of
the experiment to be analyzed. (— section "Defining groups" p. 49).

Threshold Manually adjust threshold values
The threshold value must be between 1 and 100, depending on the
standardized representation of the fluorescence curves (dRn).
Note:
The threshold value can be calculated automatically or set in the graph.

M Opens the selection window with display options
Setting the threshold To determine Ct values for the evaluation, a threshold value needs to be determined for
value each experiment first.

You have several options for setting the threshold value:
= |n the general options (— section "Making basic settings" p. 66).
= Manually in the parameters for the respective evaluation (see table above)

®  Graphically in the fluorescence curves representation:
In the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so. At the same time, the Ct values in the
result table are updated.

Note:

Due to the further spread of the early exponential area of the product accumulation
curves, a logarithmic representation is better suited for setting the threshold
manually in the display range than a linear representation.

® By having it calculated automatically:
The automatic calculation of the threshold value is activated by clicking on the ==
symbol.
Optionally, you can call up the DeltaDeltaCt » Autom. Threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the corresponding Threshold iput field.

Fix Threshold The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that
the threshold value is retained if the basic settings for the analysis are changed (—>
section "Making basic settings" p. 66).
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5.4.3 Displaying the fluorescence curves for the AACt method

Switching the display
options for the chart

In the display range, the measured data, standardized to the value 100 for highest
fluorescence intensity, is plotted against the cycle for the selected target gene. The
gene/dye and the reference gene/dye combinations are each assigned a list sheet that
can be activated by clicking on the gene/dye tab on the bottom.

In the evaluation you can always use only one target gene but several reference genes.
The number of the available list sheets depends on the number of the selected genes.

The fluorescence data is displayed as a linear or logarithmic representation depending
on the selected display option. For both display options the program shows brief
information on the sample if the cursor is placed on one of the curves.

1. Click on the ﬂ button in the parameter bar.
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.

100
75

50 Well Al {sal)

254

dRn

5 i0 15 20 25 30 35 40

Cycle

GOI-FAM | Ref.gene-FaM | Mormalized expression | Relative quantity |

Linear representation of the fluorescence curve for the AACt method

100

well al (sal) t

dRn

0,1 T T T T T T T

Cycle

—|GOI—F.¢\M | Ref.qene-FaM | Mormalized expression | Relative quantity |

Logarithmic representation of the fluorescence curve for the AACt method
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5.4.4 Display of the normalized relative expression or relative quantities

After selecting the tab Normalized Expression or Relative Quantity the display changes
to a presentation of the results as bar chart. The respective sample name is given below
each bar. The height of the bar is determined by the calculated normalized expression or
the calculated relative quantity of replicates. For each bar some short information about
the position of the samples, the mean value and the calculated standard deviation is
shown if the mouse pointer is placed on it. The size of the standard deviation is shown
as error bar on top of each bar. For the representation of the relative quantities the
results for the target gen and reference gene the bars are colored differently. Since for
large numbers of samples not all bars can be displayed in the screen the diagram can be
moved horizontally with pressed left mouse button and dragged to the desired position.

1,75
1,5

1,25

NE

BS, B6 | 1]2,04
0,75
0,5

0,25

Fam - eal
[ =1, 1.0 )
Fafd - oo
CAR o
FAM - sa5

GOI-FAM | Ref.gene-FAM |Normalized expression | Relative quantity |

Bar chart for display of normalized expression of replicates

RQ

B3, B4 | 2,65 ] 4,51

GOI-FAM | Ref.gene-FaM | Mormalized expression |Relative quantity

Bar chart for display of relative quantities of replicates

90



Evaluation

5.4.5 Setting the calculation mode for the standardized expression

Calculating the
standardized expression
SE without efficiency
calculation (Livak
method)

Calculating the
standardized expression
SE with efficiency
calculation (Pfaffl
method)

The qPCRsoft auto software enables you to calculate the standardized expression SE
with two different methods:

= Without PCR efficiency calculation (Livak method)
= With PCR efficiency calculation for GOl and reference genes (Pfaffl method)

To calculate the standardized expression SE, one sample must be defined as the
calibrator.

The Livak method assumes that the PCR efficiencies of the gene of interest (GOI) and
the reference gene (RefG) are equal. The following applies:

NE = Z—AACt

where AACt = ACt(Calibrator) — ACt(Sample)
and ACt(Sample) = Ct(GOI,Sample) — Ct(RefGene, Sample)
ACt(Calibrator) = Ct(GOI, Calibrator) — Ct(RefGene, Calibrator)

The Pfaffl method considers the efficiencies determined for the gene of interest (GOI)
and the reference gene (RefGene). The efficiencies (E(GOI) and E(RefGene)) can be
calculated from dilution series or specified in the software. The following applies:

[1+ E(GON]*¢(¢oD
[1 4+ E(RefGene)]ACt(RefGene)

NE =

where ACt(GOI) = Ct(GOI, Calibrator) — Ct(GOI, Sample)
and ACt(RefGene) = Ct(RefGene, Calibrator) — Ct(RefGene, Sample)

The Pfaffl method is generally preferred as the basic assumption of the Livak method
(equal efficiency when amplifying the gene of interest and the reference gene) is rarely
the case in practice and the calculation can therefore lead to incorrect values.

The calculation method is selected in the ddCt Options window.

]
= (lick on the “& symbol in the toolbar.
Alternatively, call up the DeltaDeltaCt || ddCt Quant. options menu command.

®  Select the desired calculation method.
For the Pfaffl method, the efficiency values can be determined automatically from
the standard curves (dilution series) for the gene of interest and the reference gene
(if standards have been defined) or the values can be entered manually in the
respective fields.
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Intensity: [~ Cancel noise
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ddCt Options window for presetting the analysis of the AACt method

5.4.6 Displaying the validation curves and values
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To calculate the AACt values there is no need to determine a validation curve. However,
it might be useful to consult it when checking the data quality.Prerequisite for creating a
validation curve is measuring a standard series with different dilution levels of target
gene and reference gene. If standard series have been measured for the target and
reference gene, the expression ratio between target and reference gene is represented
graphically in the Validation curve display. For this purpose, the mean Ct value of the
target gene is subtracted from the mean Ct value of the reference gene for the
corresponding dilution level and the resulting dCt(V) value is plotted against the
logarithm of the concentration.

In the value range on the right the following calculated data is displayed:
=  The coefficient of determination R?

= The gradient of the validation straight line

= the intersection of the curve with the y-axis at x=0 (offset)

The gradient of the curve should not exceed a value of + 0.1. The assumption then
applies that the efficiencies of the amplification of the gene of interest and the reference
gene are almost identical and the calculation of the AACt values produces valid data.
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FAM-GAFDH m
Lz u R2 0,21318
%= 1,1
= | \ Slope -0,05
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= 0,8 Offsek 0,91
[
0,8 7 T T T T T
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Log Std. Conc.

Table | Standard curve | Yalidation

Validation curves view for the AACt method

You can switch between the AACt calculation views using the Table, Standard curve and
Validation tabs. The validation curves and the values are automatically calculated by the
gPCRsoft auto software and updated if the settings change. For both, validation curves
as well as standard curves the respective data points errors bar are shown that indicate
the standard deviation between replicates. For each data point some short information
about the sample name and the mean Ct value of replicates is shown if the mouse
pointer is placed on it.

When more than one standard curve is displayed each curve has its individual color.
Accordingly each table has a color code in the header that reflects the assignment to the
respective standard curve.

FaM-c-myc ® |FAM-GAPDH = |
R= 0,99997 0,99919
o 2 Slope 3,65 3,71
a
20 CfFfset 16,35 17,29
| | | | ; PCR EFficiency (0,53 0,86
-3 -2,9 =2 -1,5 -1 -0,5 u]
Log Std. Conc.
Table | Standard curve | Walidation |
Validation curves view for the AACt method
Wel B | |Sam|:|le name ISampIe type |GOI IReference. o |CEGCT ICt R;I
Al sal Unknown c-myec 23,16
Az sal Unknown c-myc 25,08
a3 sal Unknown GAPDH 15,0
a4 sal Unknown GAPDH 20,1
a5 532 Unknown C-myC 29,36
LT3 532 Unknown c-myc 31,44 -
KN i

—|Table| Standard curve | validation |
Result table view for the AACt method

For the AACt-quantification the results table contains the following information:

Column Meaning
Well Position of sample*
Color of curve Each sample is automatically assigned an unchangeable color which is

used to display the corresponding fluorescence curve

Sample name Name of sample*
Sample type Type of sample*
Group Assignment of the sample to an experimental group*
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Display in the project
explorer

94

GOl

Gene of interest

Reference gene

Reference gene

Ct GOl Ct value of gene of interest

Ct Ref.gene Ct value of reference gene

Mean Ct GOI Mean Ct value of replicates of the gene of interest
Mean Ct Mean Ct value of replicates of the reference gene
Ref.gene

Std.Dev. Ct GOI

Standard deviation of the Ct values between replicates of the gene of
interest

Std.Dev. Ct Standard deviation of the Ct values between replicates of the reference

Ref.gene gene

%CV Ct GOI Variation coefficient of the Ct values between replicates of the gene of
interest

%CV Ct Variation coefficient of the Ct values between replicates of the reference

Ref.gene gene

dCt GOI Delta Ct value for replicates of the gene of interest

dCt Ref.gene Delta Ct value for replicates of the reference gene

RQ GOI Calculated relative amount for replicates of the gene of interest in the
original sample

RQ Ref.gene Calculated relative amount for replicates of the reference gene in the
original sample

Mean RQ Average calculated relative amount for replicates of the reference gene in

Ref.gene the original sample

Norm. Standardized relative (x-fold) expression level of the gene of interest in

Expression the sample in relation to the calibrator

A shortened representation of the validation curves calculated by the software is
displayed in the project explorer under DeltaDeltaCt. The image displays the graphical
plot of the dCt(V) values against the logarithm of the sample concentration:

% ddCt quantification

dct(v)

Log 8td, Conc.

Representation of the validation curves in the project explorer
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5.4.7 Deleting a AACt method evaluation

An evaluation that is no longer required can be removed.

1. Activate the evaluation by selecting its description in the evaluation list of the
method tab.

ddCt
2. Click on the = symbol in the toolbar.
Optionally, call up the DeltaDeltaCt » Delete ddCt quantification

3. menu command.

The evaluation is removed.
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5.5  Melting curve analysis

When performing a melting curve analysis the temperature in the reaction mixture is
increased successively until the PCR product is denatured. The dissociation of the
fragment in single strands will result in the release of a intercalating dye. The associated
reduction of the fluorescence intensity is measured and recorded by the device. By
forming the first derivative of the fluorescence curve you will get a peak that describes
the melting point and the approximate concentration of the PCR fragment. By means of
melting curve analysis you can differentiate whether the reaction has caused the
formation of a specific PCR product or whether unspecific by-products, such as
primerdimers, were produced.

5.5.1 C(Creating a new melting curve analysis

1. Go to the Analysis » Melt. curve project tab.
If the tab is not visible, click on the arrows 4 ¥ in the tab bar. This will scroll the
tabs.

ek
= et .
2. Click on the " =71 symbol in the toolbar.
Optionally, call up the Melting curve » Add melting curvemenu command.

3. Aninput window appears. Enter the description for the current evaluation.
On the MeltCurve tab the following information is activated:
= Parameter settings (1)

= Display of the fluorescence values as a function of the temperature and/or its first
derivative (2)

®  Display of the result table (3)

96



Evaluation
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@ Boo Standard 83,7 83,75 0,06
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Window for melting curve analysis

5.5.2 Parameter settings for melting curve analysis

[ Abs. Quant. V% Rel, Quant, V"?ﬁm DeltaDeltaCt /l/-: Melt. curve 4 b

Melting curve: Melt Temperatures1 -

Gene of Interest (GOI):

Group: Threshold:
Group 1 v 4,767 (]

Parameter settings for melting curve quantification

Set the following parameters for the meltings curve quantification:

Option

Description

Selection list

Selection of a selection created for the experiment

Gene of interest
(Gol)

Selection list of target gene/ dye combinations

Generally, an intercalating dye must be selected for the target gene for
the melting curve analysis.

According to the selection, the fluorescence and regression curves for the
concentration are displayed.

Group

If several experiments were carried out on the PCR plate, select the group
of the experiment to be analyzed. (— section"Defining groups” p. 49).
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Threshold Manually adjust threshold values
The threshold is now effective on the Derivative tab. Only curves whose
maximum dRn/dT is greater than the threshold are analyzed.
Note:
The threshold value can be calculated automatically or set manually in
the chart (see also "Setting the threshold value" below).

ﬂ Opens the selection window with display options

Setting the threshold For the correct evaluation a threshold value must be determined for the melting curves.

value You have several options for setting the threshold value:

= |n the general options (— section "Making basic settings" p. 66)
= Manually in the parameters for the respective evaluation (see table above)

®  Graphically in the representation of the fluorescence curves derivative:
In the chartDerivative, move the black threshold line up or down with the cursor.
Press and hold the left mouse button while doing so. At the same time, the Tm
values in the result table are updated.

= Automatic calculation:

The automatic calculation of the threshold value is activated by clicking on the I__'C—|
symbol.
Optionally, you can call up the Melting curve / Autom. Threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the corresponding Threshold iput field.

Fix Threshold The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that
the threshold value is retained if the basic settings for the analysis are changed (—>
section "Making basic settings" p. 66).

5.5.3 Displaying fluorescence curves/melting curves

In the display area, the measured fluorescence curves are shown in relation to the
temperature and are either standardized to the highest fluorescence value or both
standardized to a target value of 100, depending on the settings made in the Melt.
Curve Options window. The data is displayed as a linear or logarithmic representation
depending on the selected display option.
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Switching the display
options for the chart of
fluorescence curves

Evaluation

Melting curve Options x|

—Smoothing caling
" none (* lingar
f+ |3 | Points "~ |ogarithmic

rBaseline correction

From cycle:
|5 _|; [ Flip curve

rAuto threshold
* Standard deviation of base lines

= Defined standards

—Scaling
* Al curves start at 100%

= Maximum initial fluorescence = 100%:

Ok, - Auta Thr, I Ok - Fix Thr, | Cancel

Display options for melting curve analysis

The program shows brief information on the sample if the cursor is placed on one of the
curves.

The melting temperature Tm is determined by forming the first derivative of the melting
curves from the maxima of the forming peaks. To evaluate fluorescence data from
protein stability measurements, the melting curves can be reversed. The reversal of the
melting curves can be activated via the flip curve option.

ddRn/dT

Temp. {°C)

View of the melting curves derivative with threshold line

You can switch between the melting curves display and the derivatives via the tab in the
bottom left corner of the display range.

1. Click on the i button in the parameter bar.
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.
The Derivative tab cannot be displayed logarithmically.
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dRn

a0 65 70 75 an a5 20 i

Temp. (°C)

Fluorescence curves display (linear view)

The linear display does not show a threshold line.

5.5.4 Display of melting temperatures

100

After selecting the tab Tm the display changes to a presentation of the results as bar
chart. The respective sample name is given below each bar. The height of the bar is
determined by the measured melting temperature of replicates. For each bar some short
information about the position of the samples, the mean value and the calculated
standard deviation is shown if the mouse pointer is placed on it. The size of the standard
deviation is shown as error bar on top of each bar. Since for large numbers of samples
not all bars can be displayed in the screen the diagram can be moved horizontally with
pressed left mouse button and dragged to the desired position.
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5.5.5

Display in the project
explorer

5.5.6

Evaluation

Displaying the result table for the melting curves

The result table for melting curves contains all data and the associated measurement
values for the samples.

well M | Sample name |Sarnp|e bype |Gene |Tm |Mean Trn |Stazﬂ

B2 100 Standard 4,2 34,27 0,0

D2 . 1 Standard 4,3 54,3 0,14

Fz . 0,01 Standard 83,7 33,75 0,06

E3 . 100 Standard 4,3 54,27 0,05

3 . 10 Standard 54,3 34,3 o

D3 . 1 Standard 4,4 54,3 D,_H|;|

4] | D
Table

Result table for melting curve analysis

For melting curves the results table contains the following information:

Column
Well

Color of
curve

Sample
name

Sample type
Group
Gene

Tm

Mean Tm

Stabw.
Mittl. Tm

Meaning
Position of sample

Each sample is automatically assigned an unchangeable color which is used to
display the corresponding fluorescence curve

Name of sample

Type of sample

Assignment of the sample to an experimental group
Name of gene measured in the sample

Melting temperature of the sample

Mean melting temperature of replicates

Standardabweichung der durchschnittlichen Schmelztemperatur von
Replikaten

A shortened representation of the melting curves calculated by the software is displayed
in the project explorer under "Melt Curve". This representation shows the graphical plot
of the first derivative of the fluorescence values against the temperature.

Bl Melting curve

ddRn,/dT

e0 65 70 Y3 80 &85 90

Temp. (°C)

Representation of the melting curve derivatives in the project explorer

Deleting a melting curve analysis

A melting curve analysis that is no longer required can be removed.

1. Activate the evaluation by selecting its description in the evaluation list of the

method tab.
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5.6

5.6.1

102

2.

Genotyping

=
Click on the L= symbol in the toolbar.
Alternatively, call up the Melting curve » Delete melting curve menu command.

The evaluation is removed.

Genotyping serves to determine sequence differences between a sample and a standard.
The standard is defined as the reference sequence (genotype 1); the genetic condition
of the sample is to be determined in the experiment. Genotyping shows which alleles an
individual has inherited from its parents.

Creating a new evaluation for genotyping

1.

3.

Go to the Analysis / Genotyping project tab.
If the tab is not visible, click on the arrows ¥ * in the tab bar. This will scroll the

tabs.
Click on the T symbol in the toolbar.
Alternatively, call up the Genotyping / Add genotyping menu command.

Enter the description for the current evaluation in the input window.

The following information is activated on the Genotyping tab:

Parameter setting for defining the threshold and selecting the dye with which the
wild type and the mutant were measured (1)

Display of the fluorescence curves of wild type and mutantand/or display of the
results as a scatter plot or bar graph

Display of the result table with the results (3)
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Real time pcr project - qTOWERZ_Deme_Genotypingl _1.rtp EI@
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4t ddCt quantification +7  Melting curve %% Genotyping . A Endpoint q b
Genotyping: Genotypingl q
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Al Empty L

2 I Empty
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Genotyping window

Parameter settings for genotyping

Genotypel: Group: Threshold:

Indude passive reference Group 1 - 18,342 0
Genotype2: | ]

ROX -

Parameter settings for genotyping for the fluorescence curve display

Set the following parameters for the absolute quantification:

Option Description

Selection list Selection of an evaluation created for the experiment

Genotype 1 Selection list for the dye with which the genotype 1 was measured.
Genotype 2 Selection list for the dye with which the genotype 2 was measured.
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Setting the threshold
value

Fix Threshold

104

Include passive Only active if a dye has been defined as a passive reference on the
reference Settings / Scan project tab.
If this option is activated, the fluorescence of the dye that has been set as
a passive reference is used for standardization.

Group If several experiments were carried out on the PCR plate, select the group
of the experiment to be analyzed (— section "Defining groups' p. 49).

Threshold Manually adjust threshold value.
The threshold value must be between 1 and 100, depending on the
standardized representation of the fluorescence curves (dRn).
Note
The threshold value can be calculated automatically or set manually in the
chart (— see also "Setting the threshold value" below).

¥ Opens the selection window with display options (— section "Displaying
the fluorescence curves for absolute quantification"S. 73).

When changing to the scatter plot or end point bar graph, two fields are displayed for
the CutOff value for the Genotype 1 and the Genotype 2 instead of the Threshold field:

Genotypel: Group: CutOff Genotypel:
FAM - Indude passive reference Group 1 - 36,019
Genotype2: | ] CutOff Genotype2:

Parameter settings for the scatter plot and the bar graph of a genotyping

To determine Ct values for the evaluation a threshold value must be determined for
each experiment.

You have several options for setting the threshold value:
= |n the general options (— section "Making basic settings" p. 66)
= Manually in the parameters for the respective evaluation (see table above)

®  Graphically in the fluorescence curves representation:
In the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so. At the same time, the Ct values in the
result table are updated.

Note:

The logarithmic view is more suitable for placing the threshold manually in the
display area than the linear view because of the wider spread of the early
exponential area of the product accumulation curves.

® By having it calculated automatically:

To activate the automatic calculation of the threshold value, click on the ~ il symbol.
Alternatively, you can call up the Genotyping / Autom. threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the Threshold input field.

The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that



the threshold value is retai

Evaluation

ned if the basic settings for the analysis are changed (—

section "Making basic settings' p. 66).

5.6.3 Specifying genotyping options
Special evaluation options

N
= (Click on w in the tool

are available for genotyping.

bar to open the Genotyping Options window.

Alternatively, you can call up the Genotyping / Genotyping Options menu

command.

Genotyping cptions

=

Smoothing Scaling

~ none @ linear

@ (5 = | Points ) logari

Baseline correction

_ For all samples
From cyde: To cyde:

3 T

@ Sample specific
Crop first cycles:
5 =

Auto threshold
@) Standard deviation of base lines

") Defined standards

Filter

Intensity:

Cancel noise

Cydle of interest

1 Set to last cyde

thmic @ Set to cyde 40 -

Descriptions
If genotype1; wild type
= If genotype2: mutant

If heterozygote: heterozygote

otherwise: errar

Scatter Plot

") based on intensities dRn

@) based on Ct - values

Imedium

)

[ Ok - Auto Threshold l I Ok - Fix Threshold J I Cancel

GenoTyping Options window for

genotyping settings

Option Description

Cycle of Select the cycle for evaluation. This can preferably be the last cycle (end point)

interest but also any other cycle of the PCR run. The respective cycle can be selected
from a list.

Name Input fields for own names for the genotypel, genotype 2, heterozygote
categories or otherwise

Scatter Generation of the scatter plot based on the fluorescence intensities of the

Plot analyzed cycle and/or the Ct values

5.6.4 Displaying the fluorescence curves, scatter plot and bar graph

The respective combination

of genotype 1 dye or genotype 2 dye displayed is shown on

the tabs in the bottom left corner of the area. The entry for the respective active

combination on the tabis h

ighlighted in white. The fluorescence data is displayed as a

linear or logarithmic representation depending on the selected display option. For both
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view types a brief information is shown as soon as the mouse pointer is positioned on
one of the curves.

1. Click on the ﬂ button in the parameter bar.
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.

100

734

dRn

30+

25

Cycle

Genotype 1-FAM | Genotype2-ROX | Scatter plot | End point

Linear representation of the fluorescence curve for genotyping

100

10

dRn

0,1 T T T T

Cycle

Genotype 1-FAM | Genotype2-ROX | Scatter plot | End point

+

Logarithmic representation of the fluorescence curve with horizontal threshold line

To determine Ct values for the analysis a threshold value must be determined for the
fluorescence curves. This can be automated but is also possible manually in the display
area (— section "Parameter settings for genotyping" p. 103).

In addition to the fluorescence curves representation, the results can also be displayed
as a scatter plot or bar graph. This can be selected via the respective tabs below the

display area.
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wild type error
40 I OEm
w375
2
B 354
£
GIIJ 32,5
o
(5} 30 @)- -
B
27,5 " .
]
25 —heterozygote mutant
T T T T T T T T T T T
30 31 32 33 34 35 35 3T 38 32 40 41 42
Ct-Genotypel

Genotype1-FAM | Genotype2-ROX | Scatter plot | End point

Scatter plot for genotyping

The scatter plot is divided into four quadrants for genotypel, genotype 2, heterozygote
and error. The samples are assigned to one of the quadrants based on the measured
relative fluorescence or the Ct values of the two dyes. The respective cutoff value for the
sample assignment is represented by two black lines in the scatter plot view. To change
the position of the lines and thus change the cutoff value, select the lines and keep the
left mouse button pressed. Alternatively, the respective cutoff value for genotype 1 and
genotype 2 can also be entered in the respective fields in the selection area (—
"Parameter settings for genotyping" p. 103).

100 —

75

dRn

30

25

L R RN RN RN RN R RN RN RR R AR RR AR RN AR RR R AR RN RN AR AR
A B iz D E F G H

Genotype 1-FAM | Genotype2-ROX | Scatter plot |End point

Bar chart for genotyping

The bar graph shows the measured relative fluorescences as bars. The x-axis is scaled
from A to H based on the rows of the block, i.e. the first twelve samples correspond to
positions Al to A12 in the block, the next twelve samples correspond to positions B1 to
B12 etc. The cutoff value is set by moving the red or blue horizontal line up or down
with the left mouse button pressed. Alternatively, the respective cutoff value for mutant
and wild type can also be entered in the respective fields in the selection area of this
view (— "Parameter settings for genotyping" p. 103).

The cutoff values are thresholds after which the question whether a sample shows a
reaction is answered with "Yes" (see Reaction genotype 1 and Reaction genotype 2
table columns).
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5.6.5 Display of the values for the genotyping evaluation

The result table for the genotyping combines all data and corresponding measurements
for the samples. The columns shown in the result table differ depending on the tab
selected in the display area. The table for the fluorescence curves provides a summary
which includes the measuring data of both dyes. If the fluorescence intensity at the end
point is evaluated, the result table for the scatter plot is the same as the one for the bar
graph. The data summarized in the result table for the fluorescence curves, however,
partly differ from the data in the scatter plot or bar graph evaluation.

Mgl 0 I Sample name ISampIe by pe IGenDtyp IReactiDn v IReactiDn v IGent - |
a4 H1 Iniknioan heterozygote  wes WES hiet

B4 . H1 Iniknioan heterozygote  wes WES hete
Z4 . Hz Iniknioan heterozygote  wes WES hete
04 . Hz Iniknioan heterozygote  wes WES hete

E4 . H3 Iniknioan heterozygote  wes WES hete

F4 . H3 IInknovn heterozyvgote  wes ves hete

4 . M1 Iniknioan mukank no ves muks - |
4 I I 3

Results table for genotyping

For the genotyping the results table contains the following information:

Column Meaning
Well Position of sample*
Color of curve Each sample is automatically assigned an unchangeable color which is

used to display the corresponding fluorescence curve

Sample name Name of sample*

Sample type Type of sample*

Group Assignment of the sample to an experimental group™*

Ct Genotype 1 Ct value of genotype 1

Mean Ct Mean Ct value of replicates of the genotype 1

Genotype 1

Std.Dev. Ct Standard deviation of the Ct values between replicates of the genotype 1

Genotype 1

Ct Genotype 2 Ct value of genotype 2

Mean Ct Mean Ct value of replicates of the genotype 2

Genotype 2

Std.Dev. Ct Standard deviation of the Ct values between replicates of the genotype 2

Genotype 2

Genotype Assign the sample according to genotype 1, genotype 2, heterozygote or
error

Reaction Yes or no, depending on the end point fluorescence or Ct value

Genotype 1

Reaction Yes or no, depending on the end point fluorescence or Ct value

Genotype 2
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Display in the project
explorer

Genotype
Replicates

Assign replicates according to genotype 1, genotype 2, heterozygote or
error ("?" symbol)

dRn Genotype 1

Standardized fluorescence intensity of the genotype lreaction

Mean dRn Standardized fluorescence intensity between replicates of the genotype
Genotype 1 1 reaction

Std.Dev. dRn Standard deviation of the standardized fluorescence intensity between
Genotype 1 replicates of the genotype lreaction

dRn Genotype 2 Standardized fluorescence intensity of the genotype 2reaction

Mean dRn Standardized fluorescence intensity between replicates of the genotype
Genotype 2 2reaction

Std.Dev. dRn Standard deviation of the standardized fluorescence intensity between
Genotype 2 replicates of the genotype 2reaction

Individual columns can be shown or hidden by selection or deselection. The layout of the
columns can also be freely modified. By dragging a column heading with the left mouse
button depressed columns can be swapped. The display of the results in the table can
thus be adjusted as desired.

Optional the scatter plot or the end-point analysis calculated by the software can be
displayed in short form in the project explorer under the point Genotyping. The scatter
plot is divided into for quadrants for mutant, heterozygous, wild-type and error. The
samples are assigned to a quadrant by the relative fluorescence or the Ct values
determined for both fluorescent dyes. For the end-point analysis the measured relative
fluorescence is plotted as bar chart. Die height of the bars defines the samples as
genotype 1, genotype 2, heterozygous or error.

=~ Genotyping =

N W4 DOm
£ 375
g =7
4 3254
3:|_

5 o] o :

25 ] ||

1T 1T 11T 17T 1T 1T 1T 11

MNDRTFMFIEIRTAIOHL

Ct-Genotypel

Representation of results for genotyping as scatter plot.

E Genotyping =

100

7=

dRn

=]
25
0

Representation of results for genotyping as bar chart.
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5.6.6 Deleting a genotyping

5.7

An evaluation that is no longer required can be removed.
1. Activate the evaluation by selecting its name in the evaluation list of the method tab.
2. Clickon 1—; in the toolbar.

Alternatively, call up the Genotyping » Delete Genotyping menu command.

The evaluation is removed.

POS/NEG analysis at the end point

Positive / negative analysis at the end point of a gPCR is used to decide, whether or not
a target gene is present in the reaction mix. Such an analysis can be configured as
singleplex or multiplex experiment using fluorescence data at the end point of a PCR
run, i.e. after amplification is finished. The position of the end point — with respect to
the cycle number - as well as the cycles to be included can be set by you. Using the NTC
samples a cutoff value is calculated which discerns positive and negative for each
individual sample. The software also accounts for internal positive controls (IPC) which
can be added to each sample in order to avoid false negative results thus increasing the
confidence level of the experiment.

5.7.1 Starting end point analysis

110

1. Go to the Analysis / Endpoint project tab. If it is not visible, click on the arrows in
the tab bar. This will scroll the tabs.

e
2. C(lick the symbol L/ in the toolbar. Alternatively you can select the menu ENDPOINT
/ ADD ENDPOINT.
3. Aninput window appears. Enter the description of the current evaluation.

Note:
An end point analysis can only be opened if the plate layout contains at least one NTC-
sample (— section "Editing the sample table" p. 38).

On the Endpoint tab the following information is activated:
® Edit fields for parameter settings

= Amplification curves of the selected GOI and the internal positive control IPCin a
combined diagram.

®=  Amplification curves of the selected GOI and the internal positive control IPCin
separate diagrams which allow for setting the cutoff.

= Display of results in a PCR plate scheme
®  Display of results in a bar chart

®  Results table with measurement data and classification of the unknown samples as
POS, NEG, 7?7, CHECK
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Ei Real time pcr project - Behelfs-Testprojekt EndpunkE.rtp - Dlll
t;;i Settings W Manitaring 4 Analysis D Docurnentation 4 I
B4 Genotyping /I/E Endpoint ] 4 b
Endporc: g =
GOI: Group:
IFF\M-GOI 'I IGroup 1 e
IPC: u
IROX-IPC 'I
50000

40000

30000 —

Intensity [I]

20000 —

10000 o

Cycles

All| Go1| 1PC| Grid | Bar Chart |
4
T+

e

el m I Sample name ISampIe type Group FluoGOI IMean Fluoﬂ
A4 iHl Unknown Group 1 43304, 45 41071,62

B4 H1 Unknown Group 1 38248,79 41071,62

4 | GF Unknown Group 1 31714,67 34864, 64

D4 W Unknown Group 1 38014,61 34864, 64

E4 H3 Unknown Group 1 265687,02 30656,55

F4 H3 Unknown Group 1 34806,09 30656,55

a4 MTC MTC Group 1 -199,7 -24,41 -
kI _'l_I

Window for end point anaylis

5.7.2 Parameters settings for endpoint analysis

endpore: [0 a =

GO Group: CUkOFF;
[Far-Gor - Groupl 7| [2484,081 |
IPC: | ]

IROX-IPC "I

Parametersettings for endpoint analysis

1. Set the following parameters for endpoint analysis:

Option Meaning
Shortlist Selection of an evaluation created for this experiment
Gene of Interest (GOI) Selection list of the gene/dye combination of interest

Internal Positive Selection of the gene/dye combination which is used for IPC
Control (IPC)

Group If several experiments were carried out on the plate, select of
experiments to be analyzed.

Cutoff Cutoff defines the fluorescence value above which the sample is
considered to be positive

2. Define the cycle numbers which shall be considered as endpoint.
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Setting Cutoff values

112

By default the mean fluorescence of the last two cycles is taken for calculations. You
can define more than 2 cycles at the end or an interval of cycles of the gPCR run as
source of endpoint fluorescence data.

The selected cycles are highlighted in the chart by a yellowish bar.

nd Poink nd Paint

% last |2 _|::' cycles O last |2 _|: cycles
£ from cycle I39 _I; ko oyicle |41 _I; (& from cycle I36 = tocyde Ihg _|::'

Last 2 cycles are marked Cycle 36 to 39 are marced

Area selection for endpoint analysis

Cutoff-values for GOl and IPC can be set manually or calculated automatically. You can

select different methods for automatic calculation in the options dialogue ‘LET for
endpoint analysis.

Manual methods

= Enter a number for Cutoff directly in the edit field Cutoff or in the options dialogue
®  Shift the Cutoff line using the mouse in the tabs GOI and IPC

Automated methods

®  With negative control or NTC:
The Cutoff-value is calculated from the mean fluorescence of the NTC samples plus
the fraction (given in percent) from the difference between maximal sample
fluorescence and mean fluorescence of the NTC samples. Fluorescence data is taken
from the specified end point cycles.

® With internal positive control IPCand NTC:
Cutoff values for NTC and IPC are calculated separately. The standard deviation of
the fluorescence of all NTC samples (or IPC- samples, i.e. samples which do not
contain an internal positive control) is multiplied with a factor T which is read from a
table and is dependent from the desired confidence interval and the number of
samples.

®  You can start the automatic calculation of Cutoffs according to the settings in the
options by clicking EA . Alternatively you can choose the command ENDPOINT / AUTO
THRESHOLD CUTOFF from the menu.

Note:
If the plate layout does not contain samples which are labeled as IPC-, the option ,with
internal positive control and NTC" will not be available. On the tab Settings / Samples
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selected wells can be labeled as IPC- by right clicking the highlighted wells and select
Assign IPC- from the context menu (— section "Editing the sample table" p. 38).

5.7.3 Displaying results in end point analysis

The results of the analysis (POS, NEG, ???, CHECK) are evaluated according to the
following rules:

Without IPC Fluoescence of a single GOl sample Result
> Cutoff (GOI) POS (positive)
< Cutoff (GOI) NEG (negative)

With IPC Fluoescence of a single GOI Fluoescence of a single IPC Result
sample sample
> Cutoff (GOI) > Cutoff (IPC) POS (positive)
< Cutoff (GOI) > Cutoff (IPC) NEG (negative)
> Cutoff (GOI) < Cutoff (IPC) 77

(problematic)

< Cutoff (GOI) < Cutoff (IPC) 77

(problematic)

Bewertung bei Replikaten ~ Samples which are present in replicates (having the same sample name) are considered
to be POS or NEG if all replicates of that sample are POS or NEG. If this is not the case
CHECK will be displayed. It is possible to manually deselect samples in the project
explorer which are recognized as outliers.

Fluoescence of replicates Result of sample

all POS POS (positive)

all NEG NEG (negative)

otherwise CHECK (eliminate outliers or repeat sample)

After creation of a new analysis or after having changed options or cutoff values the
results are re-calculated and charts and table will be refreshed.

Results table

wiel m| [sample name |Sample type Group FiuoGOL Mean FluoGOL  [Std.Dev. Fluogol  [FluslPc Mean FluolPC StdDev. FluolPC [Status Go1  [status1PC [Resuksa..  [Result replicates
a4 HI Unknown Group 1 43894,45 41071,62 992,08 17019,34 15944,53 151944 POS POS POS POS
B4 Hi Unknown Group 1 38248,79 41071,62 992,08 14870,52 15944,53 1519,44 POS POS POS POS
s | O3 Unknonn Group 1 31714,67 34864, 64 4454,74 12812,05 13326,08 729,78 FOS FOS FOS FOS
D4 | 3 Unknonn Group 1 38014,61 34864, 64 4454,74 13544,11 13326,08 729,78 FOS oS POS FOS
E4 H3 Unknown Group 1 26567,02 30696,55 5811,76 15718,75 14756,52 1357,41 FOS FOS FOS FOS
F4 H3 Unknown Group 1 34806,09 30696, 55 811,76 13799,08 14758,92 1357,41 POS POS POS POS
Gt NTC NTC Group 1 -199,7 24,41 247,89 15239,33 18507,95 1794,1 EG POS HEG EG
He NTC NTC Group 1 150,88 24,41 247,69 17776,58 18507,95 1794,1 EG oS HEG EG
a7 WT1 Unknown; TFC- Group 1 55748,83 50011,56 6113,73 236,58 213,27 58 FOS NEG

B7 WT1 Unknown; TPC- Group 1 44274,23 50011,56 8113,73 -187,95 213,27 5,8 POS HEG

7 WTZ Unknown; IPC- Group 1 36536,85 39388, 36 4032,65 246,75 -149,28 137,84 POS HEG

o7 | e Unknown TPC- Group 1 42239,87 39388,36 4032,65 51,81 -149,28 137,84 FOS HEG

F7 M2 Unknonn Group 1 346,38 -411,01 a1,4 15201,38 15105,65 135,39 EG oS HEG EG
a7 | [ Unknown Group 1 475,65 411,01 a1,4 15009,51 15100565 135,39 NEG POS HEG NEG
H7 M3 Unknown Group 1 85,52 85,52 o 17320,61 17320,61 0 EG POS HEG EG

Result table of endpoint analysis

For the end point the results table contains the following information:
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Column Meaning
Well Position of sample
Color of curve Each sample is automatically assigned an unchangeable color which is

used to display the corresponding fluorescence curve

Sample name Name of sample
Sample type Type of sample*
FluoGOI Fluorescence of the GOl samples at the endpoint

Mean FluoGOl  Mean fluorescence of the GOl replicates at the endpoint

Std.Dev. Standard deviation of the GOl replicates at the endpoint
FluoGOI
FluolPC Fluorescence of the IPC samples at the endpoint

Mean FluolPC  Mean fluorescence of the IPC replicates at the endpoint

Std.Dev.FluolPC Standard deviation of the IPC replicates at the endpoint

Status GOI POS if FLuoGOI > CuTOFF, else NEG (for each sample well)
Status IPC POS if FLUOIPC > CuTOFF, else NEG (for each sample well)
Result sample Rating POS/NEG/??? for each well

Result replicates  Rating POS/NEG/CHECK of the replicates

The results table displays all calculated numerical data and the evaluation of single
samples and replicates. You can design the results table according to your requirements
by setting type, sequence and width of the columns to be displayed. You can also adjust
the sort sequence of data in the column (alphabetical, numerical, by column, by row).
The table configured this way can be exported as Excel or CSV file by right clicking the
table.

Save table as Excel-File (*, x1s)
Save table as Excel-File (*,x1s) and run Excel

Save table as CSY-File (*.csv)

Context menu for data export
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PCR plate scheme (Grid)

Bar Chart

Evaluation

i Settings ]/\__ Maonitaring /l/ﬁf Analysis ]/D Documentation ] 4 b
<7 Melting curve ]/3". Genotyping J/E Endpoint l 4 b
endpont: [T - I
1 ‘2 ‘3 4 5 ‘6 ‘? ‘8 ‘9 ‘10 ‘11 ‘12
A Unkn

B Hz
FluoGOT: 31714,67
FluoIPC: 12812,05

'n

&l GoI| IPC | Grid | Bar Chart |

+ +
Results of endpoint analysis on the plate scheme

For gTOWER? 84, the columns from 1 to 24 and rows from A to P are available using
the scroll bars.

The PCR plate scheme offers a quick overview of the results obtained in each single well.
If the mouse pointer is moved across a well a hint box is displayed showing the sample
name and the end point fluorescence of GOl and IPC for that well. You can change the
colors which code for POS, NEG and 7?7 in EXTRAS / OPTIONS / COLORS.

s;;i Settings ]/\__ Monitoring J/ﬁf Analysis I/D Docurnentation ] 4 B

=7 Melting curve ]/a’. Genobyping J/E Endpoint] 4 B

EZET - I

50000 o

40000 —

30000 o

Rn

20000 o

10000+

L0 R R RN AR AR IR AR AR R AR RN AR AR R RN R AR R RAR AR ARRAR AR R LA RN RAR
& B C ) E F 5 H

all| GoI| IPC| Grid |Bar Chart
L

Bar graph of endpoint analysis results

The bar chart displays the end point fluorescence of the GOI together with the IPC as
well as the corresponding cutoff values as horizontal lines. Red lines denote the GOl and
blue ones the IPC. If the mouse pointer is moved across a bar a hint box is displayed
showing the sample name and the end point fluorescence of GOl and IPC for the
corresponding well.
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Note:
Cutoff lines can not be changed in the bar chart. To do so, please switch to the tabs GOI
or IPC.
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Multigene-/Multiplate-Analysis

6  Multigene-/Multiplate-Analysis

The Multigene-/Multiplate-Analysis is used to analyze real-time PCR data of multiple
target genes in parallel or to analyze data from multiple project files if, for example,
several PCR plates have been used for an experiment. The Multigene-/Multiplate-
Analysis is executed as dialog in a separate window independend of the surface of the
gPCRsoft auto software. For the Multigene-/Multiplate-Analysis project files generated
by the qPCRsoft auto software are used. The project files must include a AACt-analysis
for Multigene-/Multiplate-Analysis.

6.1  Start Multigene-/Multiplate-Analysis

To start the Multigene-/Multiplate-Analysis click on the button @ in the toolbar. A
new window for Multigene-/Multiplate-Analysis appears.

6.2 The window for Multigene-/Multiplate-Analysis

After starting the dialog the window for Multigene-/Multiplate-Analysis opens. It is
devided into the following sections:

Menu bar The menu bar contains the menu commands for, e.g., opening, editing, saving

(1) and printing of Multigene-/Multiplate-Analysis files and a help function.
Toolbar In the toolbar commands for editing Multigene-/Multiplate-Analysis files are
(2) arranged.

Project list  In the project list projects that are used for Multigene-/Multiplate-Analysis are
(3) listed and administrated.

Samples In the layout the measurement data of samples can be selected or unselected.
(4) Only data of selected samples becomes included to the analysis and is used for

the results calculation. Furthermore in the layout the position of interplate
standards (IPS) can be defined.

Data In the data display amplification curves of imported project files are shown or
display the results of the Multigene-/Multiplate-Analysis are plotted as bar chart.

(5)

Results In the results table the imported measurement data of the activated project file

table (6) or the results of the Multigene-/Multiplate-Analysis are shown.
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Windows Multi gene for Multigene-/Multiplate analysis

6.3 Overview of menu commands

In the Multigene-/Multiplate-Analysis window the following menu commands are
available:

Menu  Function Description

File New Multigene-/Multiplate-  Opens a new Multigene-/Multiplate-Analysis

Analysis

Open Multigene-/Multi- Opens a Multigene-/Multiplate-Analysis.

plate-Analysis

Save Multigene-/Multi- Saves a Multigene-/Multiplate-Analysis in the

plate-Analysis qPCRsoft auto standard folder

Save Multigene-/Multi- Saves a Multigene-/Multiplate-Analysis in any

plate-Analysis as user-selected folder

Print Multigene-/Multi- Prints the results of a Multigene-/Multiplate-

plate-Analysis Analysis

Close Closes the window for Multigene-/Multiplate-
Analysis
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6.4

6.5

6.6

6.6.1

6.6.2

Multigene-/Multiplate-Analysis

Overview of the tools in the toolbar

Button Command  Function
B New Opens a new Multigene-/Multiplate-Analysis
= _  Open Opens a Multigene-/Multiplate-Analysis
H Save Saves a Multigene-/Multiplate-Analysis
i Print Prints a Multigene-/Multiplate-Analysis
q‘:éi Options Allows the input of efficiencies of PCR reactions for single genes of
interest

Help function

You can get help on the operation of the Multigene-/Multiplate-Analysis via the menu
command Help » Content.

While working with the Multigene-/Multiplate-Analysis, you can activate the help
function by pressing function key [F1].

The program pops up brief information (tool tips) on buttons of toolbar while you move
the mouse pointer across the button.

Managing Multigene-/Multiplate-Analysis files

After clicking on m the Multigene-/Multiplate-Analysis dialog starts in a separate
window and contains no data.

Start new Multigene-/Multiplate-Analysis

To start a new Multigene-/Multiplate-Analysis press on — orcall up the File » New
menu command. An already loaded Multigene-/Multiplate-Analysis will be closed. If the
analysis has been modified and the changes are not yet saved, a prompt opens.

Note:
Only one Multigene-/Multiplate-Analysis can be opened.

Open saved Multigene-/Multiplate-Analysis

.
1. Clickon or call up the File » Open Multigene-/Multiplate-Analysis menu
command.

2. Inthe standard window, select the desired file to open and confirm the selection
with [OK].
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Note:

If the file type is linked to the qPCRsoft auto application in Extras » Options the dialog
for Multigene-/Multiplate-Analysis starts automatically by a double click on the selected
file.

The Multigene-/Multiplate-Analysis including the project list, sample layout,
measurement data and analysis opens.

6.6.3 Save Multigene-/Multiplate-Analysis

The Multigene-/Multiplate-Analysis including all loaded project files and analysis is
stored.

1. Select the menu command File » Save Multigene-/Multiplate-Analysis.

2. To save files enter the name of the template in the standard window and save the
template with [OK].

Changes in a Multigene-/Multiplate-Analysis can be saved with the File » Save
Multigene-/Multiplate-Analysis menu command. Optionally, you can click on the

symbol H in the toolbar.

6.6.4 Close Multigene-/Multiplate-Analysis

The File » Close Multigene-/Multiplate-Analysis menu command closes the
Multigene-/Multiplate-Analysis window. If any unsaved changes have been made in
analysis, a confirmation prompt appears.

6.6.5 Print Multigene-/Multiplate-Analysis

The data and results of a Multigene-/Multiplate-Analysis can be printed using the Print
function. For this purpose, an analysis must be applied and in the data display the tab
Analysis must be selected (— section "The window for Multigene-/Multiplate-Analysis"
p. 117). By using the command File » Print Multigene-/Multiplate-Analysis or the icon

= in the toolbar the print function is started.

6.7 Load Project Files

If a new Multigene-/Multiplate-Analysis is started, at first a blank window is displayed.
To perform an analysis project files have to be loaded. In the project files a AACt-analysis
must be applied to evaluate them by Multigene-/Multiplate-Analysis.

1. Toload a project file click on the button [Add project].

2. Inthe standard window select one or more stored project files and confirm your
selection with [OK]. Loaded projects are listed in the project list.
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Add project E Remove project

¥l multidata3 3.rh
& multidatal_1.rip
¥ multidata2_2.rtp

Projekt list for Multigene-/Multiplate-Analysis
1. Toremove a project file mark the File in the project list.

2. C(lick on button [Remove project].

6.8 Activate/Deactivate project files for Multigene-/Multiplate-Analysis

In the project list, a check box is show next to each loaded project. By the check box
projects can be activated or deactivated. Only data from activated projects is used for
analysis.

Add project E Remove project

& multidata3 3.rip
mulﬁdaml Lrip

¥ multidataz_2.rtp

Projekt list for Multigene-/Multiplate-Analysis with activated/deactivated samples

The data of deactivated project files remain loaded in the background and after re-
activation are used for analysis again.

6.9 Activate/Deactivate samples for Multigene-/Multiplate-Analysis

In the data display for Multigene-/Multiplate-Analysis activate the tab Projects (—
section "The window for Multigene-/Multiplate-Analysis" p. 117). On the tab Activate
samples of the data display samples of single wells can be activated or deactivated for
analysis. By deactivation of samples outliers are eliminated and not included in the
calculation of mean values.

Note:
The sample selection has only influence on the analysis of data, no measurement data is
deleted.

W1 23456 7 8 35 0uon

COGrerC000606
cleiel L L ICICIelcione)
0000000060606
©000088686600600606
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@:-00000¢
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I 60 mm 9 0 m ®
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Sample layout for Multigene-/Maultiplate-Analysis

The sample layout is taken from the loaded project files. The color code for each sample
type can be modified in menu EXTRAS / OPTIONS » COLORS.

Sample type Symbol  Definition
Empty E Describes an empty position on the PCR plate
Unknown u Sample of unknown concentration or dilution

(measuring sample)

Stnadard S Sample of known concentration or dilution

Calibrator K Sample whose gene of interest expression level is set as
1

No Template Control N Complete reaction preparation but without matrix

(NTC) strand

Positive Control + Positive control preparation for which a reaction

product is expected

Negative control - Negative control preparation for which no reaction
product is expected

Active wells (i.e. displayed wells) are marked with their sample type symbol. For
deactivated wells the position is grey and the fluorescence data is hidden. Empty wells
are marked "E".

®  (lick with the mouse to switch. The activation changes with each click on a well.

®  You can change adjacent wells by holding the mouse button and moving the cursor
over the wells. To select non-adjacent positions press the Ctrl key on the keyboard
plus the left mouse button at each position.

®  Complete rows and columns can be inverted by clicking on the letter or number of
the row [A-H] or column [1-12].

®  The activation status of the complete plate can be inverted by clicking on '®on the
top left between A and 1.

®  To activate all wells click on the symbol @ below the chart.

®  To activate only samples of a specific type click on the corresponding symbol below
the chart. To activate multiple sample types at the same time keep the Ctrl key
pressed when clicking on the sample types.

6.10 Define Interplate-Standards for Multigene-/Multiplate-Analysis
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Activate the tab Projects in the data display for Multigene-/Multiplate-Analysis (—
section "The window for Multigene-/Multiplate-Analysis" p. 117). For the Multigene-
/Multiplate-Analysis Interplate-Standards (IPS) are used on each PCR plate and the
deviations among themselves are determined and calculated.

1. To define Interplate-Standards activate the tab Assign IPS in the sample display.
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[f Delete 1P [7]1PS on identical positions

@113455?591{}1111
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Activate samples |.ﬁ.ssign IPS |

T @@ m m &9 1 m

Defining IPS
2. Select the position of Interplate-Standards:

®  Press the left mouse button and drag the area that contains the IPS samples:
Selected samples are displayed in grey against a green background. For not
selected samples only the sample type icon is displayed. Empty wells are marked
with “E”. To select samples see also section "Activate/Deactivate samples for
Multigene-/Multiplate-Analysis" p. 121.

®  [fthe IPS position is the same on all plates the current selection is transferred to
all loaded projects by activating the checkbox [IPS on identical positions].

®  (lick on the button [Delete IPS] to delete the IPS in all loaded projects.

6.11 Set threshold and PCR-efficiencies for Multigene-/Multiplate-Analysis

After loading project files the measurement data for the active project is shown in the
display area. The active project is marked blue in the project list on the left. By clicking
on the name in the project list another project can be activated and thus switched
between different projects.
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[55] Multi gene - MGA_multiplex_3plates.mga Elﬂu
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NP -\ & &
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B Zous |
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[¥] multidatal_lrtp Dye: Group: Threshold:

100

75

c
% 304
254
1]
T T T T T T T T T
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®1zzass7n9muu Chart
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3
c 8888:::855%8 wWell | Sample namavlsample type |Group Gene Ct Mean Ct Std.Dev. Ct -
" 900000000000 D3 E6-3 Standard Gruppe 1 Tubulin 10,02 9,67 0,36 ]
c @@...@...@@@ D4 .E6-3 Standard Gruppe 1 Tubulin 9,67 9,67 0,36
D5 . E6-3 Standard Gruppe 1 Tubulin 9,31 9,67 0,36
FO000000000606
@

D7 . E5-3 Standard Gruppe 1 Tubulin 13,41 13,59 0,27
®®...®®®®®®® D8 .E5-3 Standard Gruppe 1 Tubulin 13,9 13,59 0,27
i ciclelciclelclolclolele) T Standerd

Gruppe 1 Tubulin 13,46 13,59 0,27

@:=00000" = [ 2] Standard Gruppe 1 Tubuiin 17,17 17,33 0,21 il
| [ Activate samples [ Assign 1PS | [Tabie
=

For the active project the fluorescence curves and results are shown under the tab ,Projects”

From the loaded projects all measurement results and settings are taken. In the dialog
for Multigene-/Multiplate-Analysis most settings cannot be modified, this is only
possible in the individual projects in the gPCRsoft auto software.

Edit threshold On the tab Projects the threshold for each dye can be adapted.
1. Activate the relevant project in the project list.

2. Select a dye from the list on the tab Projects.

Dye:
FAM -

HEX
TexasRed
Cy5

Select list for dyes

3. Ifin the project file different groups are defined select the right group from the list.

Group:
Gruppe 1 -

Select list for groups
4. To modify the threshold value two different options are available:

®  |n the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so.

m  Enter a value in the field Threshold.
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With the modification of the threshold the values in the result table displayed below are
updated.

Edit PCR efficiency Basically, PCR efficiencies are taken from the loaded project files but it is possible to set

adjust the value for the considered genes.

1. Activate the tab Analysis in the data display and click the button aﬁ in the toolbar.
2. Adjust for each gene the PCR efficiency in the window Options.

Options [ﬁ
Genes Efficiency
FAM-Tubulin .89
HEX-Actin 1
TexasRed-IL1b 1
Cy5-GAPDH 1

[ Ok ] l Cancel ]

Window Options for editing of PCR efficiency

3. Enter a new value and confirm with [OK].
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6.12 Evaluation of the Multigene-/Multiplate-Analysis

The results of the Multigene-/Multiplate-Analysis are summarized under the tab
Analysis of the data display.

Projekte | Auswertung | 4 b

Genes of inberest: Skalierung Y:
TexaRed LI Tubuln 158 ©)

Referenzgene:
HEX-Actin;CyS-GAPDH =58 [¥] interplatekalibrierung

D Lib |:| Tubulin
2%
75

2 - @

215 4

20 -

| 0000000000 0.0 000

NE

gh-Lib ]

2415 -
2-20 -
LI LI 1 1 LI LI LI T T T 1 LI 1T T T T LI LU T T 1T 7T LI T 1T T T L LI
S L8 Ef8ESES EBCREEES CREB L ERERECRCRCRERESEREREREBEDRES
“3223=23=23=23232Z=2223232322323223=222232323=23223=23232Z2=3+<
' =1 ' =1 " 3 s =1 " = . 3 . =3 . 3 = ' =1 " =1 . =} . =] " 3 . 3 . 3 . =3 ' =3 ' =1 " =1 . 3 . =1 . =3 . 3 .
Rl bl el 1 Rl Rl bl ol £ il Ll Bl L sl il ol el el o o
5 £ & & £ & &€ £ & 8 @§ O 0 & @oefewleoefwRefwieofwulodw
a w [ 1] w o w o w L+
Normierte Expression | Relative Quantitat
& &
T T
Projektname ¥ [Gen |probenname  |anz. Regl.  [Mitd. ct Mitt, Kalib... [stabw. Mit... [RQ [stabw.rRQ  [norm. Exp... [stabw.No... | -
multidata3_3.rtpIL 1b-TexasRed &h 3 37 36,8 0,18 5,02E-5 6,46 6,00E-6 7,76E-7 [
multidata3_3.rty [GAPDH-Cy5)  E2-3 3 22,9 23,97 0,51 0,04 0,01
multidata3_3.rty [GAPDH-Cy5] E5-3 3 12,42 13,43 0,44 80,29 18,49 @
multidata3_3.rtp [AcinHEX]  6h 3 22,69 21,72 0,05 8,35 0,32
multidata3_3.rtp [ActinHEX]  E2-3 3 25,88 24,91 0,3 0,91 0,19
multidata3_3.rty [ActinHEX]  ES-3 3 15,12 14,15 0,51 1583,23 560,54 -
A
= r
—[‘rabelehPs
Results of the Multigene-/Multiplate-Analysis
The data display is divided into the following sections:
= Parameter settings (1)
®  Graphical data display (2)
m  Results table with measured values (3)
Parameter settings for Genes of interest: Scaling ¥
. . TexesRed1L 1AM Tubuin
Multigene-/Multiplate- ! =~ @ Log2 _
Analysis Reference genes:
HEX-Actin;Cy5-GAPDH j [z] Inter plate calibration

Parameter settings for Multigene-/Multiplate-Analysis
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*Correction calculation

Results display for
Multigene-/Multiplate-
Analysis

Multigene-/Multiplate-Analysis

Option Description
Genes of Selection list of target gene/dye-combinations. Multiple target genes can be
Interest selected.

GOl K3

(Go1) The symbol Igl is used to remove all target genes from the evaluation
Reference Selection list of reference gene/dye-combinations. Multiple reference genes
genes can be selected.

The symbol lﬂl is used to remove all reference genes from the evaluation.

Scaling Y Selection of the scaling of the Y-axis.
Interplate With activated interplate calibration from the selected IPS samples of all
calibration plates a correction factor is determined* and from the mean Ct values of

replicates the corrected mean Ct values are calculated (see results table). The
corrected mean Ct values are then used to calculate the relative quantity and
the normalized expression. Is the interplate calibration deactivated, the
corrected mean ct values are equal to the mean ct values.

CtEZTT — Ct{[);.)eas _ agpc + % Zg=1 Ct;,PC

with

Ctiy"" — corrected Ct — value for replicate i on plate p
Ct]y® - measured Ct — value for replicate i on plate p

EQPC — mean value of Ct — values of IPS — samples on plate p

% Y5-1Ct;’¢ — mean value of Ct — values of all IPS — samples on all N plates

The results of the Multigene-/Multiplate-Analysis are shown as bar charts. In the tab
Normalized Expression the expression of selected genes of interest, normalized to the
expression of the reference genes, is shown. In the second tab Relative Quantity the
corresponding quantity for the genes of interest and reference genes is displayed. The
respective sample name is given below each bar. The height of the bar is determined by
the calculated normalized expression of replicates. For each bar some short information
about the sample name, mean value and the calculated standard deviation is shown if
the mouse pointer is placed on it. The standard deviation for the normalized expression
is shown as error bar on top of each bar. Since for larger numbers of samples not all can
be displayed in the screen the diagram can be moved horizontally with pressed left
mouse button and dragged to the desired position. Using the mouse wheel allows to
narrow or broaden the width of the representation. Alternatively the cursor keys T and
can be used.

By a right-click on the chart the results are sorted by genes or samples names on the x-
axis.
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Representation of the normalized expression as bar chart sorted by gene name
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In the tab Table of the results table for Multigene-/Multiplate-Analysis all data and

measurement values for the samples are summarized.

|Norm. EX[h .. |5td.Dev.n...

|5b:|. Dev. ..
0,01
0,05

ra

|5b:I.Dev.

|Mean calib. ..

|Mean Ct

15,28
20,78

22,13

|5ample name & |Nu:|. of repl...
oh

tr IL1b-TexasRed Oh

Project name |Gene

0,01
0,07
0,03
0,01
0,03
2,15

19,34
22,52

tidatal_1i.r

tr [GAPDH-Cy5]

tidatal_L.r

0,05

tidatal_1i.r

0,02
0,01

24,73

oh
oh
oh
oh

tr [Actin-HEX]

tidatal_1.r

19,34
24,78

15,28

22,13

tr [GAPDH-Cy5]
tr [Actin-HEX]
tr TubulinFAM

tidatal_1.r

0,02

tidatal_1.r

30,59

27,14

mui

i

i

mui

i

i

IPS

Table

Result table for Multigene-/Multiplate-Analysis

For the Multigene-/Multiplate-Analysis the results table contains the following

information:

Meaning

Column

Name of the loaded project that contains the sample

Project name
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Gene Name of the investigated gene

Sample NAME Name oft he sample

No of replicates Number of replicates of the sample

Mean Ct Mean Ct-value of the replicates of a sample

Mean Calib. Ct Mean Ct-values of replicates of a sample calibrated by the IPS

Std. Dev. Mean Calib. Ct Standard deviation of the mean calibrated Ct-values of replicates
of a sample

RQ Calculated relative quantity for replicates of the gen in the

original sample

Std. Dev. RQ Standard deviation of the calculated relative quantity for
replicates of the gen in the original sample

Norm. Exp. Normalized expression of the sample

Std. Dev. Norm. Exp. Standard deviation of the normalized expression of the sample

You can design the results table according to your requirements by setting type,
sequence and width of the columns to be displayed. You can also adjust the sort
sequence of data in the column (alphabetical, numerical, by column, by row). The table
configured this way can be exported as Excel or CSV file by right clicking the table.

Save table as Excel-File (*, xls)
Save table as Excel-File (*,xls) and run Excel

Save table as CSW-File (*,csv)

Context menu for data export

In the tab IPS of the results table for Multigene-/Multiplate-Analysis all data for the
Interplate Standards (IPS) is summarized.

Project name Dye |Mean Ct (IPS, Project) |I'~"Iean Ct (IPS, all Projects) |C0rrecﬁu:un value
multidata3_3.rip FAM 9,67 3,48 -1,19
multidata3_3.rip HEX 11,35 10,38 -0,97
multidata3_3.rip TexasRed 8,95 8,75 0,21
multidata3_3.rip Cy3 8,36 9,38 1
multidatal_1.rip FAM 5,03 3,48 3:45
multidatal_1.rip HEX 7,74 10,38 2,65

Table |1P5 |

Summarization of IPS data

Column Meaning

Project name Name of the loaded project that contains the IPS sample

Dye Dye that has been used to determine the Ct value of the IPS sample

Mean Ct (IPS, Project) Mean Ct value of IPS samples in the project (dependent upon the
used dye)

Mean Ct (IPS, all Mean Ct value of IPS samples in all projects (dependent upon the

Projects) used dye)
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Correction value Ct correction value that is applied for all samples of the project
(column 1) and the dye (column 2)
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7 MIQE documentation

Instructions for
completing the MIQE
documentation
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In 2009 an international group of experts led by Prof. Steven Bustin developed
guidelines for the publication of real-time PCR data (Bustin et al. 2009, Clinical
Chemistry 55:4, 611-622). The aim was to prevent the publication of incomplete or
incorrect real-time PCR data and to ensure comparability and reproducibility of
experiments. The guidelines regulate the requirements regarding the minimum
information necessary for the publication of data and have become known as MIQE
(Minimum Information for Publication of Quantitative real-time PCR Experiments).

1.

MIQE consists of a list of questions to 9 different topics about real-time PCR
experiments. In the gPCRsoft auto software under the tab MIQE buttons for each
topic buttons are present providing access to the corresponding list of questions.
Additionally the button MIQE-HOME allows to jump back to the main menu from any
sub menu.

In general at first by activating the corresponding radio button in the main screen it
should be defined is DNA or RNA has been used as starting material. If the option
DNA is activated the questions for topic REVERSE TRANSCRIPTION do not have to be
answered and the corresponding button becomes inactive.

After clicking on a button the corresponding questionnaire opens. The number of
questions differs between the topics. The user should answer as much questions as
possible..

The answer to some questions is taken from the currently opened project and active
project if the relevant information is available.

The completeness of the answers to the questions is presented by the software as
progress bar and measured in %. The MIQE questionnaire distinguishes between
essential questions that should be answered and additional optional questions that
can be answered. The entry fields for essential questions are highlighted by a red
colored background whereas additional questions have a white colored background.
For the progress bar only the answered essential questions are ranked by the
software. The total number of questions differs depending on whether DNA or RNA
has been used as starting material. The software cannot evaluate the quality of the
answers. It is up to user to fully answer the questions and with due diligence.

The gPCRsoft auto software offers to import MIQE data from other projects. Clicking

|
on the button E:a in the toolbar or by using the menu item MIQE / Import MIQE
Documentation opens a dialog screen. After selecting the appropriate project the
saved MIQE data is imported into the current project.

The questionnaire can be printed by the PRINT function of the qPCRsoft auto
software. Select the point MIQE under DOCUMENTATION (— section "Printing" pg. 23)
and press PRINT. It is always the complete questionnaire printed.
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Real time per termnplate - vorlagel.rts

Sample information

Nucleic acid extraction

\/ Reverse transcription

gPCR Target information

Primer & Assays

qPCR protocol

qPCR validation

Data analysis

Progress:

27%

Essential Information

Main menu of the MIQE input mask

£ Settings ]/\;, Moritoring ]/E Analysis J/D Decumentation 4 I
L] MIQE 4 b
Target:
™ MIQE-Home
) RNA
@ DNA
Experimental design
MIQE

Minimum Information far Publication of Quantitative Real-Time PCR
Experiments

(According to the MIQE guidelines published by 5.A. Bustin et. al. in
Clinical Chemistry 55:4 (2009) 611-622.)

This tool provides a questionnaire for gathering essential and desireable
information on the real-time PCR. experiment shown in this project file.
The data can be used to generate a MIQE report by using the print
function,
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8

8.1

8.2

134

Functions in Extras menu

Device initialization

The device initialization sets the device to the original state. A device initialization is
only required after an error has occurred.

= (all up the Extras » Device initialization command.

Editing color modules

After inserting the color modules into the device's probe the color modules must be
specified in the software.

Edit color modules *
Color modules [ Edit properties
\j_) Blue
'\?_) Green -
Yelow
'\3_6_) Crange Blue. 470,520,113
@ Red
MNIR1
FRET1
FRET2 FAM
SybrGreen
FRET3 EvaGreen
FRET4 Alexa4a3
e
FRETS DSGreen
Sypro
FRETSHP
Add Delete Accept
Back to standard modules Close

Edit color modules window
1. Select the Extras P Edit color modules menu command.

A window with the same name opens. The available color modules for your device
are displayed on the left.

2. From the list, select the module you have installed in the device, activate the
Properties checkbox and select the position on which the module is mounted in the
device. If necessary, you can also add dye names if these have not yet been added to
the list. Click on [Accept].

3. Repeat this for each color module you have installed.

Note: If you operate the device in the manufacturer's configuration without
additional/other color modes, make the settings as shown in the figure above.

4. If you wish to define a new color module that is not included in the list of available
color modules, click [Add]. A new color module with the description
COLOR.000.000.00.0 is created. You can define the properties on the right side of
the dialog.
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5. To delete a color module from the list, mark the module with the cursor and click on
[Delete].

6. To change the properties of a color module, proceed as follows:
®  Activate the Properties checkbox.

= |n the Position list select the position of the color module on the carrier in the
fluorescence probe.

®  Enter the dye that is detected with the color module.
Click on [+].
The dye is added to the list below.
You can remove a dye by marking it in the list and clicking on [-].

®  (lick [Accept] to assign the properties to the marked color module.

Note
A dye can only be assigned to one module. If it is to be measured with a different
module, it first has to be removed from the first module.

8.3  Connecting the device to the PC

The software gPCRsoft auto automatically recognizes which instrument is connected
and whether it is switched on or not. The instrument may also be switched on and off
during running qPCRsoft auto. Whether an active connection is established will be
indicated in the lower left corner of the status line.

® |f 3 connection cannot be obtained in between 30 seconds you can use the Extras P
Device identification in order to solve the problem

8.4  General settings in the gPCRsoft auto software

General tab

General settings for the gPCRsoft auto program can be made in the Options window.

Note
For most of the settings in the Options window you need to be logged into qPCRsoft
auto as an administrator.

1. Close all projects.
2. Select the Extras » Options menu command to open the window of the same name.

3. Make the settings on the tabs.

On the tab General, you can define the Options for saving and exporting projects.

Option Description

Auto save folder If you want to save the projects automatically after the PCR run has

(project) finished, enter a path name for the projects here where the projects
will be saved.

135



Functions in Extras menu

136

Automatically (on
the auto save
folder)

Manually after the
gPCR run

Manually at the
start of the qPCR
run

Save backup file
Last_Run.rtpx' (in
the auto save
folder)

autom. raw data csv
export at the end of
the run

autom. Ct-data csv
export at the end of
the run

Zip files per run

Auto save folder
(raw data csv)

Automatically save projects to the folder specified above after the PCR
run has finished. If you have selected the option, choose an option for
the file name:

[DATE]_XXX.rtpx
The file name is generated from the date and a consecutive number.
[Name]_XXX.rtpx
The file name is generated from a freely selectable name (enter the

name in the input field) and a consecutive number.

After the gPCR run, the Save project windows opens for entering the
file name for the project.

After starting the gPCR run, the Save project window opens. The
gPCR run does not start until the file name is entered and confirmed.

You can save the data of a running gPCR protocol. If the gPCR run is
interrupted prematurely, all fluorescence measurements performed
up to this point are recorded in this file.

The backup file is saved in the Auto save folder (project) path and is
overwritten each time a new gPCR run is started.

After a qPCR run, 2 data files for each dye (amplification and raw
data) are exported. An available melting curve is exported, too.

The file names are composed of the following values:
TemplateName_Type_Date_Time_Dye.csv

(Example: Kit-Template_AD_2020-09-21_1154 FAM.csv)

The melting curve is saved with the following file name:
TemplateName_Type_Date_Time.csv

The value "Type" indicates the exported fluorescence data:
AD Amplification data

MD Melting curve data

RD Raw data

After gPCR run, the determined Ct values are exported to a CSV file.
The file name is composed of following values:
TemplateName_Typ_Date_Time.csv

(Example: SyGreen-Assay_Ct_2020-10-23_1501.csv)

If the automatic export of the raw data or the Ct data has been
activated, the generated CSV files are combined in a zip file with the

extension "*.ajq" and saved in the file path below. The individual CSV
files are not saved separately.

The file name is composed of following values:
TemplateName_ Date_Time.ajq

If you have activated the automatic CSV export of the raw data or the
Ct values, enter the path for saving the export files here.
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Optiens *
General Data format Language Measurement Analysie Device File User management Colors  Automation

Auto save folder (project):
|C: ‘\WzersPublic\Documents\Analytik Jena\gPCRsoftauto$31075-0102 \Projects

Save projects:
(® Automatically (in the auto save folder)
Filename options:
(@) [DATE] _xx%.rtpx
() [Name] _xxx.ripx Name: |

(O Manually after the gPCR run
(O Manually at the start of the gPCR run

Save backup file "Last_Run.rtpx” (in the auto save folder)

autom. raw data csv export at the end of the run Zip files per run
autom. Ct-data csv export at the end of the run

Auto export folder:
|C: \WzersPublic\Documents\Analytik Jena\gPCRsoftauto31075-0102\Exports |

=

Options / General window with functions for automatically saving and data export

Data format tab On the Data format tab you select decimal separator for the data export and number of
decimal places to be displayed for different variables.

Language tab On the Language tab you select language of the gPCRsoft auto program interface.

Measurement tab On the Measurement tab you set basic options for fluorescence measurement and block
temperature control.

Option Description

Sensitivity Set the basic sensitivity of the detection system
This setting affects all dyes and should only be changed if
particularly weak or intense samples are to be measured.

The pre-setting value is"5".

Meas. rep. color comp. Enter the measurement repetitions for recording the color
compensation.

Show negative values If activated, negative values are also displayed in the sequence of
resulting from color the color compensation, otherwise the output is "0".
compensation

STC (simulated tube If enabled, the temperature in the sample is pre-calculated with

control) activ the measured block temperature and the temperature is regulated
to the sample temperature. This method is particularly
recommended for fast protocols.
If disabled, the block temperature is regulated according to the
selected temperature program. Particularly if the heating and
cooling rates are high and the hold times are short the actual
sample temperature can differ from the desired temperature.
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Analysis tab

Device tab

File tab

User management tab

Colors tab

Automation tab
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In the list boxes, you can enter a factor for the quantitative evaluations (Quant factor),
for the melting curve analysis (Melt factor) and for the genotyping (Genotyping factor),
which will be used for the automatic calculation of the threshold.

If you activate the option Fix scaling to 100%, the scaling of the Y-axis (fluorescence,
dRn) is fixed to 100% in all slides that display normalized fluorescence values. There is
no automatic scaling if the displayed curves are less than 100%. This facilitates the
evaluation of weak fluorescence.

On this tab you to define a file name into which the device communication data will be
written. The recorded data is used for error diagnosis (— section "Appendix B - How to
save communication data"p. 157).

On the File tab you can activate file types, when selecting them File Explorer of the
operating system will automatically start the program qPCRsoft auto and open the file.

See also information about file formats in section "Managing projects and templates" p.
20.

On the User management tab you activate or deactivate the user management (— "User
management"' p.139).

If the user management is deactivated, no login prompt will appear at the program start.
The functions for setting up the user management and for signing projects will not be
available.

If the module 21CFR Partl1 is installed and active, the user management can't be de-
activated (— "Optional 21 CFR Part 11 module" p. 145).

On the Colors tab, you define the following color settings:
= Display color for sample type and replicates in the plate layout
= Color of fluorescence curves separated by sample type, well or replicates

®  Colors for the markers of positive and negative evaluations

On the Automation tab you define the settings for control in an automated system by
Composer or DLL.

Option Description
Activate The thermal cycler is immediately connected to the plant when it is
automation at started and controlled from there.

software start @
You can disconnect the connection by clicking on the button in the

toolbar (— "Starting and exiting " p. 9)

Server IP (own) Select the interface to Composer or own interface.
The field is automatically updated when the Options window is opened.

Task-Port/State- If several devices are controlled via one PC, select the corresponding

Port ports. The ports must be set separately in each program instance and
differ from each other (50001/50002 in the first instance,
50003/50004 in the second, etc.).
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9 User management

Note on the general data Due to the encryption used, reading and changing project, template, evaluation and
security communication files generated by gPCRsoft auto is only possible with gPCRsoft auto.

The usermangement will be enabled in the window Options / User management.

Option Description
User login is If enabled, the user management is effective at the next program start.
required Logging on to the program is then only possible with a valid user profile.

Note: The first time the program is started after installation, an
administrator with access to the user administration is created.

[Settings] Settings for passwords, login and logout
[Edit] Manage user profiles
Options ﬁ

| General | Data format I Language I Measurement | Analysis I Device I File | User management | Colors

User log in required

Ok ] [ Cancel

Window Options / User management

9.1 Basic settings for password, login and logout

To access the basic settings that apply to all users, select the Extras » Options menu
command. On the User management tab click on [Settings].

You can make the following settings in user management:

= Number of login attempts: If the number of allowed logins attempts to a user
account is exceeded, i.e., if the attempts fail, the user account is deactivated. It can
then only be reactivated by the administrator.

= Minimum length of the username and the password
m  Required characters in the password

®  Warning prior to the password expiring
The password expiring is set in the user profiles

139



User management

® | ogoutin case of inactivity: After the specified time has expired without mouse or
keyboard activity, the program interface will be locked, and the login window is
displayed. The user first must enter the password before the interface can be used
again. If [Cancel] is selected in the login window, the program is closed. It is not
possible to change the user at this point. Automatic logout does not occur if a gPCR

run is active.

-
- — -
Settings of the user management -

|

Idle log out after

Mumber of log in attempts allowed:
Minimum length of the user name:

Minimum length of the passwaord:

User name and password must be different

|| Display warning prior to expiration of the password 4

1

[~] The password must contain letters, numbers and spedial characters

4| ||

||

-

Days in advance

Minutes

’ Default settings

L%

General settings in user management

9.2  Managing user profiles / user groups
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[

Ok

=

— e

To access user management, select the Extras » Options menu command. On the User
management tab click on [Edit].

-

L

— - — A
User profils - - ﬁ

Mame Group Changed

ﬂ Administrator Administrator 13.03.2018 11:17:26
B Arthur Operator 13.03.2018 11:03:44
B Lisa Supervisor 25.05.2018 11:43:53
B Ronny Supervisor 13.03.2018 11:08:08

add || Edt || Deete | ok || caneel

User management with the overview of the created user profiles

The following functions are available in the extended user management:

Function

Description

[Add]

Create a new user profile




Add / edit user profile

[Edit]

[Delete]

User management

Edit a selected user profile

Delete a selected user profile

By default, these functions are only available to users belonging to the Administrator
group. However, they can also be assigned to a Supervisor by editing the user rights.

m  To create a new user profile, click on [Add].

®  To edit an existing user profile, mark the user profile in the list and click on [Edit].

v" The window for editing the user profile appears.

®  Enter the following data:

Option
General tab
Username
Full name
Description

User group

Password tab
Password

Confirm the
password

User must change
password with new
login

User may change
password

No password
timeout

User is deactivated

User is locked

User can sign
electronically

Description

Login name at program start
Actual name (optional)
Further description (optional)

Assign a user group

The rights of each individual user can be individually adjusted within
the user group (see below).

Enter the password

Repeat the password

If activated, users must change their password at first login.

Users can change their own password.

The password is valid without a time limit.
If deactivated, the expiry date must be specified.

The user profile was automatically locked after multiple failed login
attempts or by an authorized user. Enter the number of possible login
attempts in the settings (— section "Basic settings for password, login
and logout" p. 139). The time when the user was locked is displayed.

The user profile has been locked by an authorized user. The user name
no longer appears in the login dialog, however, the user remains
created. The time when the user was deactivated is displayed.

The user is allowed to sign a project electronically (— section "Digital
signatures'p. 149).

This optionis only available, if the optional module 21 CFR Part 11 is
enabled.
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User groups
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-

User profile k g

General | password

User name: | Arthur

Full name:  Arthur Angel

Description:  Technidan

User group:  Operator -

User has access to simple programm functions.

Edit user group access ]

Settings for the username and the assigned user group

-
User profile k‘ M

General | Password

Password: [TII0]

Confirm password: sesse

[T User must change passwaord with new login
User may change password

Mo password timeout

[ User is deactivated

[ user is locked

[ User can sign electronically

Settings for the password and the validity of the user profile

The following user groups are available:

Administrator:

This user group has unlimited rights to all program functions
Administrators can create, delete, lock and unlock users and assign rights to them
They are allowed to change their own password and that of other users

They can deactivate user management in Extras » Options » User management
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Supervisor:

®  This user group has the same rights as the administrator except creating and
managing users. An administrators can block certain rights for each user logged in as
a supervisor.

Operator:

The following rights cannot be assigned to an operator:
®  (reate and manage users

m  (reate and save templates

®  Save projects

= Changes in the Options window on the General, Thermal cycler, Scan, and Layout
tabs

With this selection you automatically assign a certain user role to the user and thus
preset rights which you can additionally supplement or reduce using the Edit user
access function. This allows individual rights to be defined for each user. It is also
possible to set up several administrators with different rights.

= |n the User profile / General window, click on [Edit user group access].

v" The window of the same name containing the rights of the selected user
appears.

® |f a checkbox is activated by a checkmark, this right is granted to the user and the
user can use the function.

®  (Checkboxes with a lock symbol cannot be changed.

= The number of these locked rights is determined by the selected Administrator,
Supervisor or Operator user role and increases in this order. This means that an
operator has fewer rights than a supervisor or administrator from the outset and can
never be assigned all rights.

®  An administrator has all rights in the program and these rights can only be restricted
by removing the checkmarks. The right of an administrator to manage and create
users cannot be locked, otherwise user management would no longer be possible.
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-
Benutzergruppenzugniff bearbeiten n g

Benutzergruppenzugriff:

[T] [ Benutzer anlegen und verwalten

[ GFarbmoduIe anmelden und verdndern
G\-‘orlage SpErren

Vorlage neu erstellen

Vorlage speichern

Prajekt speichern

Anderungen auf Karte Allgemein
Anderungen auf Karte Thermocyder
Anderungen auf Karte Scan
Enderungen auf Karte Layout
GqPCR—Lauf starten

GCt— und Tm-Berechnung im Monitoring
[ G.ﬂ.nalysen anlegen und editieren
GMIQE-DokumenEtinn bearbeiten

[ GProben aktivieren [ deaktivieren

[ GAuditTraiI anzeigen [ filtern

] GDrudcfunktion

OooooEEO

| ok || abbruch

Configuring an individual user profile within a user group

9.3  Edit password
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If the user may change his password, he can open his user profile in the user

management and change the password. Supervisors and operators can only do this in
the usermanagement. They have not access to over functions in the usermangement.

1. Open with the menu point Extras » Options the window Options / User
management.

Open with [Edit] the window User profiles.
Select your user profile and click on [Edit].

Change and confirm the password in the window User profile / password.

voR W N

Confirm the settings and exit all windows with [OK].
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10 Optional 21 CFR Part 11 module

10.1 Activation

Automatic activation

Starting with version 1.2, the gPCRsoft auto software contains functions that make the
program compatible with the requirements of 21 CFR Part 11. After fee-based
activation, the following functions are available:

Audit Trail in templates and projects, i.e., changes made to the project settings are
continuously recorded.

Login Monitoring during which attempts to log in to the program and also changes
to the user settings are stored

Editors for the evaluation of audit trails and log files using search functions,
including a print function

Creation and display of Digital Signatures in templates and projects with monitoring
of their validity

Automatic Logout in case of inactivity with the option of adjusting the time

To activate the functions, you need an activation code that can be ordered from your
contact person or dealer. This fee-based activation code entitles you to use the software
on a single computer (single-user license). If it is planned to use this optional module on
several computers, an activation code is required for each computer.

The module is activated in two steps:

Send an order file (*.RTO) to Analytik Jena

Import an activation file (*.RTL) sent by Analytik Jena

Select the Help » Additional modules » Order "21 CFR Part 11" module menu
command.

v" A window containing information on how to continue appears.
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Order "21 CFR Part 11" - Medule |

With the help of this dialogue you can order a licence for using the software functions required by 21CFR Part 11,

Using this dialogue you can order a licence key (with costs) which makes the software compatible with the requirements of 21 CFR
Part11. Functions like Audit Trail, Log In list and Digital Signature are then available. In order to generate this licence key we need
identifying information of your computer which you can transmit to us by dicking “Save” and sending the file generated to your
dealer.

You will be sent a file the help of which you can activate this part of the software. For more information see the manual.

If you are not allowed to copy files from or to your system, please contact your dealer.

Save ] [ Close

Creating the RTO file for ordering the activation code
= (Click on [Save].
v This creates a file for generating the activation code.

= Save the file with the extension "*.rto" under any name on your computer and send
this file by e-mail to your dealer or contact person.

®  Assoon as Analytik Jena has processed your order, you will receive a file for
activating the 21 CFR Part 11 functions (license file). Copy the file to the hard drive
on your computer.

= Start qPCRsoft auto and select the Help » Additional modules » Activate "21CFR
Part11" module menu command.

® |n the Activate "21 CFR Part 11" module window, enter the storage location for the
license file and click on [Activate].

Activate "21 CFR Part 11" - Module [
Activation file:
C:'ProgramData\Analytik Jena\gPCRsoft'\4. Dlactivation.rt E]
Activate ] ’ Cloge ]

Importing the RTL file for activation
v" A notice field indicates whether activation was successful.

m  After completing activation, restart the software and check whether the new
functions appear in the Compliance menu.
Note: The functions are only active if user management is activated.

v If the functions are displayed, activation has been successfully completed. If
activation is not successful, contact your contact person or dealer.
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Manual activation

10.2 Audit trail

Display and evaluate audit
trail

Optional 21 CFR Part 11 module

File Edit View Cumpliam:e Extras  Window

|_| e - Show audit trail ‘

Window 0 - Unnan - Show signatures

Compliance menu for the "21 CFR Part 11" module

d

Show log file

1 5

The created RTO-file contains the name of the computer on which activation should
take place and the MAC address of the network card in encrypted form. Analytik Jena
uses this data in order to automatically generate the activation code for your computer.
The data is processed in encrypted form. It is not used for other purposes or passed on
to third parties.

If you are not allowed to copy or send files on your computer, a manual activation
method is available. In this case, contact your contact person or dealer.

The audit trail records changes to metadata in templates and projects. Metadata
determines how the results are calculated and displayed from the raw data of a qPCR
run, and thus influences the result of the experiment. The raw data, on the other hand,
always remains unchanged, meaning it is not part of the audit trail. If settings are
changed in the project or the template, the new metadata is appended as a block to the
original data when the file is saved. This process takes place automatically in the
background. If a project is frequently opened and edited, the scope of the audit trail can
increase considerably. It is not possible to delete contents in the audit trail.

Search functions are available for evaluating the (in some cases extensive) audit trail of
a project or a template. These functions allow you to systematically search for and
identify changes to metadata.

®  Select the Compliance » Show audit trail menu command.
m  To start the search, click on [Search].

= To print out the content that is displayed in the text field (the complete audit trail or
reduced content as a result of a search), click on [Print].

The following search options are available:
= The Find info and Find text input fields are empty: The entire audit trail is displayed.

®  There is an entry in the Find info field: Search in the block headers, i.e., in the text in
the square brackets. This makes it possible to track when the file was created, by
whom, and how often it was edited.

®  Thereis an entry in the Find text field: Search in the audit trail. A search can be
carried out for terms that characterize certain settings for the qPCR run, the display
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of results, the evaluations, the layout and general information. An overview of the
terms and their meaning can be found in Annex D.

The input fields save search terms that have been previously used and make them
available for reuse via the drop-down menu

Show audit trail [

Find info:
-
Find text:
comment -
Find results:
[Administrator - 06.06.2018 11:04:41 - AT_DATA_CREATECLASS] -

General, Comments ->
Samples[A1]. Comment -=
Samples[A2]. Comment ->
Samples[A3], Comment -
Samples[A4], Comment -
Samples[A5]. Comment -
Samples[AG]. Comment -
Samples[A7]. Comment -
Samples[Ag]. Comment -
Samples[A9]. Comment -=
Samples[A10].Comment -=
Samples[A11].Comment -=
Samples[A12].Comment -=
Samples[B1]. Comment -
Samples[B2]. Comment -
Samples[B3]. Comment -
Samples[B4].Comment -=
Samples[B5].Comment -=
Samples[Ba].Comment -=
Samples[B7]. Comment -
Samples[B8]. Comment -
Samples[B9]. Comment - -

=) [

Audit trail for a project with a search

m

10.3 Login monitoring
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All login processes in the gPCRsoft auto software are monitored and stored in encrypted
form in a log file that is protected against manipulation by a checksum. This file also
contains information about newly created users and digital signatures. The program
records whether logins and signatures were successful or failed. In case of failed
operations, the cause is also indicated (wrong password, wrong user name).

®  Select the Compliance » show log file menu command.

= Limit the display by activating the checkboxes and the selection in the corresponding
lists.

®  To print the displayed results, click on [Print].
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Log Datei anzeigen

Typ:
LOG_TYPE_ADDUSERCK

|| Benutzer:

[7] Zeitspanne:
06.06,2013

Resultate:

LOG_TYPE_ADDUSEROK
23.01.2018 13:33:54
Marion

LOG_TYPE_ADDUSERCK
23.01,2013 15:38:59
Arthur

LOG_TYPE_ADDUSERCK
13.03.2018 11:03:44
Arthur

LOG_TYPE_ADDUSEROK
13.03.2018 11:05:15
Lisa

LOG_TYPE_ADDUSEROK
13.03.2018 11:08:08
Ronny

- 06.06.2018

Suchen H Schliefen

Log file with filter

10.4 Digital signatures

10.4.1 Signing a document

Sign an active document

Registered users who also have the relevant authorization can digitally sign a template
or a project (— section "Managing user profiles / user groups" p. 140). The signature is
equivalent to a handwritten signature because it can be clearly traced back to its creator.

m  Select the Compliance » Sign digitally menu command.

v The Signature window appears.

= Make the following settings:

Parameter

User name

Password
Status

Comment

Description

Select the registered users who are authorized to sign

The user logged in to the program is preset in the selection
Enter the user's password
Select the signing status: Created, Edited and Released

Additional explanation of the signature (optional)
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= Confirm your entries with [OK].

v The digital signature is saved in the project or the template. Digital signatures
are valid as long as no changes are made to the project or the template.

-
Signature Iﬁ
Properties
ll—_ User name:  Administrator -
Password: s s|
Status:
[Created -
Comment:
Experiment A -
4 2
Ok l ’ Cancel
L

Window for signing a template or a project

10.4.2 Displaying signatures

You can view and print out the signatures assigned to a project or a template.
m  Select the Compliance » Show signatures menu command.

v" The Show signatures window appears. You can check the validity of the date
and the creator of the signature.

= To print the displayed data, click on [Print].

Show signatures @
Signatures
Signatur 1
Created by: Administrator
Signed on: 06.06.2018 11:29:51
Status: invalid
Importance: Created
Comment: Experiment A
Signatur 2
Created by: Administrator
Signed on: 06.06.2018 11:31:30
Status: valid
Importance: Created
Comment: Experiment A, ROX added

Overview of the signatures of a template or a project
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11 Appendix A - Short instruction

The gPCRsoft auto main
window

Project window - Settings

0 apcRooftzed auto - 310750003 - o X

D2-AP-BS(v B

_rumwmmmMg
EX P o@m

Mo connection with “qTOWER'S84 /G

The main window is arranged in different areas: Menu bar (1), Toolbar (2), Project
explorer (3), Project interface (4).

1. To create a new project select the menu command File » New or press the buttonD
in the toolbar.
Use the commands File »Open project or File »Open template to load saved files.

2. Open the Settings tab.
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aj LBaal o mor L caloonglls phe
T

iy Settings W2 Monitoring £ Analysis

Documentation

| =
{ ] General [ Thermal Cyder & Scan

Title:

= |3 |l

Tab 1st order

B
___
Samples ]X
Tab 2nd order

|Salm0nella

Operator:

|User

Start: End:

Comment:

optional notes about the experiment|

3. Enter general information for the project under tab General.

4. Enter PCR program under tab Thermal Cycler.

Table ( ¥ Step: 4 of 5)

Lid temp. %C: 100 = [¥]Preheat lid Device:[T—OpticaI 96

4 steps | scan °C m:s goto | loops | AT(°C) | At(s) | ~(°C/s)

1 95,0 02:00 - - s - 3,0

2 95,0 00:05 = = = 5,0
41x[ 3 58,0 00:05 | -- - 5,0

4 3 72,0 n0:15 | 2 40 5,0

5 & |Melt. curve 60 to 95 °C, 6 s with AT 1 °C

6

7

8

9

10

Table | Graph | Melting curve

m  Set lid temperature and activate or deactivate preheat mode.

m  Set temperature and time for each step.

Variable display
range

®  Forloops set the step number in column goto the program jumps back to and in

the column loops define the number of measurement repeats.

= [f necessary define temperature or time increments or adjust the ramping rates.

®  [f necessary activate the melting step and edit parameters.

®  |n the column scan define at which step the fluorescence is measured.

5. Define the fluorescence measurement settings on the tab Scan:
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Real time per project - ddCt_WithStandards.rtpx =GR
Q‘; Settings l/& Monitoring ]/E Analysis ]/D Documentation ] 4 b
[ General ]/ﬁ Thermal Cyder J/Q Scan Samples ] 4 b
Pos. Channel Dye Gain Measurement  Pass. Ref,
1 Blue FAM 5 *
2 Green JOE 5
3 Yellow TAMRA 5
4 Qrange RO 5
5 Red Cy5 5
] MNIR1 Cy5.5 5
Meas. repeats: 3 | Color compensation: off ~
Scan region according layout
Define scan region manually

®  Set hash key in the column Measurement for each channel to measure
®  Select dye to measure in column Dye and set LED intensity in column Gain.
®  For passive reference check mark in column Pass. Ref.
®  Set number of measurement repeats and define region to scan.
= |f necessary activate color compensation.
6. Define plate layout under the tab Samples (can be done during the run):
®  Set sample name and sample type.
= Enter name for the gene to be measured in column Gene.
®  Forstandards enter concentration in column Conc. and set unit

m  Select position or region in the plate layout.

®  Assign settings to the selected wells using Toolbar button @

7. If the plate contains samples from different experiments that have to be analyzed
separately create groups:

Real time per project - Unnamed EIE
ﬁ Settings l/k;’} Manitoring ]/E Analysis l 4 b
7 General ]/’ﬁ Thermal Cyder ]/-@ Scan /V Samplsl 1 Pk

Editlayout ”m
1|2|3|4|5|6|?|8|9|10|11|12|GWUD: Group 4 i
©000000000DDD “ '

000000000000
000000000000
000000000000
06606000 - -1 1]
(31:1:1:1:1:1:10 0000
000000 - -1
(3l 1:1:1:1:1:10 0000

®  Select group and set group name.

®  Select position or region in the plate layout.

®  Assign settings to the selected wells using Toolbar button =
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8. The layout preview functions provide a comprehensive overview for the plate layout.

To activate the layout preview use button .

Project window - = Press button P to start the run
Monitorin N . . . .
9 ® |n the Monitoring window the results of the run are displayed in real-time
[33] Real time pcr project - gTOWER2_Dema_AbsQuantl_l.rtp === @
i Settings 2 Monitoring - % Analysis [¥]  Documentation 4 b
View: [Ampliﬁcat‘on -] ¥ [ Calculate Ct ]

200004

15000
Amplification

10000 curves

Intensity [I]

5000

Cycles [n]

e
‘ All colors | FAM " Dye

tabs

Lid: 25,0 °C 4 steps | scan oC m:s

1 95,0 02:00

2 95,0 00:05

41)([ 3 58,0 00:05

4 * 72,0 00:15
° 5

25,0 °C 6 PCR protocol
7
8
9
10
™\ Protocol display
( Table | Graph | T-Profile )} tabs

= For the results either the PCR accumulation curves or the melting curves can be
displayed. Use selective list View to display the different results.

®  Use dye tabs to select between the different dyes.
®  The PCR protocol can be displayed tabular, graphical or as temperature profile.

®  After the PCR run, Ct values and melting temperatures can be calculated for all
samples without applying an evaluation. Click the [Calculate Ct] button in the
amplification curve display or [Calculate Tm] in the melting curve display.

Project window - Analysis ~ For analysis different analysis methods for absolute quantification, relative
quantification, AACt-method, genotyping and melting curve analysis are available.

®  To start an analysis select corresponding tab and press button [Add analysis] in the

toolbar. This button is labeled with a + -symbol (for example _Jﬂ)

® |n the window that opens enter a name for the analysis:
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Description of the analysis:

The analysis window is separated in a header for general settings, a graphical chart to
display amplification curves and an area to display standard- or validation curves or the
result table:

[33] Real time per project - 3Toptical_Demo_RelQuantl_1.itp (=8 (EcE ~~™
§y Settings | @& Monitoring ¥ Analysis 4 b
&5 Abs.Quant. | %4 Rel. Quant. | °§' DeltaDeltaCt 5 Melt. curve | 4 b
Gene of Interest (GOI): Group: Threshold: = Header
FAM-c-myc - Indude passive reference Group 1 - 1,189 [E]
Reference genes:
FAM-GAPDH ﬂ @
100 4
75 : z
Amplification
curves
£
g 509
254
04
T T T T T T T T
5 10 15 20 25 30 35 40
Cyde
GGO, £aM[Ref.geneFAM | ) GOl/References
/ genes
FAM-c-myc  |FAM-GAI
R2 0,99989 0,99943
S .
" Slope -3,59 3,7
< 20 \'\‘\. oL E—— ITE Standard curves
15 | : ; PCR Effidency (0,9 0,86
1 2 3 4
Log Std. Conc. < | »
Y
( Table |Standard curve [ f Table/curves tabs

In the header various settings can be made that differ by the analysis methods:
m  Select gene of interest (GOI).

= |f applicable set passive reference (e.g. ROX) for normalization.

m  Select between different experiments (groups).

m  Select at least one reference gene to calculate a standard or validation curve.
m  Set baseline correction.

m  Set threshold (manually or automatically).

®  Switch between linear and logarithmic display of the fluorescence intensities.
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Method Analysis name Show/hide header
Dve Gene of Gene of Interest (GOI): Group: Threshold: i
In)t{erest AM-c-myc A Indude passive reference roup 1 v 1,189 Base_"ne/
Scaling
Reference genes:
FAM-GAPDH =] [T
Dye reference Include pass. Group Remove Threshold
gene reference reference gene settings

® |n the amplification curves area the fluorescence intensity curves are shown:
® |n the linear mode the base line correction can be checked.

= |n the logarithmic mode the threshold line can be set manually. Move the threshold
line up or down by using the mouse.

m  Switch by the tabs between the different dyes.

If the cursor is moved on a curve some short information for the sample is displayed.

In the lower part of the analysis window the standard or validation curves are displayed:

®  Forthe curves calculated values are displayed in a table.
®  Use tabs to switch between the display of curves and of the result table.
Standard-/Validation curves Results table
FAM-c-myc | VIC-GAPD) Wel | [samplerame [Sample type [Group [Gene [et Meai 4
R*2 095968 Al 671d DNA Unknown Group 1 rp49 31,79 30,
" |Slope -2.72 -3.48 A2 .sm DNA Unknown Group 1 p49 29,2 30,4
= R o [offset 21.28 2743 46 671d DNA  Unknown Group 1 P45 31,23 30,4
H d 1.-_ i IPCR Efficency [1.33 0.94 A10 .sm DNA Unknown Group 1 p49 30,49 30,4
2 1 0 1 A1l .sm DNA Unknown Group 1 rp49 29,81 30,4
Log std. Conc. LLJ ﬂ zl_l 671d CDNA Unknown Group 1 rp49 30,7 EU;‘I hd
| Table ), Stardard curve /| Table {Standard curve

= Define columns to be displayed in the result table after right mouse click on a column
header.

®  Export data from the result table as *.csv files after right mouse click in the table.
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12 Appendix B - How to save communication data

With problems with your device you can record the communication data of the device
and send it to the service. This makes easier the distant diagnosis. For this purpose the
recording must be activated and a file name to the memory of the data be agreed.

Note
To the activation of the recording of the data traffic you must be announced as an
administrator.

1. Run gPCRsoft auto.
2. Choose the menu command Extras » Options and open the Device tab.
3. Activate the checkbox Save data traffic.
4. Click the button [...], the Open dialog appears.
5. Typein a file name to which the communication data shall be sent. The extension of
the traffic file is "*.dtf".
6. Confirm the dialog by clicking [Open].
Options X
General Dataformat Language Measurement Analysis Device  File User management Colors

Connection data file:
|C: Wsersli10111039\Downloads\DataTraffic. dtf

Save data traffic

Select device:
GTOWER /G w

Cancel

During the next PCR run the communication data between instrument and PC are
recorded in the file denoted. Send this file to Analytik Jena upon request.
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13 Appendix C - Creating a project template from the
transfer file (LIMS)

The gPCRsoft auto software can be configured by another program (e.g. a Laboratory
Information Management System" (LIMS)). In order to do this, the LIMS has to create a
file that is imported by qPCRsoft auto via the File » Import LIMS function. The so-called
transfer file has a specific structure that can be provided by Analytik Jena if requir
gPCRsoft auto soft creates a template with the transfer file, with which a PCR run can be
started immediately.

The different export functions of gPCRsoft auto can be used to transfer the results of the
PCR run to the LIMS, depending on which data the LIMS expects.

158



Appendix D - Entries in the Audit Trail

14 Appendix D - Entries in the Audit Trail

Audit-Trail print out

Description

[Administrator - 25.06.2018 08:47:00 -

AT_DATA_CREATECLASS]

Who created this project and when? Default Audit Trail data set is
following.

[Administrator - 04.07.2018 11:10:17 -

AT_DATA_SAVEPROJECT]

Who saved this project and when? Altered Audit Trail data set is
following.

General
DEVICETYPE device type: 3=qTOWER?
APPVERSION version of qPCRsoft used

FIRMWAREVERSION

firmware version of the connected device

DataUser.Name -> Administrator

logged in user

DataUser.Level

general user role (Administrator, Supervisor, Operator)

DataUser.LevelBits

granted rights of this user, coded in bits

DataUser.Password

password of the logged in user (not displayed here)

DataUser.Userdependent

not used

General.Title

titel entered on the card General

General.Operator

operator

General.DateTime

date and time of project creation

General.Comments

comments entered on the card General

General.DevicelD

device identification data read from EEPROM

Thermal Cycler
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CyclerProgram ->
ProgData.BlockType=14;ProgData.LidTemp=100;Prog
Data.HotStart=True;
ProgData.Control=10;ProgData.Standby=False;ProgDa
ta.BlockTemp=12;ProgData.MeasTime=10;MeltData.S
tartTemp=60;
MeltData.EndTemp=95;MeltData.Gradient=1;MeltDat
a.Time=16.128;MeltData.Ramp=5;
MeltData.Equilibration=6;MeltData.Active=False;StepC
ount=4;Head.ProgramNumber=1;
Head.Gradient=False;Head.ProgramPath=TOP;Head.Pr
ogramName=P(CR;Head.ProgramDate.Day=11;
Head.ProgramDate.Month=7;Head.ProgramDate.Year
=12;Stepl.ScanFalse;Stepl.Temp=95;
Stepl.Time=02:00;Step1.Goto=-;Stepl.Loops=-
;Stepl.Templinc=-;Stepl.Timelnc=-
;Stepl.Ramp=5;Step2.ScanFalse;
Step2.Temp=95;Step2.Time=00:05;Step2.Goto=-
;Step2.Loops=-;Step2.Templnc=-;Step2.Timelnc=-;
Step2.Ramp=5;Step3.ScanFalse;Step3.Temp=58;Step3
.Time=00:05;Step3.Goto=-;Step3.Loops=-;
Step3.Templnc=-;Step3.Timelnc=-
;Step3.Ramp=>5;Step4.ScanTrue;Step4.Temp=72;Step4
.Time=00:15;
Step4.Goto=2;Step4.Loops=40;Step4.Templnc=-
;Step4.Timelnc=-;Step4.Ramp=5;

program of the thermal cycler used fo this experiment

Fluorescence Measurement

ColorModule.Position -> 1

color module position 1

ColorModule.Code -> Blue.470.520.11.3

type of the color module used

ColorModule.Color -> FAM

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> -1

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 2

color module position 2

ColorModule.Code -> Green.515.545.11.2

type of the color module used

ColorModule.Color -> JOE

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 3

color module position 3

ColorModule.Code -> Yellow.535.580.11.2

type of the color module used

ColorModule.Color -> TAMRA

dye selected

ColorModule.Gain -> 5

set gain
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ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 4

color module position 4

ColorModule.Code -> Orange.565.605.11.2

type of the color module used

ColorModule.Color -> ROX

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 5

color module position 5

ColorModule.Code -> Red.630.670.11.1

type of the color module used

ColorModule.Color -> Cy5

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 6

color module position 6

ColorModule.Code -> NIR1.660.705.11.1

type of the color module used

ColorModule.Color -> Cy5.5

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

Compensation.Name ->

name of the color compensation used

Compensation.Infos[0].Position through
Compensation.Infos[5].Position

Compensation.Infos[0].Color through
Compensation.Infos[5].Color

Compensation.Infos[0].Gain through
Compensation.Infos[5].Gain

information about color modules, dyes and gains used for this
color compensation, displayed for all 6 color module positions

Compensation.Matrix[0, O] through
Compensation.Matrix[5,5]

elements of the color compensation matrix

Scan.Repetitions -> 3

number of measurement repeats

Scan.SpectralCompensation -> 0

type of the color compensation (off, standard, select)

Scan.FromCol -> 1

begin of the scanned area of the plate

Scan.ToCol -> 12

end of the scanned area of the plate

Scan.ColRangeType -> 1

select scanned area from layout (-1) or manually (0)

Layout

Layout.Code -> Blue.470.520.11.3

color module the following gene is measured with

Layout.Infos[A1].Gene through
Layout.Infos[H12].Gene

gene name of each well of the plate
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Layout.Infos[A1].Concentration through
Layout.Infos[H12].Concentration

standard concentration of each well of the plate

Units -> ng

concentration unit

Samples[Al].Name through Samples[H12].Name

sample name for all wells

Samples[A1].Typ through Samples[H12].Typ

sample type for all wells

Samples[A1].SubTyp through Samples[H12].SubTyp

sample sub type for all wells

Samples[Al].Comment through
Samples[H12].Comment

comments for each well

Samples[Al].Active through Samples[H12].Active

Is this well activated?

Samples[Al].Marked through Samples[H12].Marked

Is this well marked in the explorer?

Groups[A1] -> 0 through Groups[H12]

To which group does the well belong?

GroupNames -> Group 1 through GroupNames ->
Group 12

names of the 12 groups possible

LOCK->0

template locked? Yes (-1), No (0)

Calculate Ct

CtAnalysis.Thresholds -> 0,794712458619839

threshold value the Ct values were calculated with

CtAnalysis.Smooth -> -1

smoothing On(-1), Off(0)

CtAnalysis.SmoothMode -> 5

number of points used for smoothing

CtAnalysis.Log -> 0

logarithmic chart On(-1), Off(0)

CtAnalysis.BaseLineRange[0].Min -> 3

manually set lower boundary of the base line (cycle number)

CtAnalysis.BaselLineRange[0].Max -> 15

manually set upper boundary of the base line (cycle number)

CtAnalysis.BaseLineRange[1].Min -> 5

automatically set lower boundary of the base line (cycle number)

CtAnalysis.BaselineRange[1].Max -> -1

calculate automatically upper boundary of the base line range Yes
(-1), No (0)

CtAnalysis.AutoBaseline -> -1

automatic base line determination On (-1) or Off (0)

CtAnalysis.AutoThreshold -> 0

auto threshold On(-1), Off(0)

CtAnalysis.Filter -> -1

filter On(-1), Off(0)

CtAnalysis.FilterOptions -> 2

filter strength slight(0), medium(1) or strong(2)

CtAnalysis.FilterSmooth -> 0

smooth the filter data, Yes (-1), No (0)

Calculate Tm

TmAnalysis.GOI.Color ->

melting curve GOI

TmAnalysis.GOl.Gene ->

melting curve of gene

TmAnalysis.Threshold -> 0

threshold value for determination of melting temperature

TmAnalysis.Smooth -> -1

smooth melting curve , Yes (-1), No (0)

TmAnalysis.SmoothMode -> 3

number of points used for smoothing

TmAnalysis.Log -> 0

logarithmic chart On(-1), Off(0)

TmAnalysis.BaseLineRange.Min -> 1

manually set lower boundary of the base line (cycle number)

TmAnalysis.BaseLineRange.Max -> 5

manually set upper boundary of the base line (cycle number)

TmAnalysis.AutoThreshold -> 0

auto threshold for melting curve, Yes (-1), No (0)
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TmAnalysis.FlipCurve -> 0

flip curve horizontally, On(-1), Off(0)

TmAnalysis.Scaling -> 1

All curves start at 100%(0), Maximum initial fluorescence =
100%(1)

Absolute Quantification

AbsQuantAnalyzes.Smooth -> -1

smoothing On(-1), Off(0)

AbsQuantAnalyzes.SmoothMode -> 5

number of points used for smoothing

AbsQuantAnalyzes.Log -> 0

logarithmic chart On(-1), Off(0)

AbsQuantAnalyzes.BaselLineRange[0].Min -> 3

manually set lower boundary of the base line (cycle number)

AbsQuantAnalyzes.BaselLineRange[0].Max -> 15

manually set upper boundary of the base line (cycle number)

AbsQuantAnalyzes.BaselLineRange[1].Min -> 5

automatically set lower boundary of the base line (cycle number)

AbsQuantAnalyzes.BaselineRange[1].Max -> -1

calculate automatically upper boundary of the base line range Yes
(-1), No (0)

AbsQuantAnalyzes.AutoBaseline -> -1

automatic base line determination On (-1) or Off (0)

AbsQuantAnalyzes.AutoThreshold -> 0

auto threshold On(-1), Off(0)

AbsQuantAnalyzes.Filter -> -1

filter On(-1), Off(0)

AbsQuantAnalyzes.FilterOptions -> 1

filter strength slight(0), medium(1) or strong(2)

AbsQuantAnalyzes.FilterSmooth -> 0

smooth the filter data, Yes (-1), No (0)

AbsQuantAnalysis.Description -> Quantitation 1

title of this analysis

AbsQuantAnalysis.Group -> 0

valid for group

AbsQuantAnalysis.REF -> 0

passive reference used? Yes (-1), No (0)

AbsQuantAnalysis.GOl.Color -> FAM

dye of GOI

AbsQuantAnalysis.GOl.Gene ->

name of GOI

AbsQuantAnalysis.Threshold -> 1,13570592788773

threshold value the Ct values were calculated with

AbsQuantAnalysis.FitData.Count -> 4

number of standards

AbsQuantAnalysis.FitData.M -> -3,67716352286466

slope of the standard curve

AbsQuantAnalysis.FitData.N -> 28,0638862770259

intercept of the standard curve

AbsQuantAnalysis.FitData.R2 ->
0,999236478923372

correlation coefficient of the linear curve fit

AbsQuantAnalysis.FitData.Extern -> 0

Was the standard curve imported, Yes (-1), No (0)

MIQE.Typelnfo -> 1

MIQE documentation for DNA(Q) or RNA(1)

LOCK->0

template or project locked? Yes (-1), No (0)

Relative Quantification

RelQuantAnalyzes.GOISmooth -> -1

smoothing GOI, On(-1), Off(0)

RelQuantAnalyzes.GOISmoothMode -> 5

number of points used for smoothing, GOI

RelQuantAnalyzes.GOlLog -> 0

logarithmic chart GOI On(-1), Off(0)

RelQuantAnalyzes.GOIBaseLineRange[0].Min -> 3

manually set lower boundary of the base line (cycle number GOI)

RelQuantAnalyzes.GOIBaseLineRange[0].Max -> 15

manually set upper boundary of the base line (cycle number GOI)

RelQuantAnalyzes.GOIBaseLineRange[1].Min -> 5

automatically set lower boundary of the base line (cycle number
GOl)
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RelQuantAnalyzes.GOIBaselLineRange[1].Max -> -1

calculate automatically upper boundary of the base line range Yes
(-1), No (0)

RelQuantAnalyzes.GOlAutoBaselLine -> -1

automatic base line determination On (-1) or Off (0)

RelQuantAnalyzes.GORSmooth -> -1

smoothing reference gene, On(-1), Off(0)

RelQuantAnalyzes.GORSmoothMode -> 5

number of points used for smoothing of reference gene

RelQuantAnalyzes.GORLog -> 0

logarithmic chart GOI On(-1), Off(Q), reference gene

RelQuantAnalyzes.GORBaseLineRange[0].Min -> 3

manually set lower boundary of the base line (cycle number
reference gene)

RelQuantAnalyzes.GORBaseLineRange[0].Max -> 15

manually set upper boundary of the base line (cycle number
reference gene)

RelQuantAnalyzes.GORBaseLineRange[1].Min -> 5

automatically set lower boundary of the base line (cycle number
reference gene)

RelQuantAnalyzes.GORBaselLineRange[1].Max -> -1

automatically set upper boundary of the base line (cycle number
reference gene)

RelQuantAnalyzes.GORAutoBaseline -> -1

automatic base line determination On (-1) or Off (0), reference
gene

RelQuantAnalyzes.GOlAutoThreshold -> 0

auto threshold On(-1), Off(0), GOI

RelQuantAnalyzes.GORAutoThreshold -> 0

auto threshold On(-1), Off(0), Referenzgen

RelQuantAnalyzes.GOlIFilter -> -1

filter On(-1), Off(0), GOI

RelQuantAnalyzes.GOIFilterOptions -> 1

filter strength GOI, slight(0), medium(1) or strong(2)

RelQuantAnalyzes.GOIFilterSmooth -> 0

smooth the filter data GOI, Yes (-1), No (0)

RelQuantAnalyzes.GORFilter -> -1

filter On(-1), Off(0), reference gene

RelQuantAnalyzes.GORFilterOptions -> 1

filter strength reference gene, slight(0), medium(1) or strong(2)

RelQuantAnalyzes.GORFilterSmooth -> 0

smooth the filter data of reference gene, Yes (-1), No (0)

RelQuantAnalysis.Description -> RelQ

title of this analysis

RelQuantAnalysis.Group -> 0

valid for group

RelQuantAnalysis.REF -> 0

passive reference used? Yes (-1), No (0)

RelQuantAnalysis.GOI.Color -> FAM

dye of GOI

RelQuantAnalysis.GOl.Gene ->

name of GOI

RelQuantAnalysis.GOIThreshold ->
0,794712458619839

threshold value the Ct values of the GOl were calculated with

RelQuantAnalysis.GOR.Color ->

dye of reference gene

RelQuantAnalysis.GOR.Gene ->

name of the reference gene

RelQuantAnalysis.GORThreshold -> 50

threshold value the Ct values of the reference gene were
calculated with

RelQuantAnalysis.GOIFitData.Count -> 4

number of standards, GOI

RelQuantAnalysis.GOIFitData.M -> -
3,62354563433653

slope of the standard curve, GOI

RelQuantAnalysis.GOIFitData.N ->
27,5354442047509

intercept of the standard curve, GOI
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RelQuantAnalysis.GOIFitData.R2 ->
0,999100282770293

correlation coefficient of the linear curve fit, GOI

RelQuantAnalysis.GOIFitData.Extern -> 0

Was the standard curve for GOl imported, Yes (-1), No (0)

RelQuantAnalysis.GORFitData.Count -> 0

number of standards, reference gene

RelQuantAnalysis.GORFitData.M -> 1

slope of the standard curve, reference gene

RelQuantAnalysis.GORFitData.N -> 0

intercept of the standard curve, reference gene

RelQuantAnalysis.GORFitData.R2 -> 0

correlation coefficient of the linear curve fit, reference gene

RelQuantAnalysis.GORFitData.Extern -> 0

Was the standard curve for reference gene imported, Yes (-1), No

(0)

DeltaDeltaCt Analysis

DeltaDeltaCtAnalyzes.GOISmooth -> -1

smoothing GOI, On(-1), Off(0)

DeltaDeltaCtAnalyzes.GOISmoothMode -> 5

number of points used for smoothing, GOI

DeltaDeltaCtAnalyzes.GOlLog -> 0

logarithmic chart GOI On(-1), Off(0)

DeltaDeltaCtAnalyzes.GOIBaselLineRange[0].Min -> 3

manually set lower boundary of the base line (cycle number GOI)

DeltaDeltaCtAnalyzes.GOIBaselLineRange[0].Max ->
15

manually set upper boundary of the base line (cycle number GOI)

DeltaDeltaCtAnalyzes.GOIBaseLineRange[1].Min -> 5

automatically set lower boundary of the base line (cycle number
GOl)

DeltaDeltaCtAnalyzes.GOIBaselLineRange[1].Max -> -1

calculate automatically upper boundary of the base line range Yes
(-1), No (0)

DeltaDeltaCtAnalyzes.GOlAutoBaseLine -> -1

automatic base line determination On (-1) or Off (0)

DeltaDeltaCtAnalyzes.GORSmooth -> -1

smoothing reference gene, On(-1), Off(0)

DeltaDeltaCtAnalyzes.GORSmoothMode -> 5

number of points used for smoothing of reference gene

DeltaDeltaCtAnalyzes.GORLog -> 0

logarithmic chart GOI On(-1), Off(Q), reference gene

DeltaDeltaCtAnalyzes.GORBaseLineRange[0].Min -> 3

manually set lower boundary of the base line (cycle number
reference gene)

DeltaDeltaCtAnalyzes.GORBaseLineRange[0].Max ->
15

manually set upper boundary of the base line (cycle number
reference gene)

DeltaDeltaCtAnalyzes.GORBaseLineRange[1].Min -> 5

automatically set lower boundary of the base line (cycle number
reference gene)

DeltaDeltaCtAnalyzes.GORBaseLineRange[1].Max -> -
1

automatically set upper boundary of the base line (cycle number
reference gene)

DeltaDeltaCtAnalyzes.GORAutoBaseLine -> -1

automatic base line determination On (-1) or Off (0), reference
gene

DeltaDeltaCtAnalyzes.GOlAutoThreshold -> 0

auto threshold On(-1), Off(0), GOI

DeltaDeltaCtAnalyzes.GORAutoThreshold -> 0

auto threshold On(-1), Off(0), Referenzgen

DeltaDeltaCtAnalyzes.GOIFilter -> -1

filter On(-1), Off(0), GOI

DeltaDeltaCtAnalyzes.GOIFilterOptions -> 1

filter strength GOI, slight(0), medium(-1) or strong(2)

DeltaDeltaCtAnalyzes.GOIFilterSmooth -> 0

smooth the filter data GOI, Yes (-1), No (0)

DeltaDeltaCtAnalyzes.GORFilter -> -1

filter On(-1), Off(0), reference gene
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DeltaDeltaCtAnalyzes.GORFilterOptions -> 1

filter strength reference gene, slight(0), medium(1) or strong(2)

DeltaDeltaCtAnalyzes.GORFilterSmooth -> 0

smooth the filter data of reference gene, Yes (-1), No (0)

DeltaDeltaCtAnalysis.Description -> ddCt

title of this analysis

DeltaDeltaCtAnalysis.Group -> 0

valid for group

DeltaDeltaCtAnalysis.GOl.Color -> FAM

dye of GOI

DeltaDeltaCtAnalysis.GOl.Gene ->

name of GOI

DeltaDeltaCtAnalysis.GOIThreshold ->
0,794712458619839

threshold value the Ct values of the GOl were calculated with

DeltaDeltaCtAnalysis.GOR.Color ->

dye of reference gene

DeltaDeltaCtAnalysis.GOR.Gene ->

name of the reference gene

DeltaDeltaCtAnalysis.GORThreshold -> 50

threshold value the Ct values of the reference gene were
calculated with

DeltaDeltaCtAnalysis.EfficiencyCalc -> 0

PCR efficiency calculation according to Livak (0) or Pfaffl (1)

DeltaDeltaCtAnalysis.EfficiencyType -> 0

if Pfaffl: calculate efficiency from standards (0) or entered values

(1)

DeltaDeltaCtAnalysis.GOIEfficiency -> 1

PCR efficiency of the GOI

DeltaDeltaCtAnalysis.GOREfficiency -> 1

PCR efficiency of the reference gene

DeltaDeltaCtAnalysis.GOIFitData.Count -> 4

number of standards, GOI

DeltaDeltaCtAnalysis.GOIFitData.M -> -
3,62354563433653

slope of the standard curve, GOI

DeltaDeltaCtAnalysis.GOIFitData.N ->
27,5354442047509

intercept of the standard curve, GOI

DeltaDeltaCtAnalysis.GOIFitData.R2 ->
0,999100282770293

correlation coefficient of the linear curve fit, GOI

DeltaDeltaCtAnalysis.GORFitData.Count -> 0

number of standards, reference gene

DeltaDeltaCtAnalysis.GORFitData.M -> 1

slope of the standard curve, reference gene

DeltaDeltaCtAnalysis.GORFitData.N -> 0

intercept of the standard curve, reference gene

DeltaDeltaCtAnalysis.GORFitData.R2 -> 0

correlation coefficient of the linear curve fit, reference gene

DeltaDeltaCtAnalysis.ValFitData.Count -> 0

number of standards used for validation

DeltaDeltaCtAnalysis.ValFitData.M -> 1

slope of the validation curve

DeltaDeltaCtAnalysis.ValFitData.N -> 0

intercept of the validation curve

DeltaDeltaCtAnalysis.ValFitData.R2 -> 0

correlation coefficient of the linear curve fit, validation

Melt Curve Analysis

MeltCurveAnalyzes.Smooth -> -1

smoothing GOI, On(-1), Off(0)

MeltCurveAnalyzes.SmoothMode -> 3

number of points used for smoothing

MeltCurveAnalyzes.Log -> 0

logarithmic chart On(-1), Off(0)

MeltCurveAnalyzes.BaseLineRange.Min -> 1

manually set lower boundary of the base line

MeltCurveAnalyzes.BaselineRange.Max -> 5

manually set upper boundary of the base line

MeltCurveAnalyzes.AutoThreshold -> 0

auto threshold On(-1), Off(0), GOI
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MeltCurveAnalyzes.FlipCurve -> -1

flip curve horizontally, On(-1), Off(Q)

MeltCurveAnalyzes.Scaling -> 0

All curves start at 100%(0), Maximum initial fluorescence =
100%(1)

MeltCurveAnalysis.Description -> melt

title of this analysis

MeltCurveAnalysis.Group -> 0

valid for group

MeltCurveAnalysis.GOIl.Color -> FAM

dye of GOI

MeltCurveAnalysis.GOl.Gene ->

name of GOI

MeltCurveAnalysis.Threshold -> 0

threshold value above which the melt temperatures are
determined

Genotyping

GenoTypingAnalyzes.GOISmooth -> -1

smoothing GOI, On(-1), Off(0)

GenoTypingAnalyzes.GOISmoothMode -> 5

number of points used for smoothing, GOI

GenoTypingAnalyzes.GOlLog -> 0

logarithmic chart GOI On(-1), Off(0)

GenoTypingAnalyzes.GOIBaseLineRange[0].Min -> 3

manually set lower boundary of the base line (cycle number GOI)

GenoTypingAnalyzes.GOIBaseLineRange[0].Max -> 15

manually set upper boundary of the base line (cycle number GOI)

GenoTypingAnalyzes.GOIBaseLineRange[1].Min -> 5

automatically set lower boundary of the base line (cycle number
GOl)

GenoTypingAnalyzes.GOIBaselLineRange[1].Max -> -1

automatically set upper boundary of the base line (cycle number
GOl)

GenoTypingAnalyzes.GOlAutoBaseLine -> -1

automatic base line determination On (-1) or Off (0)

GenoTypingAnalyzes.GORSmooth -> -1

smoothing reference gene, On(-1), Off(0)

GenoTypingAnalyzes.GORSmoothMode -> 5

number of points used for smoothing of reference gene

GenoTypingAnalyzes.GORLog -> 0

logarithmic chart GOI On(-1), Off(Q), reference gene

GenoTypingAnalyzes.GORBaseLineRange[0].Min -> 3

manually set lower boundary of the base line (cycle number
reference gene)

GenoTypingAnalyzes.GORBaselLineRange[0].Max ->
15

manually set upper boundary of the base line (cycle number
reference gene)

GenoTypingAnalyzes.GORBaseLineRange[1].Min -> 5

automatically set lower boundary of the base line (cycle number
reference gene)

GenoTypingAnalyzes.GORBaseLineRange[1].Max -> -
1

calculate automatically upper boundary of the base line range Yes
(-1), No (0)

GenoTypingAnalyzes.GORAutoBaseLine -> -1

automatic base line determination On (-1) or Off (0), reference
gene

GenoTypingAnalyzes.GOIAutoThreshold -> 0

auto threshold On(-1), Off(0), GOI

GenoTypingAnalyzes.GORAutoThreshold -> 0

auto threshold On(-1), Off(0), Referenzgen

GenoTypingAnalyzes.GOIFilter -> -1

filter On(-1), Off(0), GOI

GenoTypingAnalyzes.GOIFilterOptions -> 1

filter strength GOI, slight(0), medium(1) or strong(2)

GenoTypingAnalyzes.GOIFilterSmooth -> 0

smooth the filter data GOI, Yes (-1), No (0)

GenoTypingAnalyzes.GORFilter -> -1

filter On(-1), Off(0), reference gene

GenoTypingAnalyzes.GORFilterOptions -> 1

filter strength reference gene, slight(0), medium(1) or strong(2)
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GenoTypingAnalyzes.GORFilterSmooth -> 0

smooth the filter data of reference gene, Yes (-1), No (0)

GenoTypingAnalyzes.SPType -> 1

genotyping based on Ct (1) or dRn (0)

GenoTypingAnalyzes.EPLast -> -1

end point is the last cycle (1) or enter cycle manually

GenoTypingAnalyzes.EPCycle -> -1

manually entered end point cycle

GenoTypingAnalyzes.InfoText -> wild type text 1
GenoTypingAnalyzes.InfoText -> mutant text 2
GenoTypingAnalyzes.InfoText -> heterozygote text 3
GenoTypingAnalyzes.InfoText -> error text 4

GenoTypingAnalysis.Description -> Geno

title of this analysis

GenoTypingAnalysis.Group -> 0

valid for group

GenoTypingAnalysis.REF -> 0

passive reference used? Yes (-1), No (0)

GenoTypingAnalysis.GOl.Color -> FAM

dye of GOI

GenoTypingAnalysis.GOl.Gene ->

name of GOI

GenoTypingAnalysis.GOIThreshold ->
0,794712458619839

threshold value the Ct values of the GOl were calculated with

GenoTypingAnalysis.GOR.Color ->

dye of reference gene

GenoTypingAnalysis.GOR.Gene ->

name of the reference gene

GenoTypingAnalysis.GORThreshold -> 50

threshold value the Ct values of the reference gene were
calculated with

GenoTypingAnalysis.SPCutOff0 -> 0

cut off value 1, Ct

GenoTypingAnalysis.SPCutOff1 ->
0,794712458619839

cut off value 2, Ct

GenoTypingAnalysis.EPCutOff0 -> 49

cut off value 1, Cycle

GenoTypingAnalysis.EPCutOffl -> 51

cut off value 2, cycle

End Point Analysis

EndPointAnalyzes.Smooth -> -1

smoothing GOI, On(-1), Off(0)

EndPointAnalyzes.SmoothMode -> 5

number of points used for smoothing, GOI

EndPointAnalyzes.Log -> 0

logarithmic chart GOI On(-1), Off(0)

EndPointAnalyzes.BaseLineRange[0].Min -> 3

manually set lower boundary of the base line (cycle number GOI)

EndPointAnalyzes.BaseLineRange[0].Max -> 15

manually set upper boundary of the base line (cycle number GOI)

EndPointAnalyzes.BaseLineRange[1].Min -> 5

automatically set lower boundary of the base line (cycle number
GOl)

EndPointAnalyzes.BaselLineRange[1].Max -> 25

automatically set upper boundary of the base line (cycle number
GOl)

EndPointAnalyzes.AutoBaseLine -> -1

automatic base line determination On (-1) or Off (0)

EndPointAnalysis.Description -> Endp

title of this analysis

EndPointAnalysis.Group -> 0

valid for group

EndPointAnalysis.GOl.Color -> FAM

dye of GOI

EndPointAnalysis.GOl.Gene ->

name of GOI

168



Appendix D - Entries in the Audit Trail

EndPointAnalysis.GOICutOff -> 2040,83542831301

cut off value of GOI

EndPointAnalysis.IPC.Color ->

Dye of the internal positive control (IPC)

EndPointAnalysis.IPC.Gene ->

gene name of the internal positive control

EndPointAnalysis.IPCCutOff -> 0

cut off value of the internal positive control

EndPointAnalysis.OptionCycles -> -1

end point analysis based on end point intensities, Yes (-1), No (0)

EndPointAnalysis.OptionLastCycles -> 2

number of last cycles used for calculation

EndPointAnalysis.OptionFromCycle -> 38

start cycle end point range

EndPointAnalysis.OptionToCycle -> 40

end cycle end point range

EndPointAnalysis.OptionCutOff -> -1

end point analysis based on NTC intensities, Yes (-1), No (0)

EndPointAnalysis.OptionCutOffNTC -> 10

factor applied to the NTC intensities for threshold calculation

EndPointAnalysis.OptionCutOffNTC_IPC -> 2

confidence intervals: (0)95%, (1)99%, (2)99.5%, (3)99.7%,
(4)99.9%

EndPointAnalysis.OptionCutOfflnput -> 0

use cut off values from table Yes(-1), No (0)

MIQE.Typelnfo -> 1

MIQE documentation for DNA(Q) or RNA(1)

LOCK->0

template or project locked? Yes (-1), No (0)
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detected

Following color modules are available:

Description / order number

Color module 1, order number: 844-00520-0
Color module 2, order number: 844-00521-0
Color module 3, order number: 844-00522-0
Color module 4, order number: 844-00523-0
Color module 5, order number: 844-00524-0
Color module 6, order number: 844-00525-0
FRET module 1, order number: 844-00526-0
FRET module 2, order number: 844-00527-0
FRET module 3, order number: 844-00528-0
FRET module 4, order number: 844-00529-0
FRET module 5, order number: 844-00531-0

Color module Protein 1, order number: 844-00530-0

Dyes (examples)

FAM, SYBR Green, Alexa488
JOE, HEX, VIC, YakimaYellow
TAMRA, DFO, Alexa546, NED
ROX, TexasRed, Cy3.5

Cy5, Alexa633, Quasar670
Cy5.5, LightCycler Red

FAM (Donor) / TAMRA (Akzeptor)
FAM (Donor) / Cy5 (Akzeptor)
FAM (Donor) / Cy5.5 (Akzeptor)
JOE (Donor) / Cy5 (Akzeptor)
FAM (Donor) / ROX (Akzeptor)
SYPRO Orange
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